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Preface

This document describes the steps for installing and configuring the components of 
the Argus Safety Solution application.

Intended Audience
This document is intended for  administrators of the Argus Safety system for 
configuring Argus Safety. 

Documentation Accessibility
Our goal is to make Oracle products, services, and supporting documentation 
accessible to all users, including users that are disabled. To that end, our 
documentation includes features that make information available to users of assistive 
technology. This documentation is available in HTML format, and contains markup to 
facilitate access by the disabled community. Accessibility standards will continue to 
evolve over time, and Oracle is actively engaged with other market-leading 
technology vendors to address technical obstacles so that our documentation can be 
accessible to all of our customers. For more information, visit the Oracle Accessibility 
Program Web site at

http://www.oracle.com/accessibility/

Accessibility of Code Examples in Documentation
Screen readers may not always correctly read the code examples in this document. The 
conventions for writing code require that closing braces should appear on an 
otherwise empty line; however, some screen readers may not always read a line of text 
that consists solely of a bracket or brace. 

Accessibility of Links to External Web Sites in Documentation
This documentation may contain links to Web sites of other companies or 
organizations that Oracle does not own or control. Oracle neither evaluates nor makes 
any representations regarding the accessibility of these Web sites. 

TTY Access to Oracle Support Services
To reach Oracle Support Services, use a telecommunications relay service (TRS) to call 
Oracle Support at 1.800.223.1711.

About This Book
This guide contains following chapters:
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Conventions
The following text conventions are used in this document:

Convention Meaning

boldface Boldface type indicates graphical user interface elements associated 
with an action such as Buttons, Dialog boxes, Check boxes, Combo 
boxes, Drop-down lists, Labels, Option (Radio) buttons, Tabs, Text 
boxes, etc.

"between quotation 
marks"

Information that may appear as-is on screen, or information provided 
by the user.

Note Information that should be noted before proceeding with the 
instructions.

Important Important information that must be noted to ensure accurate, reliable, 
or safe behavior of the system.

Tip Information that enables easier completion of the current task or helps 
in completing other tasks.

Bold Underline Link indicating that additional "pop-down" information is available.

ALL CAPITALS Keyboard keys

Initial Capitals Names of user interface elements, modules, applications, proper nouns, 
etc.
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Introduction
Argus Safety assists manufacturers of pharmaceuticals and devices by providing a 
simple and efficient way to comply with international and domestic regulatory safety 
reporting requirements. It also facilitates internal company safety surveillance by 
providing tools for signal detection and for analyzing the overall safety profile of both 
investigational compounds and marketed products.

Argus Safety Configuration Process Overview
To configure Argus Safety, the Administrator must follow a particular sequence of 
steps. Steps that fall later in the sequence might depend on those that appear earlier. It 
is, therefore, important for the Administrator to use the following flowchart as a 
guideline for configuring Argus Safety.

Task Purpose

Configure User Sites, Groups 
and Accounts

Enter user sites, create user groups and user accounts, 
configure group and individual user access rights

Configure Products Configure Manufacturers, Ingredients, Formulations, 
Dosage Units, Product Families, and Data Sheets

Configure Licenses Enter license information, countries and products associated 
with the license
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Usage Conventions
The following conventions are used throughout this document to help you identify 
specific kinds of information.

Getting Started
This section introduces the basic tasks for configuring Argus Safety. To get started with 
the configuration process, the person responsible for configuring Argus Safety must 
log on as Administrator to configure the Argus Console.

Refer to the following sections for information pertaining to:

Configure Code List Items Configure list maintenance items that are not covered in 
other topics, like Action Taken, Clinical Studies, Study 
Centers, etc.

Configure Workflow Configure case workflow states and rules that determine the 
transition of cases between states

Configure Regulatory 
Reporting

Configure Regulatory Agency information and expedited 
reporting rules

Configure System Options Configure miscellaneous system items like Auto-numbering, 
Field Labels, etc.

Configure Case Form Configure Case Form dictionaries, duration calculations, etc.

Configure Letters Create letter templates by using template placeholders

Configure Database 
Common Profiles

Configure the Common Profiles Table to customize the 
Argus Safety application

Usage Convention Description

Bold User interface elements such as Buttons, Dialog boxes, Check boxes, 
Combo boxes, Drop-down lists, Labels, Option (Radio) buttons, Tabs, 
Text boxes, etc.

"between quotation 
marks"

Information that may appear as-is on screen, or information provided 
by the user.

Note: Text Information that should be noted before proceeding with the 
instructions.

Important! Text Important information that must be noted to ensure accurate, 
reliable, or safe behavior of the system.

Tip: Text Information that enables easier completion of the current task or 
helps in completing other tasks.

ALL CAPITALS Keyboard keys

Initial Capitals Names of user interface elements, modules, applications, proper 
nouns, etc.

Section Topics Covered

Administrator Login ■ Logging in and out of the Argus Console

■ Changing the Administrator password

■ Accessing the Home Page and Online Help

Task Purpose
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Argus Console Architecture
The Argus Web Administration Console has been designed to enhance ease of 
navigation for the Argus end-users.

The following illustration shows the design and location of the individual components 
under the main Argus Console Menu.

Required Fields
Fields that are marked with a red flag image  and associated with an orange boundary 
are required fields. These fields must be filled in, to proceed with the configuration 
requirements.

Standard Buttons
The standard buttons used in this console are described in the following table:

Understanding 
Argus Console user 
interface

Read this section for an overview of the Argus Console user interface 
components.

Note: The menu items that you can access depend on the security 
permissions that are defined for your account by the administrator

Button Description

Save Use this button to save changes associated with a section

Cancel Use this button to cancel changes associated with a section

Print Use this button to print information associated with a sub-section in a 
PDF.

Delete Use this button to delete an item associated with a section

Copy Use this button to create a new editable copy of an item within a section

OK Use this button to confirm an action associated with a section

Yes Use this button to confirm an action associated with a section
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Standard Icons
The standard icons used in this console are described in the following table:

No Use this button to cancel an action associated with a section

Help Use this button to launch the online manual for the Argus Console

Add New Use this button to add a new item associated with a section

Icon Identifies

A required field

An item placed inside a folder in the tree-view

A closed folder containing sub-folders or nodes

An open folder displaying sub-folders or nodes

An open folder that does not contain sub-folders or nodes

A closed folder that does not contain sub-folders or nodes

An expandable or collapsible browser tree view

An option to sort columns alphabetically (when placed next to a 
column header)

An item appearing under multiple categories (e.g. a user name 
appearing under multiple groups)

A withdrawn license in the tree-view of licenses.

Button Description



Introduction

Introduction 1-5

Administrator Login
When Argus Safety is installed, an account for the Administrator is automatically 
created. The installation program assigns "admin" as both the User Name and 
Password for this account.

Before logging in to the Argus Console, be aware of the following:

■ If you enter an incorrect username or password three (3) consecutive times, the 
system disables the Login button and displays the following message:

The login button has been disabled due to 3 consecutive incorrect entries of Username or 
Password. Please refresh the page to enable the Login button.

■ The Date/Time format  24-hour used by the Web server: DD-MMM-YYYY 
HH:MM:SS.

■ When you click the name of an enabled/disabled module, the Oracle Web site 
pages for the module opens in a new browser window, as follows:

http://www.oracle.com/us/industries/health-sciences/027630.ht
m

Logging In as an Administrator:
1. Enter the Argus URL in your web browser, to launch Argus Safety. The login 

screen appears as shown:

2. Enter the User Name and Password to login to Argus Safety.

3. Select the database name from the Database list.

4. Press Enter or click Login.

Tip:

■ The modules displayed in bold text identify the modules you 
have permission to access.

■ Your login user ID and password are valid for all accessible Argus 
modules.

Note: The password is case-sensitive.



Introduction

Introduction 1-6

5. When the window opens, click Yes to proceed with the login.

6. Click Argus Console to launch the Argus Console Administrator screen.

Changing the Administrator's Password
1. Select Utilities -> Change Password in Argus Safety.

2. The Change Password dialog opens.

3. Enter the current password and the new password.

4. Confirm the new password and click OK.

Logging out
1. Click Close to leave the Argus Console application.

2. To log out at any time from Argus Safety, click Logout.

Accessing the Home Page
To go back to the Home page, click Home. The default Home page appears.

Launching Online Help
To launch  online help click Help.

Note: If the window does not appear, verify that your brower’s  
Pop-Up blocker is disabled.

Note: If the window does not appear, verify that your brower’s  
Pop-Up blocker is disabled.
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Understanding Argus Console GUI
This section broadly categorizes the sections of the Argus Console GUI with their 
associated descriptions.

Section Sub-Section Description

Getting Started ~ This section provides information about new 
keyboard navigation features for the Argus 
Console.

Access Management Sites This section enables the administrator to enter 
and configure new user sites.

Groups This section enables the administrator to enter 
and configure new user groups.

Users This section enables the administrator to 
configure user accounts.

Business 
Configuration

Product and License This section helps in capturing Product Details 
(product specifics, product licenses, products 
involved in the studies.

These can be the products marketed, or under 
investigation, by the company.

Studies 
Configuration

This section helps in capturing Study 
information (study specifics, products involved 
in the study licensed countries associated with 
the study and the clinical references used in the 
expedited reports.

This section helps in capturing Expedited 
Reporting Rule configuration.

The Reporting Rules configuration feature 
enables the administrator to define the reporting 
rules or criteria for the cases to be qualified for 
expedited reporting.
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System 
Configuration

Case Priority This section enables the administrator to 
configure rules to determine the priority of new 
cases that are entered into the system.

Field Validation This section enables the administrator to 
configure field level validations for the case 
form fields.

Field Labels This section enables the administrator to change 
field labels, hide and unhide fields in Case form.

LAM System 
Numbering

This dialog enables the administrator to specify 
the case numbering preferences for LAM cases.

System Management

Common Profile 
Switches

This section enables the configuration of 
Common Profile Switches that affect the 
behavior of the Argus application.

Workflow The section enables the configuration of 
workflow states and rules, within the safety 
department starting from initial case receipt to 
case closure.

The system enables tracking of the progress of 
cases between users and states of activity.

System Numbering This section enables the administrator to specify 
the case numbering preferences.

SMTP Configuration This screen enables the user to configure SMTP 
settings.

Code Lists Code Lists

Argus

This section helps in capturing Code List 
information. Code lists appear as drop-downs in 
the Argus application.

Tools E2B Length Check This screen enables the user to view the E2B 
Length Check report in PDF format.

Section Sub-Section Description
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Access Management
Site, group, and user configuration takes place in the Access Management section of 
Argus Console.  Here you can add, copy or delete users, groups or sites. 

Each user must be assigned to at least one group in order to determine their security 
level. Each group is assigned a specific security level. This security level enables 
members of the group to view, modify, or restrict access rights to various sections of 
the Case Form, and so on.

The first set of steps in configuring Argus safety is to create the following exactly in 
the listed order:

■ Sites

■ Groups

■ Users

Configuring User Sites
Addition of Sites is necessary in order to create Users because every user must be 
assigned to exactly one Site. Site information can also be used in automatic numbering 
of case IDs.

To configure Sites, use the Access Management --> Argus --> Sites section. The 
following is an illustration of that section.

Field Descriptions
The following table lists and describes the fields on the screen.

Note: The configuration must occur in the exact order specified 
above.
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Adding User Sites
This screen helps in capturing Site information (such as user site description, 
abbreviated term, site type and LAM site configuration).

Use the following procedure to add a user site.

1. Click Access Management->Argus->Sites.

Field/Control Name Description

Description Enter a description of the site.

Abbreviation Enter an abbreviation of the site name. A one to four character 
abbreviation is required for each site.

Site Type Select the Site Type Argus or LAM (Local Affiliate Module).

Protect Patient 
Confidentiality - 
Default

Protects or reveals Patient Confidentiality for the specific site.

Protect Reporter 
Confidentiality - 
Default

Protects or reveals Reporter Confidentiality for the specific site.

Bulk report By form 
(Approved reports) - 
Default

Allows or protects availability of the Bulk Reports by Form for the 
specific site.

LAM Sites Select and add previously created LAM sites.
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2. In the left panel, select User Sites. The User Sites are listed in the right panel.

3. Select a User Site and click Add New.

4. Enter the user site Description.

5. Enter the user site Abbreviation.

6. Select a Site Type.

7. Select the following options as required:

■ Select the Protect Patient Confidentiality - Default to protect or reveal Patient 
Confidentiality for this specific user site.

■ Select the Protect Reporter Confidentiality - Default to protect or reveal 
Reporter Confidentiality for this specific user site.

■ Select the Bulk Report by Form (Approved Reports) - Default to enable 
availability of the Bulk Reports By Form for this specific site.

8. Add or remove any LAM Sites information.

Tip: You can alternatively click Modify to modify an existing site.

Use Copy to make an editable copy of an existing user site.

Use Delete to delete a user site.

Note: A maximum four-character abbreviation is required for each 
user site.

Note: Each Argus Safety user must be assigned to exactly one user 
site.

You cannot change the site type from LAM to Central if the current 
central site has an association with a LAM site, the current site is 
associated with any user, or the current LAM site has any events 
assigned to it.

Tip: To add more LAM Sites to the Lam Sites list, use the Add>>/ 
Add All .options.

To delete the LAM Sites from the Lam Sites list, use the 
Remove>>/Remove All options..
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9. Enter the Name of the printer that will be displayed in the application when 
referring to the printer. The name can have upto 20 characters.

10. In the Path textbox, enter the full path of the printer on the network. This path 
name can have upto 256 characters. The specified path should be accessible from 
the machine where Argus Safety Service is installed.

11. Click Save to save the information and return to the Code List Maintenance 
dialog.

About Filtering Criterion  The filtering criterion is essential as it helps you to search for 
specific items. The Argus Console provides this option for the Access Management 
section. The filtering browser is displayed as the Code Filter List

Argus Console helps you to filter information further for the Access Management 
section. Using the Code Filter List you can specify whether your search should 
contain or start with specific alphabets.

For Example: The following filtering criteria enables the system to search for all User 
Sites that contain A in the abbreviated term.

***********************************************************************************************

The right panel now displays the list of User Sites based on the filtering criterion.

Configuring Groups
Each user of Argus Safety can be a member of one or more user groups. The access 
rights of each user group to the menus in the user interface and specific sections of the 
Case Form can be configured when the group is created.

Configuration of the user site is done using the Access Management-->Argus --> 
Groups section.

Field Descriptions
The following table lists and describes the fields in the Modify Group Information 
section.
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Adding User Groups
This section enables the Administrator to configure the security levels for each work 
group.

Radio buttons enable you to view the group and assign access rights for several 
specific sections of the case form, menu, case workflow, and report workflow.

If a user belongs to multiple groups, the access rights for the user will be the sum-total 
of the individual group access rights. Consider the following example:

John Smith is an Argus User and his profile has been added to 2 user groups with 
different access level permissions for each group.

■ John has access rights to the Patient Tab in one group and access rights to the 
General Tab in another group.

■ In this case, John will be able to access both the Patient and the General tabs of 
Argus

Use the following procedure to create a user group

1. Click Access Management->Argus->Groups.

2. Select the filtering criterion to display the list of Groups or Users in the left panel.

3. Select a Group and click to view the group details in the right panel.

Field/Control Name Description

Group Name Enter a unique name for the group.

Email Add the group email, used for case priority notification and workflow 
routing notification.

Supervisor Email Add the Group's Supervisor Email as applicable. This e-mail address is 
used to send notifications when the maximum time of a case for a 
particular workflow state is exceeded.

Menus Lists the menus and sub menus within a Case Form and allows you to 
enable or disable each of them.

Case Form Lists the sections and sub sections within a Case Form and enables you 
to assign the group Modify; View (Read Only); or No Access (not 
visible) to each area.

Listedness 
Determination - 
Countries

Assigns Argus users to the group that has  rights to change the 
listedness determination for licenses originating in the selected 
countries.

Restrictions - 
Products

Limits the number of products that can be viewed in the trade name 
lookup and non-study cases.

Restrictions - Studies Limits the number of studies available for selection and the study cases 
that can be viewed.

1. Click the Studies checkbox to enable the Select button

2. Click this button to view a security configuration containing a tree 
view list of available items

3. Select a study family to select all its constituents

Default report (LAM 
only)

Lists the expedited report forms in the drop-down list.
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4. Enter the Group Name. This should be a unique name associated with this Group.

5. Enter the Email address, if applicable.

6. Enter the Supervisor Email address, if applicable.

7. In the Case Form section, select the desired access right option ("Modify", "View", 
or "No Access") for the group's access to each of the listed items of Case Form.

8. In the Menus section, enable or disable access of the group, to particular items in 
the Argus Safety menu.

Tip:

■ You can alternatively click Add Group to create a new group.

■ Use Copy to make an editable copy of an existing group.

■ Use Delete to delete a group.

Note: The following fields are required in order to save a case: Initial 
Receipt Date, Country of Incidence, Report Type, Suspect Product, 
and Event Description as Reported. Therefore, the group responsible 
for initial case entry must have access to these fields in order to save 
new cases.

Tip: Refer to the Argus Safety User Guide for information about the 
functions of the Case Form sections and the menu items in the Argus 
Safety user interface.
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9. In the Listedness Determination section, select a list of countries. This enables the 
end user to override the listedness determination in the Event Assessment section 
of the Case Form for product licenses that match the countries selected in this step.

10. In the Advanced Conditions section, select No Access to Create Advanced 
Condition, No Access to Share Advanced Conditions, and/or No Access to View 
and Edit SQL.

11. In the Restrictions section, select Products.

12. Click Add Product, to open the Available Products dialog box.

13. Select each product you want to add and click OK.

14. In the Restrictions section, select Study.

15. Click Add Study, to open the Available Studies dialog box.

16. Click the appropriate checkboxes to select the required studies and click OK.

Tip:

■ If you select No Access to Create Advanced Condition,  
Advanced Conditions does not appear as an option for that user 
group.

■ If you select No Access to Share Advanced Conditions, the user 
group does not have access to share Advanced Conditions.

■ If you select  No Access to View and Edit SQL, the SQL... button 
will not appear as an option for that user group.
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17. Click OK to save the group.

Groups Included with the Factory Data  The following table lists and describes the groups 
included with the factory data.

About Filtering Criterion  The filtering criterion is essential as it helps you to search for 
specific items. The Argus Console provides this option for the Access Management 
section.

Using Organized by
The system displays the filtering browser in the top-left corner of the left panel. You 
can filter based on either of the two combination shown in the following illustration.

Consider the following.

■ If you enable Organized by Groups, the generated output displays in a 
tree-format in the left panel. The structure is based on the entire categorization of 
Groups and Users

■ If you enable the Organized by Users, only the User list is available in the tree 
view in the left panel.

Group Description

Administrator This group has access rights to all areas and all the functionality of 
Argus Safety.

Investigator Receives an e-mail alert that can be set up during Clinical Study 
Configuration.
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Using contains or starts with enables you to specify whether your search should 
contain or start with specific alphabetic characters. For example, filtering criterion 
shown in the following illustration enables the system to for all Groups that contain 
the word "administrator."

Printing a User Group
Use the following procedure to print a user group.

1. Select Access Management->Argus->Groups.

2. Select the filtering criterion to display the list of Groups or Users (based on the 
filtering criterion) in the left panel.

3. Select a Group and click to view the group details in the right panel.

4. Click Print to display a Print dialog that enables the user to choose to print the 
entire window or to print only the text covered by the current selection.

5. Select the appropriate options and click OK.

6. The system opens the Print Groups to enable the user select the sections to be 
printed in the Group Configuration printout.

By default, the Group Information checkbox is selected and disabled so that it 
always gets printed.

7. Select the appropriate checkboxes, and click OK
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Group Configuration Print Out  The following is an illustration of the Group 
Configuration printout.

■ It lists the users which are configured to the groups.

■ User are sorted alphabetically by User Full Name in the report section

About Filtering Criterion  The filtering criterion is essential as it helps you to search for 
specific items. The Argus Console provides this option for the Access Management 
section.

Using Organized by
The system displays the filtering browser in the top-left corner of the left panel. You 
can filter based on either of the two combinations.

Consider the following.

■ If you enable Organized by Groups, the generated output displays in a 
tree-format in the left panel. The structure is based on the entire categorization of 
Groups and Users

■ If you enable the Organized by Users, only the User list is available in the tree 
view in the left panel.

Using contains or starts with enables you to specify whether your search should 
contain or start with specific alphabetic characters. For example, filtering criterion 
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shown in the following illustration enables the system to for all Groups that contain 
the word "administrator."

Configuring Users
User Maintenance enables you to add, copy, or delete users for the system.

■ Each user must be assigned to at least one group in order to determine security 
level.

■ Each group is assigned a specific security level that defines whether group 
members can view, modify, or have no access rights to various sections of the case 
form, etc.

Configuration of the users is done using the Access Management->Argus->Users 
section. You can specify a password when creating or modifying an individual user 
account. When updating user records, be aware of the following:

■ If you enter a value in the Password field, the system uses this password to 
authenticate at login.

■ The Reset Password field is available only when you select Reset Password. The 
new password can be up to 30 characters.

■ If you leave the value blank, the system uses the default password as defined in 
the Common Profile for the system.

■ When you save the user configuration, the system saves the default password you 
enter.

■ During entry, the system displays the password you type.

■ The password update function is included in the Argus Insight module.

The following illustration shows the fields associated with this section.
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Field Descriptions
The following table lists and describes the fields in the Administrator section

Field/Control Name Description

User Name Enter the full name.

User ID Enter a unique user identification (ID).

Reset Password Reset the password of a user to a default value specified in the common 
profile section.

Email Address Enter the user's e-mail address.

Site Assigns the user to a site.

The values in this field are populated from the codelist item User Sites.

User Group - Select Attaches the user to pre-configured user groups.

User Roles - Select Attaches the user to pre-configured user roles.

Application Access Configure user access settings for Argus Console and Argus Safety.

The default application access for the user can be selected from the list.
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Worklist to display at 
login

Configure users to see their worklists immediately upon login. The 
options are:

■ None (default) - Does not open any worklist when the user logs 
into Argus. Displays personal Argus status on login.

■ Action Items - Opens Worklist - Action Items screen for the user on 
login into Argus

■ New - Opens Worklist - New screen for the user on login into 
Argus

■ Open - Opens Worklist - Open screen for the user on login to 
Argus.

■ Reports - Opens Worklist - Reports screen for the user on login into 
Argus

Enable site security If Enable Security is checked, the site-based data security will be enabled 
for the user.

If the box is not checked, the user will have full access to data from all 
sites.

Enable LDAP Login Authenticates users against the active directory server.

When Enable LDAP Login is selected, all fields inside the Access 
section are disabled, excluding the Account Disabled option.

Account Disabled When this option is selected, the user account is temporarily disabled to 
prevent users from logging in. This option is different from deleting a 
user as it enables the Administrator to re-activate the account at a later 
date.

Security Disabled 
Account

■ When unchecked, the login procedure keeps track of the number 
of consecutive unsuccessful attempts at logging into the system. If 
the count reaches three, the login procedure will always fail the 
password validation to lock the user out. Administrators with 
rights to user maintenance can reset the login attempts for the user 
to unlock the account.

■ When checked, the login procedure that tracks the consecutive 
unsuccessful attempts at logging into the system do not apply.

Force password 
change at login

If this check box is selected, the users must change the password the 
first time user logs on to the system after the checkbox is checked.

Force password to 
expire every

Enables the Administrator to force the user's password to expire in the 
specified number of days.

Days Enables the Administrator to enter the number of days after which the 
password should expire.

__ Days remaining The field displays the number of days remaining for the password 
change.

Allow unblinding of 
cases

Enables the user to unblind a study case.

For example, a user without unblinding rights will not see the Study 
Drug field. A user with unblinding rights sees a yellow Unblind tag next 
to concentration of product field and the Broken by Sponsor option in 
Blinding Status drop-down list is enabled. User will have to enter 
password when user selects Broken by Sponsor' option.

Protect from 
unblinded 
information

When checked, the user cannot view any unblinded information.

Protect from printing 
unblinded 
information

When checked, the user cannot print any unblinded information.

Field/Control Name Description
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Printing Users
Use the following procedure to print users.

1. Select Access Management > Argus > Users.

2. Select a User and click to view the user details in the right panel.

3. Click Print to display the Print User dialog. 

4. Click OK to display list of Print User options. 

Allow locking of 
cases

Enables the user, to lock/unlock the cases.

Allow closing of 
cases

Enables the user to close the cases.

Route on close case When checked, this disables the case routing dialog which appears 
when the users selects Case Actions - close case on the case form.

Enable Checklist on 
Route

By default, this checkbox is selected.

If this checkbox is not selected, the checklist for the Workflow is not 
displayed to the user while routing the cases, even if the rule that is 
being used has a checklist.

Field/Control Name Description
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5. Select the appropriate option(s) and click OK.
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About Business Configuration
This section explains the Business Configuration of the Argus Console, categorized 
into the following modules:

Editable and Non-editable Business Configuration Sections
Each of the three Business Configuration sub-sections supports various views for 
efficient access to data. Each view consists of a hierarchical tree-structure comprising 
various nodes such as Family, Product, Licenses, and Countries.

The following table list which nodes can be edited and which cannot.

Section Sub-Section Description

Business 
Configuration

Product and License: This section helps in capturing Product 
Details such as product specifics, product 
licenses and products involved in the 
studies.

These can be the products marketed, or 
under investigation, by the company.

Refer to the following sections for further 
information on:

■ Configuring Product Families

■ Configuring Products

■ Configuring Licenses

Studies 
Configuration

This section helps in capturing Study 
information such as study specifics, products 
involved in the study licensed countries 
associated with the study and the clinical 
references used in the expedited reports.

Expedited Report 
Rules

This section helps in capturing Expedited 
Reporting Rule configuration.

The Reporting Rules configuration feature 
enables the administrator to define the 
reporting rules or criteria for the cases to be 
qualified for expedited reporting.
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Business 
Configuration 
Sub-Section Organized By Node Editable

Products and Licenses Family / Product / Licenses Family Yes

Product Yes

Licenses Yes

Product / Licenses Product Yes

Licenses Yes

License / Products License Yes

Products Yes

Countries / Licenses Countries No

Licenses No

Countries / License Type / 
Licenses

Countries No

License Type No

Licenses No

Studies Projects / Studies / Products Projects No

Studies Yes

Products No

Studies / Products Studies No

Products No

Products / Studies Products No

Studies No

Countries / Projects / Studies Countries No

Projects No

Studies No

Expedited Report 
Rules

Country / License Type / 
Reporting Rule

Country No

License Type No

Reporting Rule Yes

License Type / Reporting 
Destination / Reporting Rule

License Type No

Reporting 
Destination

No

Reporting Rule Yes

Responsible Group / Reporting 
Rule

Responsible Group No

Reporting Rule Yes

Inactive Rules Country No

License Type No

Reporting Rule Yes

Active Rules Country No

License Type No

Reporting Rule Yes
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Type Ahead Fields
Some fields in the Business Configuration section of Argus Console are enabled with 
Type Ahead-input. This means that these fields are equipped with the ability to guess 
what the user is typing.

Based on the text being entered, this feature provides suggestions for the user to 
choose from.

The following fields have the type-ahead feature:

■ Clinical Reference Type (Under ClinicalStudies Configuration)

■ Ingredients (Under Product Family Configuration)

■ Manufacturers (Under Product and License Configuration)

■ Project ID (Under Clinical Studies Configuration)

■ Reporting Destination (Under Expedited Reporting Rules)

Additional Comments Fields
Be aware of the following:

■ The system has a Comments field that accommodates a maximum of 1000 
characters on the Product Family, Product, and License and Study configurations.

■ The Product Configuration permits a maximum of 50 characters in the PSUR 
Group Name field. Multiple blank spaces between words will cause the generation 
of unusable report templates. 

■ The License Configuration permits a maximum of 50 characters in the CTPR 
Group Name. Multiple blank spaces between words will cause the generation of 
unusable report templates.

■ The Business Configuration report prints the Comments field, and the system 
tracks any changes made to these fields in the audit log.

Configuring Product Family
Each company has a set of products to sell and a set of processes unique to its 
business. The Administrator should be aware of the company business processes 
and/or workflow rules. The manner of product configuration in Argus Safety will 
depend on how the company handles its internal workflow related to the release of a 
product.
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Details of the company's products can be added in Argus Safety using the Business 
Configuration section. This feature helps end-users to retrieve details of company 
products, without entering significant product information for each case.

Every company product should belong to a product family. Each product within a 
product family shares the same key ingredient and data sheets but can have a different 
concentration for the key ingredient.

Configuration of the product is done using the Business Configuration->Products 
and Licenses section.

The following illustration shows the fields associated with this section.

Field Descriptions
The following table lists and describes the fields in this section.

Adding Product Families
The screen helps in capturing the Product Family information. As per the Argus data 
model, the Product Family adds the Ingredients, Data Sheets, and the Product group.

Products are associated with Product families and are created using the Data Sheets, 
Dosage form, Strength and unit of the corresponding Product Family. The Product 
Group field in the Product Family configuration screen enables the Argus 
administrator to group the product families into various Product Groups.

Use the following procedure to add a product family.

Field Description

Product Family Name Enables the user to enter a new product family name.

Product Family Name 
(J)

Enables the user to enter a new product family name in Japanese.

Product Group Enables the user to select a product group name.

Search Equation 
Number

Enables you to  enter a search equation number for Literature Import 
-- Bookin.

Ingredient Name Enables the user to select the multiple key ingredients for the product 
family

■ The user can sort the field alphanumerically.

■ Sorting on the ingredient name in the Product Family 
Configuration updates the sort order in all the products which 
are part of the same family

■ A maximum of 25 items are displayed as the search results in the 
drop-down list.

■ The Key Ingrediens drop-down list enables the user to enter up 
to 20 active ingredients for a product family.

Ingredient Name (J) Enables the user to select the multiple key ingredients for the product 
family

■ Sorting is not supported.

■ A maximum of 25 items are displayed as the search results in the 
drop-down list.

■ This field is optional, non-editable, and auto-populated based on 
the value in the English

■ The Key Ingrediens drop-down list enables the user to enter up 
to 20 active ingredients for a product family.
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1. In the Business Configuration section, select Product and Licenses.

2. In the left panel, select a filtering criterion. The left panel now displays the tree 
view of the Family based on the filtering criterion.

3. Select a Product Family and click to view the product family details in the right 
panel.

Product family details appear in the right panel.

4. Enter the Product Family Name as applicable.

5. Select the Product Group from the drop-down list. This helps you to group the 
product families into various product groups.

6. Select the required Ingredient Name(s) displayed under the Key Ingredients 
section

7. Select the required Datasheet configuration.

8. Click Save to save the changes made to the Product Family.

About Filtering Criterion  The filtering criterion is essential as it helps you to search for 
specific items. The Argus Console provides this option for the Business Configuration 
section.

Using Organized by
The filtering browser is displayed in the top-left corner of the left panel. The Products 
and Licenses section can be filtered based on any of the three combinations shown in 
the following illustration. Consider the following:

■ If you enable Organized by Family/Product/License, then the generated output 
will be visible in a tree-format in the left panel.

■ If you enable the Organized by Product/License, only the Product and License 
views are available in the tree view in the left panel.

Note: Ensure that you select the top-level folder to view the details 
of the product family.

Tip:

■ You can alternatively click Add Family to create a new family of 
products.

■ Use Copy to make an editable copy of an existing product family.

■ Use Copy with Datasheets to make an editable copy of an 
existing product family, along with all associated datasheets.

Tip: If you have added a new Product Family, click Add Family to 
save the new Product Family.
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The Argus Console helps you to filter information further for the Business 
Configuration section. Once you have selected the Organized by, you can specify 
whether your search should contain or start with specific alphabets.

The filtering criterion shown in the following illustration, enables the system to 
search for all Family/Product/License data that contains the term Cure.

Creating Data Sheets
Packaged medications (like prescriptions) are marketed with an insert sheet that lists 
the known contraindications (side-effects) that may occur as a consequence of taking 
the product. These inserts are also referred to as data sheets. It is important to list these 
effects in order to ensure accuracy in reporting. An inaccurate report could result in 
the wrong action taken or bring harm to a patient.

The Listed Events & Indications from the data sheet determine the listedness of the 
adverse event(s) for the case. Depending on the configured regulatory report rules, the 
listedness determination will automatically schedule the expedited reports .

The data sheet in the Product Family is configured using the Business Administration 
-> Products Family section.

Field Descriptions
The following table lists the Field Descriptions for this section.

Tip: The number displayed next to the folder indicates the number 
of Products in the product family.

Field/Control Name DescriptionDescription

Datasheet Name Enables the user to rename the datasheet.Be aware of 
the following:
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Use the following procedure to create a datasheet.

1. In the Datasheet section of the Product Family section, click Activate Datasheet to 
activate the data sheet associated with the Product Family.

Activate Data Sheet Enables the user to activate the current data sheet. Be 
aware of the following:

■ When you click the checkbox, the system enables 
the radio buttons next to Activate Data Sheet.

You cana either select the option to activate the data 
sheet with Terms added on the current dates or on 
another date entered in the Other Date field.

Once the datasheet is activated, the system disables 
the Activate Datasheet text box.

If you enter a date greater than the current system 
date, the system permits you to enable the 
activation date. 

Core Sheet The Core Sheet checkbox enables the user to indicate 
that this data sheet is the central data sheet. This 
checkbox is disabled if another data sheet is marked as 
the core data sheet.

Include The Include checkbox enables the user to indicate that 
this data sheet includes the particular datasheet selected 
in the drop-down list. Be aware of the following:

■ The system populates the drop-down list with the 
list of datasheets that do not include other data 
sheets.

■ The system enables the drop-down list only when 
the include checkbox is checked.

If a product family has a single datasheet that is 
marked "core," the system disables the include 
checkbox. 

Other Date

Global /No local labeling assessment 
required

Checking this option automatically marks any license 
using this data sheet, as assessed, and the license does 
not require any local labeling assessment.

Notes On clicking the notes icon, a pop-up appears to enable 
users to enter notes while entering the details of the 
Datasheet.

Listed Term This field displays the listed terms (Preferred Term) for 
the datasheet.

View Revisions Enables users to view a list of term that were added or 
removed with the added date.

New Name of the Datasheet Name 
(J)

Enables the user to rename the datasheet in Japanese.
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2. Select the Core Sheet check box, if this data sheet is required to be the core data 
sheet. Only one core data sheet is allowed per product.

3. Select the Include check box and select the value from a drop-down list. This helps 
you to indicate that this data sheet includes the particular datasheet selected in the 
drop-down list.

4. Select Global/No local labeling assessment required to automatically mark any 
license using this data sheet as assessed.

5. Click Add Term to select the listed terms (Preferred Term) for the datasheet. The 
MedDRA browser appears.

6. The MedDRA Browser available for Datasheets enables the administrator to select 
either multiple or all Preferred Terms (PTs) in the following way:

■ Click the required High Level Term (HLT) and select multiple PTs by clicking 
on each required PT.

OR

■ Right-click the HLT to select all entities available under PT.

7. Select the Preferred term from the MedDRA browser and click Select.

Note: If you want to make a copy of the datasheet, click Copy. 
Ensure that you enter a new name for the datasheet, if you are making 
a copy of another datasheet.

Tip: You can alternatively click Select and Close, in the MedDRA 
browser to save and exit the Product Family screen.

You can use Delete Term to delete the selected listed term(s) from the 
datasheet.
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8. Press Save to save the data sheet. The Data Sheet name displays in the Data 
Sheets list.

Adding a New Data Sheet
1. Click the New tab to open the Datasheet Name dialog box.

2. Enter the  English name of the datasheet in the Specify New Name of Datasheet 
field. 

3. Enter the Japanese name of the data sheet in the New Name of Datasheet (J) field).

4. Click OK.

5. Click Add Term or Add Term (J) button to open the MedDRA or MedDRA J 
broswers repectively.

6. Select the terms from either MedDRA or MedDRA J.

Configuring Products
Each company has a set of products to sell and a set of processes that are unique to its 
business.

The manner of product configuration in Argus Safety depends on how the company 
handles its internal workflow, related to the release of a product. Therefore the 
Administrator should be familiar with the business processes or workflow rules of the 
company.

Configuration of the product is done in the Business Administration -> Products and 
Licenses section.

When configuring a product, be aware of the following:

■ When the user clicks the Notes link on a data sheet, he/she can enter a maximum 
of 2000 characters in the Preferred Terms section of a data sheet as shown in the 
following illustration.

■ When the user clicks the Notes link, he/she can enter one note for each term.

■ The user can use the standard spell check function.

■ If notes have been entered for the term, the system displays the Notes icon to 
indicate that notes are present.

■ The system also prints the notes on the Product Family details.

Tip: To view the revision history associated with a Datasheet, click 
Revisions. A pop-up appears containing the following information:

■ Rev. No: Displays the revision number of the datasheet. This 
number is updated each time the data sheet is activated

■ Terms: Displays all the terms that were added / removed. In case 
a term has been deleted, it is marked with * against the term 
name.

■ Added On: Displays the date when the terms were added in the 
datasheet

■ Active On: Displays the date when the datasheet was made active 
for that revision
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■ A comments field that can contain up to 1000 characters has been added to the 
Product Family/Product/License and Study configuration elements.

■ The Product configuration also has a 50 character PSUR Name.

■ The Business Configuration reports print the contents of the Comments fields.

■ The system tracks any updates made to the data sheets in the audit log.

The following illustration shows the fields associated with this section.

Field Descriptions
The following table lists and describes the fields in this section.

Field/Control Name Description

Product Name Enables the user to enter the unique name for the product. 
The Product name must be at least five (5) characters.

Product Abbreviation Enables the user to enter a five-character abbreviation of the 
Product name which would be used in Case numbering 
when Product' is selected in the system numbering 
configuration in case of non-study cases.

By default, the system populates the field with the first five 
(5) characters of the generic name of the product family.

Ingredient Name Displays the Ingredients of the Product Family to which the 
Product belongs.

The user can alphanumerically sort the field.

Sorting on the ingredient name in the Product Configuration 
updates the sort order in the corresponding Product Family 
and all the other products which are part of the same family.

Dose Enables the user to enter the dose for the ingredient name.

The user can numerically sort the field.

Unit Enables the user to select the dose units for the ingredient 
name.

The user can alphabetically sort the field.
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Adding Products
This screen helps in capturing Product Details (product specifics, product licenses, 
products involved in the studies. These can be the products marketed, or under 
investigation, by the company. Every company product should belong to a product 
family. Each product within a product family shares the same key ingredient and data 
sheets but can have a different concentration for the key ingredient. This data is 
reflected in multiple expedited and periodic reports and case form-general 
information section.

Use the following procedure to add a product.

1. In the Business Configuration section, select Product and Licenses.

2. In the left panel, select a filtering criterion.

Generic Name Displays the generic name of the product. The field is 
populated by clicking the Copy from Ingredients button.

Product Dosage form Displays a formulation list. The list of formulations is 
maintained in the Formulation dialog in Code List section.

Manufacturer Displays a manufacturer list. The list of manufacturers is 
maintained through the Manufacturer dialog in Code List 
Maintenance.

Strength Enables the user to enter the strength of the product.

Units Displays a list of strength units. The list of Strength units is 
maintained through the Dosage Units dialog in Code List 
Maintenance.

WHO Drug Code - Select Provides the World Health Organization Drug Code from 
the Drug Coding dialog.

Company Code Enables the user to enter the company code for that product.

Model # Enables the user to enter the model number for that product.

International Birth Date Displays the international birthdate, which is automatically 
calculated from the earliest license, held against this 
product. This field is read only.

Primary Indication - Encode Displays a primary indication for the product using either 
the MedDRA or the ICD-9 Dictionary. (The dictionaries are 
configured through Case Form Configuration).

Device Code If configured for the product, the device code is printed on 
the MedWatch Device Report D2: Common Device Name 
section.

Lot # Enables the user to enter the lot numbers for the product.

Date Enables the user to enter the lot expiration dates for the 
product. 

Product Name (J) Contains a unique Japanesse name for the product.

Generic Name (J) Displays the generic name of the product. Click the Copy 
from Ingredient button, to generate the generic name.

J Drug Code -- Select Provides the J Drug Code from the Drug Coding dialog box.

PSUR Group Name This value is used to filter period reports in ARgus Safety.

Comments Enables the user to enter the reason for configuring the 
elements.

Field/Control Name Description
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3. Select a Product and click to view the product details in the right panel.

4. The details of the product appear in the right panel as shown.

5. Enter the Product Name and Product Abbreviation.

6. Enter the Dose information associated with the Ingredient Names in the Key 
Ingredients section.

7. Select the Unit information from the drop-down list, associated with the 
Ingredient Names in the Key Ingredients section.

8. Enter the Generic Name.

9. Enter the Dosage Formulation.

10. Enter the Strength of the dosage and select the Units from a drop-down list.

11. Click Encode to enter the Primary Indication. This enables you to display a 
primary indication for the product using either the MedDRA or the ICD-9 
Dictionary.

Note: Ensure that you select the second-level folder to view the 
details of the product.

Tip:

■ You can alternatively click Add Product to create a new product.

■ Use Copy to make an editable copy of an existing product.

■ Use Copy with Licenses to make an editable copy of an existing 
product, along with all associated licenses.

Tip: To copy all the Key Ingredients entered in the previous section, 
click Copy From Ingredients. This helps you to modify the list as 
required, instead of entering all the names manually
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12. Enter the Model # number associated with the product.

13. Select the Manufacturer from the drop-down list.

14. Click Select icon to select the WHO Drug Code associated with the product.

15. Enter the Company Code allotted for the product.

16. Enter the Lot# and Date associated with the Product.

17. Click Save to save the Product details.

About Filtering Criterion  The filtering criterion is essential as it helps you to search for 
specific items. The Argus Console provides this option for the Business Configuration 
section.

Using Organized by
The filtering browser displays in the top-left corner of the left panel. The Products and 
Licenses section can be filtered on the basis of any of the three combinations displayed 
below. Consider the following:

■ If you enable Organized byFamily/Product/License, the generated output is 
visible in a tree-format, in the left panel.

■ If you enable Organized byProduct/License, only the Product and License views 
are in the tree view in the left panel.

The Argus Console helps you to filter information further for the Business 
Configuration section. Once you have selected the Organized by, you can specify 
whether your search should contain or start with specific alphabets.

For example, the filtering criterion defined in the following illustration searches for all 
Family/Product/License data that contains the term Cure.

The left panel now displays the tree view of the Product Family->Product based on 
the filtering criterion.

Adding Products
Before adding products in Argus J, you should be aware of the following:

■ Argus J has a J Data Entry button to enable you to enter data in a popup window 
with equivalent content and enable you to enter Japanese equvalent text for each 
field.

■ Before clicking the J Data Entry button, all required fields on the English Product 
screen must be filled in. If you fail to enter the data in the required fields in the 
English screen, the system presents the following message, "Enter data in all the 
mandatory fields!" 

■ The popup contains all standard and J-specific fields and all fields are editable.

Tip: You can click Add to add new Lot# numbers. If you wish to add 
the current date in the Date field, use the = sign on your keyboard as a 
short-cut.

Tip: If you have added a new Product, click Add Product to save the 
new Product.

Tip: The number displayed next to the folder signifies the number of 
licenses within that product.
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■ The Encode button invokes the MedDRA J browser and stores the MedDRA J term 
in the Indication. 

■ The Copy Products  Only, Copy Products with Licenses buttons, and the 
right-click menu options display corresponding Japanese values

■ Only the Save, Print, and Cancel buttons are available. 

■ The system copies the licenses under the product to the new copied product but 
excludes any references to other products. 

■ The system provides the following functionality when navigating from an English 
screen to the J popup for an existing product

– When you click the J Data Entry button, the system presents the following 
message: "Do you want to save the changes before opening the Japanese 
screen?"

– If you choose to save the data, the system saves the data and the changes are 
reflected on the Japanese screen.

– If you choose not to save the dta, the changes made on the English screen will 
not be reflected on the Japanese screen

■ The system provides the following functionality when navigating from an English 
screen to the J popup for new product:

– When you click the J Data Entry button, the system presents the following 
message: "Data must be saved before opening the Japanese screen. Do you 
want to save?"

– If you choose to save the data, the system saves the data and the changes are 
reflected on the Japanese screen.

– If you choose not to save the data, the system will not open the Japanese 
screen.

■ The Drug Code section has the following functions:

Configuring Licenses
Once product configuration is complete, you must create product licenses. Licenses are 
issued for pre-market and post-market release of a drug, device, or vaccine. 
Investigational (pre-market) licenses are issued for studies done at study centers and 
marketed licenses are issued for release of product. Configuration of licenses related to 
a product is a key step in the configuration of Argus Safety.

Configure licenses in the Business Administration -> Products and Licenses section. 
When configuring product licenses, be aware of the following:

Field Description

J Drug Code Click this  button to identify the J drug code. This is 
the default. If you select a J drug from the J Drug 
Dictionary browser, the system populates the field 
with the J drug code.

OTC Drug Code Click this  button to identify the OTC drug code. 
You must enter the drug code manually.

Temporary Code Click this  button to identify the Temporary drug 
code.You must enter the drug code manually.

J Drug Code (Search) Click to search for the J Drug code.
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■ The user can enter Medical Device Information in the licenses as shown in the 
following illustration.

■ The user can enter the following values in the Medical Device Information:

– AIMD Active Implants

– MDD Class III

– MDD Class IIb

– MDD Class lla

– IVD Annex II List A

– IVD Annex II List B

– IVD Devices for Self-testing

– IVD General

– Blank (default)

■ The user can enter up to 20 characters in the PMA?510(k) # field. By default, the 
field is empty.

■ The user can enter a five-digit Nomenclature Code.

– This must be a numeric value.

– By default, the field is empty.

■ The system tracks license updates in the audit log.

■ These values display on the License report.

The following illustration shows the fields associated with this section.

Field Descriptions
The following table lists the Field Descriptions for the License configuration section.

Field/Control Name Description

Trade Name Enables the user to enter the Trade Name under which this product(s) is 
(are) authorized by this license.
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Trade Name J Enables the user to enter the Japanese trade name under which. the 
product is authorized by this license.

Award Date Enables the user to enter the license award date for this license.

Withdrawn Date Enables the user to enter the license withdrawal date for this license. 
The withdrawn date cannot be less than the award date.

Market 
Authorization Holder

Enables the user to select a manufacturer or co-marketing partner for 
this license of the product.

PMDA 
Re-examination Date

The date of the next PMDA examination.

Biologic / Vaccine Whether the license is for a Biologic/Vaccine (this can impact reporting 
rule).

If this is option is checked MedWatch will print PLA# not NDA# in 
section G5. It is included to support the Biologic License Application 
(BLA) and the Product License Application (PLA) requirements.

Not in Tradename 
lookup / Not 
Auto-scheduled

An option to indicate that this license name should not appear in the 
filter criteria for Auto Scheduling of Reports or trade name lookup 
browser.

When this checkbox is checked, the trade name will not appear for this 
license in the Trade Name Lookup dialog and this license will not be 
evaluated or allowed for auto scheduling of the reports, but will be 
available for manual scheduling of reports.

The license will be displayed in event assessment.

Labeled for Single 
Use

Whether the drug is for single use (such as disposables)

If this option is selected it will mark YES in section H5 of the MedWatch 
device form, otherwise it will mark NO.

OTC Product This enables the user to specify if the Product has been bought as an 
Over-the-Counter Product.

Datasheet URL User can enter a hyperlink to a site giving information about the 
datasheet of the product.

Countries List Enables the user to select all the countries in which the same license 
was issued.

Authorization 
Country

This enables the user to select the Country for which this license 
applies.

The chosen country does not impact the reporting rules algorithm. This 
field maps to the Country' field in the Reporting rules configuration.

License Type The user can select one of the possible six types:

Investigational Drug/Device/Vaccine or Marketed 
Drug/Device/Vaccine

The chosen license type maps to the License type field under each 
country on the Reporting rules configuration.

Datasheet Name The datasheet drop-down enables the user to associate a datasheet with 
the License.

The field lists the datasheets for all the product families of the added 
products.

The Data Sheet drop-down is enabled when one or more products have 
been added to the Products list.

License # Enables the user to enter the License Number which will be referred in 
the regulatory reports like NDA, IND.

Field/Control Name Description
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Adding Product Licenses
This screen helps capture License information (License specifics, associated with the 
License, Countries where the product is marketed or is under investigation). This data 
is reflected in multiple expedited and periodic reports and in case form-product 
information section.

Use the following procedure to add a product license.

Company Item 
Number

Enables the user to enter the Company Item number corresponding to 
the license.

Trade Name J Enables the user to enter the Japanese trade name.

Clinical Compound 
Number

The number that identifies the specific chemical compound.

■ You can edit this field when the Authorization Country is "Japan" 
and the license type is either "Investigational Drug" or 
"Investigational Vaccine."

■ The Clinical Compound field is only available to users to Argus J.

Product Name (J) The Product List box displays the list of products (product name, 
dosage form and strength) that this associated license covers for 
regulatory reporting purposes.

Countries List Enables the user to select all the countries in which the same license 
was issued. The system adds the authorization country to the Countries 
Lise and updates the list when the user updates the authorization 
country.

Product Name The Product List box displays the list of products (product name, 
dosage form and strength) that this associated license covers for 
regulatory reporting purposes.

Hide When a product is marked as non display, it will not appear in the 
Trade Name Product lookup dialogue associated with the license 
tradename.

PMA/510(k)# This field is  associated with medical device information and prints in 
expedited reports.

Nomenclature Code This field is  associated with medical device information and prints in 
expedited reports.

Medical Device 
Information

This field is associated with medical device information and can contain 
the following values:

■ AIMD Active Implants

■ MDD Class III

■ MDD Class IIb

■ MDD Class IIa

■ MDD ClassI

■ IVD Annex II List A

■ IVD Annex II List B

■ IVD Devices for self-testing

■ IVD General

■ Blank (default)

CTRP Group Name This value is used in Argus Safet when filter periodic report data.

Comments Enables the user to enter information about the element configuration.

Field/Control Name Description
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1. In the Business Configuration section, select Product and Licenses.

2. In the left panel, select a filtering criterion.

3. Expand the folders till you reach the license associated with a product.

4. Select a license and click to view the license in the right panel.

5. The system opens the following screen.

1. Enter the Trade Name of the license.

2. In the Manufacturer list, select the manufacturer of the product.

3. Select the AuthorizationCountry in which the license was issued.

4. Select the License Type. This is the type of license.

5. Enter the license number in License#.

6. If this license is to be reported under the PLA# and not the NDA# select the 
Biologic/Vaccine checkbox. If this checkbox is selected, the PLA# (and not the 
NDA#) will be printed in section G5 of the MedWatch form.

7. Specify if the drug is Labeled for Single Use or not.

8. Specify if the drug has been bought as an Over-the-Counter (OTC) Product.

9. Under Award Date, enter the date the license was granted to the 
manufacturer.

10. Enter the Withdrawn date, if applicable.

11. Enter the Company item number in Company item number.

12. Enter a URL reference for the license under Data Sheet URL (A URL reference 
might be a link to product label or product information).

13. A world wide web address or an appropriate network path (For example: 
http://anydomainname/anypath or \\FILESERVER\LOCATION) can be 
entered in this field.
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14. Select Not in Tradename lookup/Not Auto-Scheduled if this license is not to 
be involved in reporting.

15. In the Countries List, select the countries that define whether the case will be 
classified as domestic or foreign for regulatory report scheduling algorithm.

16. Select the Data Sheet Name associated with the license, from the drop-down 
list.

17. Click Add in the Product Name/Dosage Form/Strength to add a product to 
the License

6. The ProductBrowser dialog opens.

7. Enter the name (partial or full) of the product and select FullSearch.

8. Select the appropriate product in the search results and click Select. Enter all the 
required products in this manner. Click here for more information on Product 
Browser.

Using the Product Browser
1. Click on Add Products to add products.

2. The Products Browser window opens:.

■ Enter the Ingredient key word for the search. The ingredient is displayed in 
the first column.

■ Select the Ingredient to obtain the Family it is associated with.

■ Select the Product Name to view the associated Trade Names.

■ Select the Trade Name required.

3. Select is now enabled at the bottom of the window.

4. Click Select to add the product details under the Product Name section. The 
Product Name is displayed in under the Product Name section.

Tip: To modify this list, use the Modify option (placed next to the 
Countries List).

Tip: You can alternatively click Add License to create a new license.

Use Copy to make an editable copy of an existing license.
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5. The product browser available for datasheets, enables the administrator to select 
either multiple or all Product Names as follows:

■ Click the Family name and select multiple Product Names by clicking on each 
required Product Name.

OR

■ Right-click the Family name to select all entities available under Product 
Name.

6. Click Save to save the changes.

Configuring Clinical Studies
It is important to configure clinical studies in the Argus Console because it helps the 
system categorize the source of information for the cases that have been registered. 
This screen helps in capturing Study information (study specifics, products involved 
in the study licensed countries associated with the study and the clinical references 
used in the expedited reports.

Configuration of the product is done using the Business Administration->Studies 
section.

When configuring clinical studies, be aware of the following:

■ The Study screen has a J Data Entry button that is available only to J users.

■ When you click the J Data Entry button, the system presents a message telling you 
to enter data in the required fields (Study ID, Project ID, and at least one (1) 
Product) before opening the Japanese translation window.

The Study Type value displays in Japanese and can be one of the following: 

Tip: If you have added a new License, click Add License to save the 
new License.
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– Single Blinded

– Double Blinded

– Not Blinded

■ The License Type value displays in Japanese and can be one of the following:

– Investigational Drug

– Investigational Device

– Investigational Vaccine

– Marketd Drug

– Marketed Device

– Marketed Vaccine

■ When you click Add J Drug, the system opens the J WHO Drug Lookup Window 
to enable the user to  add a J Drug. The system adds the drug to the product 
section of the pop-up.

■ The WHO Encoded column has an Encode button. Click this button to open the 
WHO Drug browser. This enables you to associated the corresponding WHO drug 
with the J Drug if it is available. The associated WHO drug appears in the product 
section of the English screen.

■ Before closing the J pop=up, the system reminds the user to associate 
corresponding WHO drugs with the J drugs.

■ All error messages are in English.

■ After saving the data in the pop-up window, the system makes the same changes 
on the English screen. 

■ In browser view, the system displays the Englich product name by default. If the 
English product name is not availabe, the system displays the Japanese product 
name.

■ Clicking Save closes the window and saves the data, if all J drugs are WHO 
encoded. If they are not WHO encoded, the system presents the following 
message: Some J drugs are missing WHO drug association. Do you still want to 
close the J Data Entry dialog? 

■ Spell check is notavailable in the Study description dialog.

■ When you click Auto Encoding on the J-popup, the system opens the Auto 
Encoding dialog box

The following fields appear in the dialog box:

– Drugs

– Events & Indications

– Prevent manual encoding for event

– Require Events & Indications encoding before case closure

■ When you click the Centers--Modify button, the system opens the Modify Study 
Center dialog box.

This dialog box contains the following fields:/controls

– Center

– Selected Center
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– Add

– Add All

– Delete All

– Delete

– OK

– Cancel

■ When you copy data, the system does not copy the equivalent Japanese data.

■ When you copy data, the application puts "Copy of" at the beginning of the data in 
the Name field.

■ You can save a duplicate last name if the English ID is unique. If the ID is not 
unique, the system presents the following message: "A duplicate Study ID already 
exists!"

■ If the Japanese name is not unique, the system presents the following message:  "A 
duplicate ID already exists!"

■ When navigating from the English screen to the J pop-up for an existing study:

– When you click the J Data Entry button, the system prompts you to save the 
data on the English screen before opening the J screen:  "Do you want to save 
the changes before opening the Japanese screen?"

– If you choose to save the data, the system saves the data and the changes 
appear on the J screen.

– If you choose not to save the data, then changes made on the English screen 
will not appear on the J screen.

■ When entering a new study:

– When you click the J Data Entry button, the system asks you to save the data 
on the English screen before opening the J screen. The message is: "Data must 
be saved before opening the Japanese screen. Do you want to save?"

– If you choose to save the data, the system saves the data and the equivalent 
data appears on the Japanese screen.

– If you choose not to save the data, the system will not open the J screen.

The following illustration shows the fields associated with this section.
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Field Descriptions
The following table lists and describes the fields in this section.

Field/Control Name Description

Study ID This is the Study ID.

Study Name This is the Study Name. 

Project ID This is the project ID for the study.

Study Type The user can select a study type associated with this study.

Other ID This is another ID to refer to this study.

Template Only

Observe Study Type 
(E2B)

This enables the user to select the study type from a drop-down list.

■ This element is populate from the Case From Clinical Study section 
of the application.

■ The value selected in Study Configuration, "Observe Study Type 
(E2B)" is populated in the the Case Form Study section when the 
user selects the Clinical Study.

■ The system updates the standard E2B profiles (EMEA, FDA, and 
ICH) to populate the tag.

Study Development 
Phase

Enables you to choose the study phase.

Products

Product Name This is the Product Name.

Dosage Form This is the Product formulation.

Strength This is the Product Concentration.

Units This is the Product Units.

Products -Add WHO 
Drug

Opens Search Screen for selecting a non-company product.

Products -Add 
Product

Opens Search Screen for selecting a company product.

Products -Delete Deletes the selected product row.
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Clinical References

 Reference Type Shows the various reference types that can be setup for this study.

 Country Enables the user to select a country for the clinical reference type.

Reference Number Captures the reference number that will be reflected on the regulatory 
reports.

Add Enables the user to add another clinical reference.

Delete Enables the user to delete the selected clinical reference.

Countries Enables the user to select a country for the clinical reference type.

Product License This is the license of the primary (company) product participating in the 
study.

Product Abbreviation This enables the user to enter an up to 5 character abbreviation of the 
study name which would be used in Case numbering when Product' is 
selected in the system numbering configuration in case of study cases.

 Centers The system displays the selected study centers for the study.

Study Description Enables the user to enter a brief description of the study.

Opens the study description in zoom mode and provides a spell check 
dialog.

Opens the multi lingual dialog allowing the user to choose the language 
by clicking on the relevant flag of the country.

Investigator Alert Enables the user to select an existing Advanced Condition. Under 
Investigator alert, an advanced condition can be created / selected. 
When this condition is satisfied, the system automatically sends an 
e-mail to the investigator group associated with this study.

Investigator Alert - 
select

Opens up the advance condition browser.

Study is eligible for 
Unblinding

Check this box if the study can be unblinded. If the Study Type selected 
is Not Blinded", this field is disabled.

Enable Study Specific 
Encoding

User checks this box if Study specific Auto encoding has to be enabled.

Autoencoding : 
Drugs(dict)

If unchecked (default state) the study will use the dictionaries 
configured using the Case form Configuration options.

If checked, the Auto encoding button is activated.

Autoencoding : 
Events & Indications

Select this field to enable the system to encode Events & Indications 
using the dictionary the user selects from the list.

Study Reporting

Products -Add 
Product

Opens Search Screen for selecting a company product.

Products -Delete Deletes the selected product row.

Inherent Reporting 
Rules Form

Field/Control Name Description
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Argus J specific Fields

Always report Usually the study-specific reporting is configured to handle reporting 
requirements for non-company products, e.g. Placebo or a comparator, 
as the company-based reporting is taken care by the license based 
reporting logic utilized in Argus.

However, checking this checkbox will force Argus to check for 
qualifying expedited reporting rules based on the country, license type 
and reporting destination specified even if no non-company products 
are identified as study drugs.

If the checkbox is unchecked then expedited reports based on the 
study-specific reporting rule will only be scheduled if there is a 
non-company product identified as a study drug.

Country Specifies what country's reporting rules the console should consider. 
The list includes countries for which the expedited reporting rules exist.

License Type Specifies what license type to consider for the specified country. Only 
applicable license types, i.e. Marketed Drug, Device, Vaccine or 
Investigational Drug, Device, Vaccine are displayed in this drop down 
list.

For example if a country Germany" only has reporting rules for 
investigation drugs, then Investigational Drug" is the valid drop-down 
element.

Reporting 
Destination

This field is optional and by default will have the value All.

Specifying any value in this list limits the reporting rules to be 
evaluated to the selected country, license type and reporting 
destination. The drop-down list is filled with valid destinations 
(regulatory authorities) for the country and license type selected based 
on the expedited reporting rules.

For example, if the user has selected Germany, Investigation Drug and 
there are reporting rules for Germany with destinations of BfArM" and 
Drugs R us" then only these two destinations (LM: regulatory 
authorities) are displayed.

Time Frame This field cannot be searched or altered, but is included for 
informational purposes.

Based on the country, license type and reporting destination selected, 
the system determines and displays all possible time frames in 
ascending order separated by a comma.

Possible Report 
Forms

This field cannot be searched or altered, but is included for 
informational purposes.

Based on the country, license type and reporting destination selected, 
the system should determine and display all possible report forms in 
alphabetical order separated by a comma.

Field/Control Name Description

Clinical Compound 
Number

Enables the user to enter clinical compound information.

Target Disease 
Indication

Enables the user to enter disease information.

Study Development 
Phase

Displays a list of all valid study development phases 
configured in the study development code lists.

Field/Control Name Description
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Adding Clinical Study Configurations
This screen helps capture study information (study specifics, products involved in the 
study licensed countries associated with the study and the clinical references used in 
the expedited reports). Study Information is required if a case has been reported while 
conducting a study and the participating product(s) belong to the company. This data 
is reflected in multiple expedited and periodic reports and case form-general 
information section.

Be aware of the following:

■ The IND Reference Number drop down displays only those reference numbers 
(license numbers) associated with a product with a License Type of 
Investigational.

– Console --> Business Configuration --> Studies --> Clinical Reference section 
(in middle of screen).

– The Reference Number drop down field should be limited to IND 
(Investigational) US Licenses Number only.

■ The Study Name on the Study Configuration can be a maximum 70 Characters 
(same as the Product name)

Use the following procedure to add a study.

1. In the Business Configuration section, select Studies.

2. In the left panel, select a filtering criterion.

3. Select a Study and click to view the study details in the right panel.

4. The details of the study appear in the right panel.

Are any subjects 
given this 
investigational drug?

Comments Enables you to enter relevant comments regarding the study.

J Data Entry This button appears only to Argus J users. When you click J 
Data Entry the application opens the Study Configuration 
dialog box with Japanese localization.

Note: Ensure that you select the study-level folder to view the details 
of the study.

Field/Control Name Description



About Business Configuration

Business Configuration 3-27

5. Enter the Study ID and Study Name associated with the Study.

6. Select the Project ID for the Study, from the drop-down list.

7. Select the Study Type associated with the Study, from the drop-down list.

8. Enter the Other ID. This will be an alternative id for the Study.

9. Select Template to associate a template with the Study.

10. Select the Observer Study Type(E2B) from the drop-down list.

About Filtering Criterion  The filtering criterion is essential as it helps you to search for 
specific items. The Argus Console provides this option for the Business Configuration 
section.

Using Organized by
The filtering browser displays in the top-left corner of the left panel. The studies 
section can be filtered based on of any of the three combinations shown in the 
following illustration. The generated output is visible in a tree-format, in the left panel, 
based on the entire categorization of Projects, Studies, Products.

Tip:

■ You can alternatively click Add Study to create a new study.

■ Use Copy to make an editable copy of an existing study.

■ Use Copy with Products to make an editable copy of an existing 
study, along with all associated products.
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If you enable the Organized by Study/Products, only the Study and Product views 
will be available in the tree view in the left panel.

The Argus Console helps you to filter information further for the Business 
Configuration section. Once you have selected the Organized by, you can specify 
whether your search should contain or start with specific alphabets.

The filtering criterion shown in the following illustration, enables the system to search 
for all Projects/Studies/Products data that contain the term Cure.

The left panel displays the tree view of the Projects/Studies/Products based on the 
filtering criterion.

Adding WHO Drug Details
Use the following procedure to add WHO Drug detail information.

1. Select Add WHO Drug in the Products section to add the WHO Drug details 
associated with the Study.

2. Click on WHO Drug to add WHO drug details (using the WHO Drug browser 
window) associated with the Study.

3. The system opens the WHO Drug browser window.

Tip: The number displayed next to the folder signifies the number of 
studies/products within that project/studies family.
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4. Select the Trade Name or the Ingredient radio-button, to search for the WHO 
Drug term associated with either the Trade Name or the main Ingredient of the 
drug.

5. Click Search to execute the search. The data is displayed as follows.

6. Select the required component/row (this can be the key Trade Name or 
Ingredient).

7. The row now appears highlighted and the Drug Details section displays the 
associated information.

8. ClickSelect to add this drug information in the Product Name section of the 
Studies Configuration window.

9. The WHO Drug browser window closes and the drug appears in the Product 
Name section.

1. Select Add Product in the Products section to add the products associated 
with the Study.

2. Click on Add Products to add products. The Product Browser window 
appears.

3. Enter the Ingredient key word for the search. The ingredient is displayed in 
the first column.

4. Select the Ingredient to obtain the Family it is associated with.

5. Select the Product Name to view the associated Trade Names.

6. Select the Trade Name required.

7. Select is now enabled at the bottom of the window. Click Select to add the 
product details under the Product Name section. The Product Name is 
displayed in under the Product Name section.

8. Select the Reference Type associated with this Study, from the drop-down list.

Tip: To delete a product, select the product and click Delete (placed 
next to Add Product). A pop-up appears asking you to confirm the 
action.
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9. Select the Country associated with this Study, from the drop-down list.

10. Enter the Reference Number associated with the Reference Type in this Study.

11. The Countries field is a display only field. You can Add or Delete this list 
based on your requirements.

12. Select the Product License from the drop down list. This is the license of the 
primary (company) product participating in the study.

13. Enter the Product Abbreviation.

10. The Centers are displayed as per the centers you choose to associate with the 
Study. To modify this list, click on Modify (placed next to Centers). Using this 
option you can add and delete Centers associated with the Study.

11. Enter the Study Description associated with the Study.

12. Click Select placed next to Investigator Alert to select or create an Advanced 
Condition for this Study.

13. Select Study is eligible for Unblinding to enable the study to be unblinded.

14. Select Enable Study Specific Encoding to enable the study specific Auto 
Encoding.

Configuring Auto Encoding
The Auto Encoding features helps you to configure your own dictionary of encoded 
data. Using this enables you to:

■ Configure studies to use dictionaries different from the dictionaries configured 
using the Case Form configuration.

■ Retrieve coded Events, Drugs and Events & Indications and codes from the lists 
associated with this section.

■ Ensure that the expedited reports display the correct verbatim and coded terms

Use the following procedure to configure Auto Encoding.

1. Click Auto Encoding to open the Auto Encoding dialog. The Auto Encoding 
dialog opens.

Tip:

■ To add more Reference Types in the Clinical Reference section, 
simply click Add . A new row is added to this section.

■ To delete the Reference Type, select the Reference Type and click 
Delete (placed next to Add). A pop-up appears asking you to 
confirm the action.

Tip:

■ To add more Centers to the Study Center list, use the Add>>/ Add 
All .options.

■ To delete the Centers from the Study Center list, use the 
Delete>>/Delete All options.

Tip: Click here for details on Advanced Conditions
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2. Select the encoding options as required for Drugs and Events & Indications. Use 
the items in the list to encode. For Study Encoding, go to Console -> Business 
Configuration -> Studies -> Study Encoding to support Central Encoding for 
Events & Indications for study cases in a similar way as for non-study cases. 
Checking the Central Encoding checkbox also ensures that Central Encoding also 
gets reflected (as configured here) in the Argus Case Form, for study cases.

3. Select Prevent manual encoding for Events & Indications , if you want to disable 
manual encoding by users.

4. Select the Require event term encoding before case closure, to ensure that the 
expedited reports display the correct verbatim and coded terms.

5. Select Inherit Reporting Rules From using the drop-down list to configure 
study-based reporting requirements.

Note: If this feature is not selected, then the study will use the 
dictionaries configured using the Case Form Configuration options.

Cases where the report type does not include clinical trial cases, will 
always encode with the dictionaries configured through the Case 
Form configuration options.
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Configuring Study Reporting
Study Reporting is provided in the Study Configuration section to configure 
study-based reporting requirements.

The reporting rules are not directly defined in the study, but rather identify which 
reporting rules to check from the already configured expedited reporting rules.

The identification is based on specifying what set of reporting rules to evaluate, as per 
the criteria of:

■ Country

■ License Type

■ Reporting Destination

Use the following procedure to configure study based reporting.

1. Click Add in the Inherit Reporting Rules From section. The Study Reporting 
dialog opens.

2. Select Always Report as required.

3. Select the Country from the drop-down list.

4. Select the License Type from the drop-down list.

5. Select the Reporting Destination from the drop-down list.

6. The Time Frame and Possible Report Forms cannot be searched or altered, but is 
included for informational purposes.

7. Click Save to save the changes made to the Studies section.

Tip: Select this checkbox to force Argus to check for qualifying 
expedited reporting rules. These rules are based on the country, 
license type and reporting destination specified. Refer to the Field 
Descriptions for details.

Tip: This field specifies which country's reporting rules should be 
included. The drop-down list includes countries for which the 
expedited reporting rules exist.

Tip: This field specifies the license type to be considered for the 
specified country. Refer to the Field Descriptions for details.

Tip: This field is optional.

Tip:

■ To add information pertaining to inheriting reporting rules in the 
Study Reporting section, click Add

■ To delete information pertaining to inheriting reporting rules in 
the Study Reporting section, select the reporting rule and click 
Delete. A pop-up appears asking you to confirm the action.

Tip: If you have added a new Study, click Add Study to save the 
new Study.
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Configuring Expedited Report Rules
This section describes the configuration of Expedited Reports using pre-defined rules. 
These reports are required by Regulatory Authorities. The Administrator is 
responsible for entering information about Regulatory Authorities to which regulatory 
reports will be submitted.

This information is entered in the Regulatory Agency Information screen. Information 
about the local company contact for a regulatory authority can also be entered in this 
screen.

Configuration of the expedited report rules is done using the Business 
Administration -> Expedited Report Rules section shown in the following 
illustration.

When configuring expedited reporting rules, be aware of the following:

■ If the user does not have permission to access Advanced Conditions on the 
Expedited Reporting Rules, the system does the following:

– Displays the advanced condition name instead of displaying a blank.

– Does not permit the user to modify or view advanced condition details.

– Disables the Adv Condition button.

■ The system enables the user configure the Blinding Study Products option for 
those included in the case (default unchecked).

– The system track updates to this field in the audit log.

– The Reporting Rules reports print the new options

■ For cases where expedited reports are due, the user can force-distribute expedited 
reports even if processing is incomplete.

■ The reporting rules have a Forced Distribute XXX days before due checkbox. The 
default is unchecked.
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– If the user checks the Force Distribute option, the # of days before due field is 
entered and automatically checks the Auto Distribute checkbox on the 
reporting rule (grayed out).

– The user can enter the number of days from 0 - # of days defined within the 
time frame.

– If the user enters a value greater than the defined time frame, the system 
displays the following message:

Please enter a value less than the Time Frame defined for the Reporting Rule.

– If the user has not checked Force Distribute, the system disables the days 
before due.

■ The system tracks updates made to the new Argus Console fields in the audit log.

■ The system prints an audit log and print out that shows the expedited report rules 
information as shown in the following illustration.

■ A super rule  is a rule that overrides other rules when it finds a match. Be aware of 
the following:

– The system executes a super rule before executing any other reporting rules.

– If a super rule matches, it executes all the super rules but does not execute 
other rules.

– If the super rule does not match, the application executes the other rules.

Field Descriptions
The following table lists and describes the fields in this section.

Field/Control Name Description

Report Name Enables the user to view or enter the name of the Report.

Report Destination Enables the user to select the name of the agency to which the report 
will be scheduled.
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Active Enables the user to specify whether the configured rule is active or 
inactive.

■ Only active rules are considered for report scheduling.

■ Inactive rules are not checked when the report scheduling 
algorithm runs.

Auto Distribute 
Reports

Enables you to distribute reports automatically. Except the E2B Reports, 
all the Expedited Reports that are selected for auto-distribution are 
tracked under the Worklist--> Bulk Transmit screen. The E2B Reports 
which are transmitted automatically, are tracked from Worklist--> Bulk 
Transmit E2B.

Protect Reporter and 
Patient 
Confidentiality

Enables the user to configure Protect Reporter and Patient 
Confidentiality

■ If this option checked and a report is generated or draft is viewed, 
the Patient and Reporter information will be hidden.

■ This option will override the check-boxes on the case form (for 
Protect Reporter and Protect Patient) if it is checked.

■ If this option is unchecked, the Case Form check-boxes will take 
effect.

■

■ The Reports listed below will check for the Reporting Rule 
Confidentiality Flag:

■ EU Device Initial

■ EU Device Final

■ French CERFA Report

■ CIOMS Report

■ MedWatch Report

■ Vaers Report

HCP Case When checked, the system check for any reporter in the case where 
HCP=Yes. This enables the report to be scheduled if other parameters 
for the reporting rules are satisfied.

The default is unchecked.

Report on Study 
Drug not 
Administered

If this field is not checked and a study drug (any in case) has not 
administered checked then no report is scheduled.

Active Moiety Enable this check-box to enable rule to act exclusively as an active 
moiety rule for that country.

When this option is enabled the system will disable and ignore the 
county when evaluating the domestic/foreign causality sections. 
Listedness will be evaluated at the case level.

No Follow-up or 
Downgrade

The system does not schedule a follow up or a downgrade report for 
the case when the the initial report was scheduled based on the current 
rule.

Origin of Events to 
Include - Domestic

Enables the user to select the inclusion of domestic or foreign cases 
based on their country of incidence.

■ Domestic: The event is marked as Domestic, if the country of 
incidence appears in the list of selected countries.

■ This list is displayed in the Countries tab, in the List Maintenance 
Licenses (section) for the license(s) of the suspect product(s) under 
examination.

Field/Control Name Description
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Origin of Events to 
Include - Foreign

Enables the user to select the inclusion of domestic or foreign cases 
based on their country of incidence.

■ Foreign: The event is marked as Foreign, if the country of incidence 
does not appear in the list of selected countries.

■ This list is displayed in the Countries Tab on List Maintenance 
License (section) for the license(s) of the suspect product(s) under 
examination.

Timeframe This field specifies the report's scheduled due-date based on the 
number of days, after the initial receipt or significant follow-up date.

Form This is the drop-down list of expedited report forms.

Local Comment Type This field is used to extract the local evaluator comment from case data 
(French CERFA 65-0044, CIOMS-I (Local)).

Clinical Reference 
Type

This field is used to get information from the study configured for a 
case. The field is only enabled for CIOMS-I (Local) form.

Language Enables the user to select language type.

■ English is the default language of choice.

■ The system does not support other languages at this time.

■ Reports such as the German BfArM, German PEI, and French 
CERFA can utilize some field values in their corresponding 
language (For example: narrative).

Message Type Enables you to select the message type.

Message Type Enables the user to select the message type for E2B report forms.

Listedness Enables the user to check if the license being evaluated for reporting is 
listed. The possible values are:

■ Listed

■ Unlisted

■ Ignore (default)

Seriousness - 
Fatal/Life 
Threatening

Enables the user to check if the case contains a Death' or Life 
Threatening' seriousness criteria for the current event being evaluated. 
The possible values are:

■ Yes

■ No

■ Ignore (default)

Seriousness - Serious 
(Case)

Enables the user to check if case level seriousness assessment is 
Serious'. The possible values are:

■ Yes

■ No

■ Ignore (default)

Seriousness - Serious 
(Event)

Enables the user to check if the event level seriousness assessment (for 
any event) is Serious. The possible values are"

■ Yes

■ No

■ Ignore (default)

Seriousness - Severity Enables the user to select a term descriptive of the severity of the event. 
E.g. Mild, Moderate, severe, unknown.

Field/Control Name Description
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Product Specific - 
Family Name

Enables the user to configure product specific reporting rules.

Product Specific - 
Product Group

Enables the user to configure product specific reporting rules.

Product Group drop-down always lists the configured Product 
Groups".

Causality - Most 
Conservative

If this checkbox is marked, the system will look at the event level 
reported causalities, event level determined causalities and case level 
causalities, and if any of these three causalities is Yes then the case will 
be considered Reportable.

If checked, the following options are hidden and set to Ignore":

■ Causality as Reported (Event)

■ Causality as Determined (Event)

■ Causality as Reported (Case)

■ Causality as Determined (Case)

■ Causality is ignored when scheduling reports for non - study cases. 
This only Study cases.

Causality - Include 
Non-Clinical Trial 
Cases

Enables you to include the Spontaneous Cases (Non Clinical Trial 
Cases) for causality assessments.

Causality - Causality 
as Reported (Event)

Assesses As Reported causality in conjunction with the Listed value (if 
any) specified in the rule for the license/event combination being 
assessed. Ignored for non-study cases. Only applies to Study cases. The 
possible values are

■ Reportable

■ Non-reportable

■ Ignore (default)

Causality - Causality 
as Determined 
(Event)

Assesses As Determined causality in conjunction with the Listed value 
(if any) specified in the rule for the license/event combination being 
assessed. Ignored for spontaneous, literature and regulatory authority cases.

Ignored for non - study cases. Only applies to Study cases.

The possible values are:

■ Reportable

■ Non-reportable

■ Ignore (default)

Causality - Causality 
as Reported (Case)

Most conservative of the As Reported causalities in event assessment 
for ANY event.

Ignored for non - study cases. Only applies to Study cases.

The possible values are:

■ Reportable

■ Non-reportable

■ Ignore (default)

Field/Control Name Description
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Adding Expedited Report Rules
The Reporting Rules configuration feature enables you to define the reporting rules or 
criteria for the cases to be qualified for expedited reporting.

Use the following procedure to add expedited report rules.

1. In the Business Configuration section, select Expedited Report Rules.

2. In the left panel, select a filtering criterion. The left panel now displays the tree 
view of the Country/License Type/Reporting Rule based on the filtering criterion.

3. Select a Reporting Rule and click to view the reporting details in the right panel.

Causality - Causality 
as Determined (Case)

Case Level Causality, as observed on the Analysis tab for the Case Level 
Causality.

Ignored for non - study cases. Only applies to Study cases.

The possible values are:

■ Reportable

■ Non-reportable

■ Ignore (default)

Advanced 
Conditions

This field enables the selection of an advanced condition to further 
restrict cases that meet the criteria for the rule.

Advanced 
Conditions - Select

Enables the user to open the Advanced Condition Browser.

You can click this button to open the Advanced Conditions browser to 
select / create an Advanced Condition.

Responsible Group Enables the user to select a group to whom reports scheduled by this 
rule will be assigned.

Cover Letter Enables the user to use letters that have been configured for reporting 
template use.

Comments Enables the user to enter reporting rule comments, up to 2000 
characters.

Note: Ensure that you select the reporting rule-level icon/folder to 
view the details of the reporting rule.

Field/Control Name Description
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4. Enter the Report Name.

5. Select the Report Destination from the drop-down list. This is the name of the 
agency to which the report will be scheduled.

6. Select Auto Distribute Reports to distribute reports automatically.

7. Select Active to specify if the configured rule is active or inactive.

8. Select Origin of events to include-Domestic to include domestic cases based on the 
country of incidence OR Select Origin of events to include-Foreign to include 
foreign cases based on the country of incidence

9. Select Report on Study Drug not Administered. This option ensures that all study 
drugs that are not administered are reported.

10. Select Active Moiety if you want to enable this option.

11. Select the required Form from the drop-down list of expedited report forms.

12. Select the Local Comment Type from the drop-down list. This field is used to 
extract local evaluator comments from case data.

13. Select the Clinical Reference Type from the drop-down list. This field is used to 
obtain information from study configured for a case.

Tip: ■You can alternatively click Add Rule to create a new reporting 
rule.

■ Use Copy Rule to make an editable copy of an existing reporting 
rule, along with all associated expedited reporting rule 
information.

Note: Only active rules are considered for report scheduling
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14. Select the Language and Message Type from the drop-down list.

15. Select the Listedness from the drop-down list. This ensures that the license being 
evaluated for reporting is listed.

16. Select the Seriousness- Fatal/Life Threatening option from the drop-down list. 
This field ensures that cases that contain Death or Life Threatening seriousness 
criteria for an event are evaluated.

17. Select the Seriousness- Serious (Event) option from the drop-down list. Enable 
this field to check if the event level seriousness assessment is Serious

18. Select the Seriousness- Serious (Case) option from the drop-down list. Enable this 
field to check if the case level seriousness assessment is Serious

19. Select the Seriousness- Serious (Severity) option from the drop-down list.

This enables you to define the Severity as Mild, Moderate, Severe and Unknown.

20. Select the Product Specific - Group Name from the drop-down list. This field 
enables you to configure product specific reporting rules.

21. Select the Product Specific - Family Name from the drop-down list. This field 
enables you to configure product specific reporting rules.

22. Select Causality-Most Conservative. This ensures that the system looks at event 
level reported causality, event level determined causality and case level causality.

23. Select Causality-Include Non-Clinical Trial Cases. This enables you to include the 
Spontaneous Cases (Non Clinical Trial Cases) for causality assessments.

24. Select Causality - Causality as Reported (Event) as required, from the drop-down 
list.

25. Select Causality - Causality as Determined (Event) as required, from the 
drop-down list.

26. Select Causality - Causality as Reported (Case) as required, from the drop-down 
list.

27. Select Causality - Causality as Reported (Case) as required, from the drop-down 
list.

28. Select or create the Advanced Condition to restrict cases to the advanced 
conditions defined here.

If any of these three causalities are confirmed, then the case will be considered as 
reportable.

29. Select the Responsible Group from the drop-down list. This is the group to which 
the reports scheduled by this reporting rule will be assigned.

30. Select the Cover Letter from the drop-down list. Use this field to select cover 
letters that have been configured for reporting template use.

31. Enter any regulatory report comments under the Comments text box.

32. Click Save to save the changes made to this section.

Tip: This field is enabled only for CIOMS-I (Local) form.

Note: Use the Advanced Conditions browser to select or create an 
Advanced Condition by clicking  Select .



About Business Configuration

Business Configuration 3-41

About the Filtering Criterion  The filtering criterion is essential as it helps you to search for 
specific items. The Argus Console provides this option for the Business Configuration 
section.

Using Organized by
The filtering browser is displayed in the top-left corner of the left panel. The Expedited 
Report Rules section can be filtered on the basis of any of the five combinations shown 
in the following illustration.

Consider the following examples:

■ If you enable Organized by Country/License Type/Reporting Rule, then the 
output generated will be visible in a tree-format, in the left panel, based on the 
entire categorization of Country, License Type and Reporting Rule.

■ If you enable the Organized by Responsible Group/Reporting Rule, then only 
the Responsible Group and Reporting Rule views will be available in the tree view 
in the left panel.

The Argus Console helps you to filter information further for the Business 
Configuration section. Once you have selected the Organized by, you can specify 
whether your search should contain or start with specific alphabets or words.

For example, the filtering criterion defined in the following illustration for all 
Country/License Type/Reporting Rule data that contain the term Canada.

Tip: If you have added a new Reporting Rule, click Add Rule to save 
the new Expedited Reporting Rule.

Tip:

■ Enable the Organized By filter for Active Rules, to obtain the list 
of active reporting rules.

■ Enable the Organized By filter for Inactive Rules, to obtain the 
list of inactive reporting rules
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4System Configuration

This chapter provides information about configuring the system. It includes 
information about how to configure the following:

■ Case Priority

■ Field Validations

■ LAM System Numbering

■ Common Profile Switches

■ Argus J

■ Case Form

■ Custom HTTP Header

■ Case Processing

■ Assessments

■ Auto Archiving

■ Case Numbering

■ Lot Number

■ MedDRA Browser

■ WHO Drug

■ Performance

■ Documentum

■ E2B

■ Local Labeling

■ Reports

■ Workflow

■ System Numbering

■ Field Labels

■ User-Defined Fields

System Configuration Overview
The following table describes how the system options are configured:
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Configuring Case Priority
Configure rules to determine the priority of new cases that are entered into the system. 
Based on these rules, the system assigns each case a priority that is displayed in the 
Worklist.

Each row in the Case Priority Configuration screen represents the priority level 
assigned to a case that meets the specific criteria selected for that level. This data is 
reflected in multiple expedited and periodic reports and case form-product 
information section.

■ The user can select the priority level for which the criterion is to be configured.

■ Select System Configuration --> Case Priority to view the Case Priority page.

Field Descriptions
The following table lists and describes the fields in this section.

Section Description

Case Priority This screen enables the administrator to configure rules to 
determine the priority of new cases that are entered into the 
system.

Field Validation This screen enables the administrator to configure field level 
validations for the Case Form fields.

Field Labels This screen enables the administrator to configure field labels.

LAM System Numbering This section enables the administrator to specify the case 
numbering preferences for LAM cases.

System Management 
(Common Profile Switches)

This screen enables the administrator to configure common 
profile switches.

Workflow This screen enables the administrator to configure Workflow 
states and rules.

System Numbering This screen enables the administrator to specify the case 
numbering preferences.

SMTP This screen enables the administrator to configure SMTP for 
e-mails
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Field/Control Name Description

Priority Enables the user to select the priority level whose criterion is to be 
configured.

The user can disable only the last enabled priority. Example: If a 
user has priority 1-4 checked, the priority can be disabled only in 
the order of 4-1.

Case Assessment - Serious Enables the user to configure the seriousness for case assessment.

■ Select Yes from the drop-down list to give priority to cases 
that are serious.

■ Select No for non-serious cases to be considered for this 
priority level. Seriousness is considered at the case level.

■ Select Ignore from the drop-down list to ignore this condition 
when assessing the priority of this case.

Case Assessment - 
Unlisted

Enables the user to configure the priority level for unlisted case 
assessment.

■ Select Yes from the drop-down list for unlisted cases to be 
considered for this priority level.

■ Select No for listed cases to be considered for this priority 
level. Listedness criteria is considered at the case level.

■ Select Ignore from the drop-down list to ignore this condition 
when assessing the priority of this case.

Case Assessment - Causal Enables the user to configure the priority level for causal case 
assessment.

■ Select Yes from the drop-down list for causal cases to be 
considered for this priority level.

■ Select No for non-causal cases to be considered for this 
priority level. Causality criteria is considered at the case level.

■ Select Ignore from the drop-down list to ignore this condition 
when assessing the priority of this case.

Report Due Date-Due Soon Enables the user to configure the report date due soon.

If this option is selected, the case is given the specified priority if 
at least one expedited report is due after the number of warning 
days specified from the current system date.

First Report Due Date - 
Ignore

Enables the user to configure the first report due date to ignore 
status.

This option is used to ignore this parameter when assessing the 
priority.

No. of Warning Days 
Before Due

Enables the user to enter the number of days before a case's report 
due date when the priority is raised to Due Soon.

Advance Condition Drop 
Down List Box

Enables the user to select an existing advance condition from the 
drop-down list.

Select Button Enables the user to create a new advanced condition set or modify 
an existing one.

Run All Case Priority 
Determination on Middle 
Tier

Enables the user to run all case priority determination on Middle 
Tier.

■ If unchecked, the application assesses priority during every 
case save operation in Web .

■ If checked, the application does NOT assess priority during 
every case save operation in Web and Client/Server.
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Use the following procedure to configure Case Priority

1. Select the priority level whose criterion is to be configured.

2. Select the Case Assessment - Serious. The options in the drop-down list are Yes, 
No, Ignore.

3. Select the Case Assessment - Listed. The options in the drop-down list are Yes, No, 
Ignore.

4. Select the Case Assessment - Casual. The options in the drop-down list are Yes, 
No, Ignore.

5. Select First Report Due Date as Due Soon or Ignore. Enter the #Warning days for 
Due Soon.

6. Select the Advanced Conditions from the drop-down list.

7. Use Select icon to create a new Advanced Condition.

8. Select Run All Case Priority Determination on Middle Tier to ensure that the 
application does not assess priority when a case is saved in Web and Client/Server.

9. Click Save to save the changes made.

Configuring Field Validations
This screen enables you to configure field level validations for the Case Form fields. Be 
aware of the following:

■ These validation rules are expressed as an advanced condition, with their criteria 
marked as required or warning.

■ The field level validations feature helps in automatic checking of data as it is 
entered on the Case Form, to ensure consistency of data as per company 
requirements. Consider the following example:

Suppose that the year in the patient's date of birth is entered as 1860. The patient's 
date of birth probably could not have been prior to 1880; hence, a warning is 
issued to ensure the accuracy of the entered data.

■ A field level validation message such as this one is a "warning violation" and the 
user can therefore enter a justification and continue working on the case.

■ An example of a mandatory violation would be a dosage regimen stop date that 
occurs before the dosage regimen start date. Cases cannot be saved without 
correcting mandatory violations.

■ For dependent fields, Argus Safety is pre-loaded with several field level 
validations. Some of these validations are protected and cannot be disabled. 
Others can be disabled, if required by company policy.

■ The system displays the Advance Condition Description for field validations on 
the case form after the Advanced Condition name in the following format: Field: 
XXXX:YYYYReason: ZZZZ

where:

XXXX Is the Field Label Tree view followed by the field label as configured in 
the field label configuration.

YYYY Is the Advance Condition name configured for the field validation.
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***********************************************************************************************

Select System Configuration->Field Validation to view the Case Form Field Level 
Validation screen. The following is an illustration of the screen.

Consider the following example:

The General Tab in the Case Form contains sections such as Study, Follow-up, Case 
Literature, etc. To view the list of field names associated with the Study section, click 
Study in the left panel. The field names associated with Study appear in the right 
panel.

Field Descriptions
The following table lists and describes the fields in this section.

ZZZZ Is the advance conditions descriptions as configured for the Advance 
conditions.

This text prints only if there is a description available for the Advanced 
Condition. Otherwise, the system disables the field label.

Tip: The Case Form tabs appear on the left panel and are categorized 
as folders. Each folder contains all the field labels associated with that 
section.
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Modifying Field Validations
This section enables the user to edit the information already entered in fields.

Use the following procedure to modify a field validation.

1. Select the Case Form folder and field for which, the validation rule is to be 
modified.

2. Click Select icon to create/select advanced conditions for Condition forWarning 
and Condition forMandatory Exception.

3. Click Save to save the changes made.

Configuring LAM System Numbering
This section enables you to specify the case numbering preferences for LAM cases. The 
system provides the ability to use multiple case numbering schemes for global use. For 
example, if site is used in the numbering, the system provides the option to keep 
separate sequences for each site.

Field/Control Name Description

Field Displays the name of the field.

Condition for Warning Displays the advanced condition for warning.

Table Displays the name of the selected sub-folder as displayed in the 
browser tree view. This field cannot be edited.

Field Displays the name of the selected field label in the browser 
tree-view. This field cannot be edited.

Condition for Warning Displays the advanced condition for warning.

Condition for Mandatory 
Exception

Displays the advanced condition for mandatory exception.

Print All Displays a list of validations on all tables, fields and advanced 
conditions of each Group in the Case Form as a PDF.

Tip: The information of the selected field is displayed in the Modify 
section.

Tip: Click here for details on Advanced Conditions.

Note:

■ If all validation rules are met, a green icon is displayed.

■ If a condition for warning is met during field validation, an 
orange icon is displayed.

■ If a condition for mandatory exception is met during field 
validation, a red icon is displayed.

Note: Label Changes will not be reflected in Argus Case Form unless 
IIS is reset.
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Select System Configuration->LAM System Numbering to view the LAM System 
Numbering screen shown in the following illustration.

Field Descriptions
The following table lists and describes the fields in this section.

Field/Control Name Description

Manually Number Cases The option is used to enable the user to manually number the 
cases on booking or while copying the case, using the save as' 
option on the case form.

Automatically Number 
Cases

On selection, the system automatically numbers the cases as 
defined by the user in the numbering format.

Start at Enables the user to initialize the counter of the sequence number.

Separate sequence for each 
site

Enables the user to separate the sequence numbering for cases 
on site by site basis. If there are cases being entered from two 
different sites then each site will have different sequencing of 
case numbers.

Separate sequence for each 
report type

Enables the user to separate the sequence numbering for cases by 
the report type of the case.

Separate sequence for each 
year

Enables the user to reset the sequence numbering for cases after 
each year, based on the initial receipt date of the case.

Separate sequence for each 
month

Enables the user to reset the sequence numbering for cases after 
each month, based on the initial receipt date of the case.

Separate sequence for each 
product abbreviation

Enables the user to reset the sequence numbering for cases for 
each different product abbreviation.

Numbering Format Enables the user to select the numbering format by selecting the 
different placeholders.

■ Define the numbering format by typing in custom keywords 
to print on every case number and selecting different 
placeholders.

■ [YY][MM]-[###] is the default format.
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Use the following procedure to configure LAM Numbering.

1. Select the Numbering feature as required. This can be manual numbering or 
automatic numbering of cases.

2. Select the Sequencing Options as required.

Placeholder Enables the user to enter a placeholder.

■ Placeholders are used to pickup values from the database to 
be used in the Case numbering format.

■ The possible values populated in this list are:

■ # - Number: defines the digits to 
be used as the sequence number 
in the format. The field is used 
to display the sequence number 
on the case numbers.

■ CC- Country code: When 
selected, this uses the A2 code 
for the country of incidence for 
the case number.

■ DD - Day: When selected, this 
uses the date of the Initial 
receipt date' field of the case.

■ MM - month: When selected, 
this uses the month of the Initial 
receipt date' field of the case.

■ P -When selected , this uses 
either of the two values:

If report type is Spontaneous or 
other during booking: the 
system uses the value of the 
Product Abbreviation' field 
specified in the Product 
configuration for the selected 
Primary suspect product.

■ SSS – User Site: When selected 
this uses the Site abbreviation of 
the site belonging to the user 
who booked in the case. 

■ TTT – Report Type: When 
selected this uses the report type 
abbreviation of the report type 
selected during bookin of the 
case.·

■ YY- Year: When selected, this 
uses the year of the Initial 
receipt date’ field of the case.

Field/Control Name Description
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3. Select the Numbering Format. Use Placeholders to enter the required format.

4. Click Save to save the changes made.

Configuring System Management - Common Profile Switches
This section lists the configurable sections for Common Profile Switches.

Select System Configurationand thenSystem Management to view the Common 
Profile Configuration screen.

The following table provides the list of configurable sections associated with Common 
Profile Switches.

Tip: For the complete explanation of the sequencing option refer to 
the Field Descriptions.

Tip: To customize the Numbering Format, use the placeholder 
values. Consider the following example:

To select Country Code, Month and Year (as values to be incorporated 
from the database ) as the Case numbering format, execute the 
following steps.

1. Click on Country Code. This appears in the Numbering Format field.

2. Click on Month. This appears in the Numbering Format field next to the 
Country Code.

3. Click on Year. This appears in the Numbering Format field next to the 
Country Code and Month.

4. The final data listed in the Numbering Format field is the Case 
Numbering Format.

Tip: The Common Profile folder appears in a tree-view on the left 
panel. The components are categorized as folders. Each folder 
contains all the field labels associated with that section.

Note: If any change is made in the System Management (Common 
Profile Switches) screen, the Argusvr2.exe and Argusvr2a.exe should 
be killed from each Web Server and the IIS on Argus Web / Report 
Servers must be reset, in order to reflect the changes made in the 
Argus application..

Section Sub Section Description

Advanced Conditions ~ The Advanced Conditions 
configuration screen enables you to 
specify the number of rows to be 
displayed on the Advanced 
Condition search screen.

Argus J ~ The Argus J Configuration screen 
enables you to modify the 
customizable fields on the Argus J 
form.
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Case Form Configuration ~ This screen enables you to configure 
Common Profile Switches that affect 
the behavior of the Argus application

Case Processing Assessments

Auto Archiving

Case Numbering

MedDRA Browser

Performance

This section enables you to configure 
the case processing fields and items.

Documentum ~ This screen enables you to configure 
the Documentum fields and items for 
Documentum.

Documentum Login ~ Enables the user to configure the 
Documentum login.

Enable Storage of E2B Reports 
in Documentum

~ Enables the user to indicate whether 
E2B reports should be stored in 
Documentum. The user selects Yes or 
No.

Enable Storage of Submitted 
Expedited Reports in 
Documentum

~ Enables the user to indicate whether 
submitted expedited reports should 
be stored in Documentum. The user 
selects Yes or No.

Enable Storage of Case 
Attachment Files in 
Documentum

~ Enables the user to indicate whether 
case attachment files should be stored 
in Documentum. The user selects Yes 
or No.

Enable Storage of Submitted 
Periodic Reports in 
Documentum

~ Enables the user to indicate whether 
submitted periodic reports should be 
stored in Documentum. The user 
selects Yes or No.

E2B ~ This screen enables you to configure 
the E2B fields and items for E2B.

Local Labeling LAM The Local Labeling Configuration 
screen enables you to modify the 
options available through local 
labeling.

MedWatch Configuration ~ The MedWatch Configuration screen 
enables you to modify the 
customizable fields on the MedWatch 
form.

Reporting Expedited

Expedited BfArM

Expedited Canada

Expedited CIOMS

Expedited MedWatch

Periodic

Scheduling

The Reporting Configuration screen 
enables you to modify the options 
available for reporting.

Security ~ The Security Configuration screen 
enables you to modify the options 
available for security.

Section Sub Section Description
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Configuring Advanced Conditions
The Argus J Configuration screen enables you to modify the customizable fields on the 
Argus J form.

Select System Configuration --> System Management to view the Common Profile 
Configuration screen.

To configure the rows to display on each page of an advanced condition screen, click 
the Advanced Conditions folder in the left panel.

Field Descriptions
The following table lists and describes the fields in Advanced Conditions 
Configuration.

Use the following procedure to configure Advanced Conditions.

1. Enter the Number of rows to display per page on the Advanced Conditions Search 
screen.

User Interface ~ The User Interface screen enables you 
to modify the options available for 
User Interface.

Workflow ~ The Workflow Items screen enables 
you to modify the options available 
for Workflow Items.

Tip: The Common Profile folder appears in a tree-view on the left 
panel. The components are categorized as folders. Each folder 
contains all the field labels associated with that section.

Field/Control Name Description

Number of rows to display per page on the 
Advanced Condition Search screen

Enables the user to specify the number of rows to 
be displayed on the Advanced Condition search 
screen.

Section Sub Section Description
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2. Click Save to save the changes made.

Configuring Argus J
The Argus J Configuration screen enables you to modify the customizable fields on the 
Argus J form.

Select System Configuration->System Management to view the Common Profile 
Configuration screen.

To view the list of field names associated with the Argus J section, click the Argus J 
folder in the left panel. The field names associated with Argus J Configuration 
appears in the right panel.

Configuring Incompletion Report Submission Profile Switch  The Follow-up Action Item for 
INcompletion Report Submission is available in as part of the Reporting profile switch. 
The following table lists and describes the fields on the screen.

Enabling Modules  The Enabled Modules dialog box enables you to click a check box to 
enable the Argus Safety Japanese module. as shown in the following illustration.

Updating Code Lists  You can update the Code List LIcense Category to support PMDA 
reportss. Supported categories include the following:

■ Under surveillance immediately after put on market

■ Within 2 years of approval

■ Not approved

■ Under clinical trial for partial change (clinical study for change on 
indication/listedness)

■ Does not apply

Code List -- Emperor  This code list enables you to maintain the Emperor code list (i.e., 
the data required to support the Emperor Date format. The following is an illustration 
of the Emperor Filter screen.

When using this screen, be aware of the following:

■ The input language type is alphebetic.

■ Entry abbreviations are as follows:

Tip: The Common Profile folder appears in a tree-view on the left 
panel. The components are categorized as folders. Each folder 
contains all the field labels associated with that section.

Follow-Up Action 
Item for INcomplete 
Report Submission.

Enables you to select the follow-up  action item.

Due In Enables you to select the number of days before the repor is due.

Follow-up Action 
Item for 
Incompletion Report 
Submission Group 
Assignment

Enables you to assign the Incompletion report submision to a specific 
user group
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– T = Taisho

– H - Heisei

– M = Meiji

– S = Syowa 

Age Units Code List  The Age Units code list accepts decimal number and integers. 
However it only accepts a single digit after the decimal point.

J Reportable Product Keyword  This code list item enables you to specify specific 
keywords to use when searching. The following is an illustration of the J Reportable 
Product Keyword filter.

The following table lists and describes the fields on the screen.

Lab Test Group Code List  The system enables you to create and stor a lab test group in 
the code list.  as shown in the following illustration.

The following table lists and describes the fields  on the Lab Test Group Filter screen.

Lab Test Type Code List  This code list item enables you to add a lab test type to a Lab 
Test Group. The following is an illustration of the Lab Test Type Filter screen.

The following table lists and describles the fields on the screen.

Field/Control Name Description

Keyword Enables you to enter keywords to facilitate searching for related 
company product family drugs and filtering them from foreign 
non-company suspected drugs. 

Activate When clicked, includes the keyword in the search.

Product Family If the selected key word matches the the trade name or generic name of 
the non-company suspected drug, the product family is targeted for 
assessment in Japan.

If you type text in the text box and click select, the system transfers the 
text ou entered to the product browser when you leave the Product 
Family textbox.

Field/Control Name Description

Lab Test Group Enables you to enter the name of the Lab Test Group.

Display When clicked, the system displays the Lab test group.

Field/Control Name Description

Test Enables you to select the test to associate with a selected Lab Test 
Group.

Normal Low Enables you to enter the expected normal low for the lab test.

Normal High Enables you to enter the expected normal high value for the lab test.

Lab Test Group Enables you to select one or more Lab Test Groups to associate with the 
lab test.
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Holiday Calendar Code List  The system enables you to create and store holidays in the 
code list. The following is an illustration of the Holday Calendar filter screen.

The following table lists and describes the data input fields on the Holiday Calendar 
screen

Reporting Destination Code List  Enables you to select the agency reports should be routed 
to. The Agency Information tab is shown in the following illustration.

The following table lists and describes the fields on the Agency Information tab.

Field/Control Name Description

Holiday Name Enables you to enter the name of the holiday to include on the holiday 
calendar.

Date Enables you to enter the date on which the holiday occurs.

Description Enables you to enter a description of the holiday.

Country Enables you to select a one or more countries to  associate with this 
holiday.

Field/Control Name Description

Address The address of the agency receiving the report.

Phone/Ext The telephone and extension numbers.

Country Code The code for the country in which the agency resides.

Fax The telephone number of the agency’s fax machine.

City The name of the city in which the agency resides.

State/Province The name of the state or province in which agency resides.

Country The name of the country in which the agency resides.

Postal Code The unique value associated with the agency address.

Report Transmissions 
Options

Enables you to select whether to tranmit the report by e-mail.

Attachments Enables you to select attachments to include with the report.

Email Text Body When selected, enables you to enter the body text of the e-mail 
message.

Report for Marketed 
License

Enables you to generate a report that includes information about 
marketed licenses

Report for 
Investigational 
Licenses

Enables you to generate a report that includes information about 
investigational licenses.

Suppress Duplicate 
Reports for

When checked, enables you to suppress duplicate reports.

Allow WHO Drug 
Reporting

When checked, enables you to include WHO Drug reporting 
information in the report.

Field/Control Name Description
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Configuring Case Form (System Management)
This screen enables you to configure Common Profile Switches that affect the behavior 
of the Argus application. When configuring Case Form, be aware of the following:

■ The user can use the Console Field Label Configuration to configure additional 
fields.

■ The system tracks any field updates to fields in the audit log, and the system 
prints the additional fields on the print out.

■ The system also enables the user to select the Event Occurred as Consequence of 
field from a code.

■ The Event Occurred as Consequence of field and the Term field are required 
fields and must contain values.

■ The user can perform the following functions for the Event Occurred as 
Consequence of page:

– Ad New

– Copy

– Delete

– Print

– Save

■ The filtering and pagination options are similar to the Code List functions.

■ The system tracks updates to fields on the Event Occurred as Consequence of 
page in the audit log.

■ The Drug Events & Indications are sorted in descending order so the latest 
dictionary displays first.

– This displays in the same order if the MedDRA browser is opened from the 
Utilities | MedDRA browser option.

– This displays in the same order in the Study Configuration for Enable Study 
Specific Encoding.

■ On the Configuration User Interface and the Printout, the Update column 
heading has been changed to Other. This affects the following screen:

– Console --> System Configuration --> Case Priority> Ignore column (middle of 
screen)

– Select System Configuration --> System Management to view the Common 
Profile Configuration screen.

Adjust Expedited 
Report Due Dates for 
Holidays and 
Weekends

When checked, enables the Reporting rule due date adjustment. 

Before When selected, the system  schedules the agency report before a 
Holiday Calendar date or a weekend.

After When selected, the system schedules the agemcu report after a Holiday 
Calendar date or weekend. 

Field/Control Name Description
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To view the list of field names associated with the Case Form Configuration section, 
click the Case Form Configuration folder in the left panel. The field names associated 
with Case Form Configuration appears in the right panel.

The Case Form Configuration dialog helps you customize the case processing 
activities in order to meet the company's requirements. The Administrator can 
configure the following items by using the Case Form Configuration dialog shown in 
the following illustration.

Auto Encoding / Central Encoding  To enable the use of standardized medical terminology 
throughout the adverse event reporting process, dictionaries can be used to encode 
certain terms in the Case Form.

The dictionaries that will be used to encode drugs, Events & Indications, and events 
can be specified in the Autoencoding section of the Case Form Configuration dialog.

Field Descriptions
The following table lists and describes the fields in this section.

Tip: The Common Profile folder appears in a tree-view on the left 
panel. The components are categorized as folders. Each folder 
contains all the field labels associated with that section.
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Automation  The Automation section enables the user to generate an Auto narrative 
based on one of the templates configured by the method described in this topic.

Field Descriptions
The following table lists and describes the fields in the Automation dialog box.

Field/Control Name Description

Drugs The Drugs dictionary list enables the selection of the WHO-DRUG 
dictionary. Select the Drugs check box and tab out of the product name 
field in the Case Form to search the company product followed by the 
license trade names.

■ If no matches are found, the WHO drug dictionary (drug names) is 
searched.

■ Tab out of the generic name field in the Case Form to search the 
product /product family ingredients (it displays the select dialog if 
more than one product is found with the ingredient).

■ If no match is found, the WHO drug dictionary (ingredients) is 
searched.

Events & Indications Select  Events & Indications to be prompted for the term as you enter it 
to be encoded on the Events & Indications tab. If an exact match is 
found in the dictionary, the term  populates automatically. If an exact 
match is not found, the Event Coding dialog is displayed to select the 
desired event.

Auto encodes  primary indication for the drug encoding, Patient 
Condition description in Other Relevant History section and Death 
Details dialog.

Prevent manual 
encoding for Events 
& Indications

Prevents users from encoding the Events & Indications manually.

Require event term 
encoding before case 
closure

Ensures that users encode the events prior to formally closing a case.

Field/Control Name Description

Auto Regulatory 
Scheduling

This enables the user to configure the manner in which Argus Safety 
handles the Auto-scheduling of Regulatory Reports.

The available options are:

■ None

■ Always

■ Significant

■ Manual

Selecting Always will run the auto-scheduling algorithm when any 
field from a specific list of fields is modified on the Case Form and the 
case is saved.
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Report Generation The Report Generation option helps you to configure how the system 
responds to new data when generating auto-scheduled regulatory 
reports.

■ When new data is entered, the system re-runs the regulatory 
report-scheduling algorithm to determine which reporting rules 
apply to the case.

■ If Overwrite Existing Reports is selected, the system updates the 
existing scheduled reports with the new data entered. This setting 
ensures that follow-up numbering is specific to each health 
authority.

■ If a MedWatch report for the FDA has already been scheduled for 
this case, that report would then be updated with the new 
information entered.

■ If Create as Follow-up is selected, the system uses the new data to 
create new reports marked as follow-up reports. This setting 
ensures that the same number would identify a follow-up report 
worldwide. Users will be unable to submit follow-up reports 
before one of the following events occur on the initial or previous 
follow-up report.

Case Locking for 
People

The Administrator has the option of indicating whether cases that are 
not locked can appear in periodic reports.

■ If Allow Unlocked cases to be included is selected, then a check 
box on the periodic report configuration dialogs will allow 
unlocked cases to appear in periodic reports.

■ To prevent unlocked cases from appearing in periodic reports, 
select Prevent unlocked cases from appearing.

Report On Selecting Diagnoses will only list the events marked as diagnoses plus 
events unassociated with a diagnosis in Regulatory Reports.

■ The Event Assessment section of the case form will only list 
diagnosis and unrelated events. If there are no diagnoses, all events 
are listed. You can configure a default setting for selecting the 
Diagnoses state at a system level.

■ Selecting All Events will always list all events, regardless of their 
relationship in the Event Assessment section of the case form. The 
system will take into consideration both events marked as 
diagnoses and events marked as symptoms when running the 
regulatory report algorithm.

Diagnosis Default on 
Event

The options are Yes or No

■ Selecting Yes will set the default Events Diagnosis to Yes whenever 
a new event is entered.

■ Selecting No will set the default Events Diagnosis to No whenever 
a new event is entered.

Event Assessment On The Event Assessment section of the case form will only list diagnosis 
and unrelated events. If there are no diagnoses, all events are listed. You 
can configure a default setting for selecting the Diagnoses state at a 
system level.

■ Selecting Diagnoses will include in Event Assessment only those 
events that are associated with a diagnosis or symptoms that are 
not associated with any of the diagnoses.

■ Selecting All Events will include all events when the Event 
Assessment is performed.

Prevent Modification 
to Autonarrative

Selecting the Preventing Modification of Autonarrative check box will 
prevent users from modifying autonarratives.

Field/Control Name Description
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Templates  Clicking the Templates button enables the Administrator to create a new 
Autonarrative template, modify/copy an existing template, or delete an existing 
template.

Use the following procedure to create a new Autonarrative template.

1. Click the Templates button in the Case Form Configuration dialog to open the 
Autonarrative Configuration dialog.

2. Click New to open the Narrative Configuration dialog.

***********************************************************************************************

3. Under Template Name, enter a name for this new template.

4. Click the Add button at the bottom of the dialog. A new row for entering a phrase 
and its associated logic will appear.

5. Enter a text phrase in the Phrase field. The text can include placeholders that will 
be substituted by the appropriate case data when the Autonarrative is generated.

For example:A phrase might be entered as: "The patient was [age] at the onset of this 
event". When the Autonarrative is being generated, the "[age]" placeholder will be 
substituted for the actual age of the particular patient in the case.

6. Click the ellipsis button to the right of the Logic column. Select or enter an 
Advanced Condition for the logic section.

This search will be used to determine whether or not the corresponding phrase will appear 
in a narrative for a particular case.For example:An advanced condition can be specified 
such that only cases involving children younger than five years old will have the phrase "

The patient was [age] at the onset of this event" in the Autonarrative.

7. Repeat steps 4 through 6 to add other text phrases to the template. Click OK to 
save the template or Cancel to exit the dialog without saving the changes.

Case Autonarrative Selecting the Case Autonarrative check box enables the user to generate 
an Autonarrative based on one of the templates configured by the 
method described in this topic.

Field/Control Name Description
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Creating a Template in Another Language  Use the following procedure to create a template 
in another language.

1. Once a template is created, double-click the "Narrative Templates" folder to 
expand the template tree in the Autonarrative Configuration dialog.

2. Expand the selected template folder to display the languages for this template. To 
configure this template in a language other than English, double-click the 
appropriate language icon.

3. Configure the foreign language template as described in steps 4 through 7 of the 
procedure for creating the Autonarrative template above.

4. Click Close to exit the Autonarrative Configuration dialog.

Copying a Template to Another Language  Use the following procedure to copy a template 
to another language.

1. Select the original language from which the target language copy is to be created. 
The original language can be selected in the tree-view of the Autonarrative 
Configuration dialog.

2. Click Copy. The Autonarrative Copy dialog will appear.

3. Select the language to which the narrative template is to be copied and click Copy.

4. The contents of the original language template will now be copied into the 
selected language template.

Deleting Templates  Use the following procedure to delete templates.

1. To delete a language template, select the appropriate language icon for the 
template in the Autonarrative Configuration dialog and click Delete.

2. To delete the entire Autonarrative template, select the template folder icon in the 
Autonarrative Configuration dialog and click Delete.

Note: Selecting the Preventing Modification of Autonarrative 
checkbox in the Case Form Configuration dialog will prevent users 
from modifying autonarratives..

Tip: To open the Autonarrrative Configuration dialog, click the 
Autonarrative button in the Case Form Configuration dialog.

Note: Autonarrative placeholders in a language other than English 
will get substituted by text from that particular language. If no text is 
available in that language, English language text will be used to 
substitute the placeholders.

Tip: To open the Autonarrrative Configuration dialog, click the 
Autonarrative button in the Case Form Configuration dialog.

Note: In the Autonarrative Configuration dialog, the Copy button 
for a selected language template will only be available if a template 
has already been created in that language.
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Duration Calculations  The following table lists and describes the fields associated with 
this section.

Documentum Common Login  The Documentum Common Login information is used to 
connect to the Documentum server to perform Documentum related activities to the 
case form. The system uses this information only if the common profile switch to use 
the common login is set. This option is only available if the system is configured to use 
Documentum.

The following table lists and describes the fields associated with this section.

Custom Routines  The following table lists the Field Descriptions associated with this 
section.

Field/Control Name Description

Event The Duration Calculations section is used to indicate whether the 
system should calculate event duration (the time from Event Onset 
Date to Event Stop Date) in an inclusive or an exclusive manner.

For instance, select Inclusive to calculate a range from 01 January to 10 
January as ten days. Select Exclusive to calculate a range from 01 
January to 10 January as nine days.

If the user has entered both the date and time, the exclusive/inclusive 
designation is ignored.

Drug The Drug Duration Calculations section is used to indicate whether the 
system should calculate drug duration in an inclusive manner or an 
exclusive manner, as described under Event Duration Calculations.

Field/Control Name Description

Username This is the username associated with the Documentum Common Login.

Password This is the password associated with the Documentum Common Login 
username.

Field/Control Name Description

Custom Routine 
Before Save

The function behaves the same way as the Custom Routine Before 
Commit. The case ID is passed as a parameter to the function. The 
return value is a string format. If a null string is returned, the system 
assumes the procedure executed without any error, and continues with 
the case save operation. If any numeric/string value is returned, the 
case save routine is aborted and the system displays the returned string 
as an error message to the user.

Custom Routine 
Before Commit

This is the Custom routine to be called before case save. Ensure that the 
custom routine is present in the database, and the application has access 
to it.

Custom Routine 
After Commit

This is the after-save Custom routine to be called after case save. Ensure 
that the custom routine is present in the database, and the application 
has access to it.

Select the Table Config button to select the tables that are being 
modified in the post-save script.

Custom Routine 
Before Lock

This is the Custom routine to be called before case lock Ensure that the 
custom routine is present in the database, and the application has access 
to it.
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Table Config Button  The Table Config button enables you to fetch only the delta table 
data after post-save, so that the entire case is not reloaded. This button is enabled only 
when the Custom Routine After Commit checkbox is selected.

Use the following procedure to remove case tables.

1. Select the Custom Routine After Commit checkbox and click the TableConfig 
button. The following screen appears.

***********************************************************************************************

Initially, all case tables open under the Available Tables list box.

2. Select the required table(s) and click Add>> to include them to the Selected Tables 
list.

Alternatively, you can select the required table(s) and click <<Remove to exclude 
them from the Selected Tables list.

3. Click Cancel to close the screen without making any changes or click Save to save 
this configuration.

■ The Case Save routine gets modified to retrieve only the table data from the 
Selected Tables in the configuration.

■ If no Post Save is configured, the Case Save does not execute the Case Load 
routine.

Modify Data Lock Point  This section displays only if the DLP_USE_LAST_COMPLETED_
VERSION switch is in the database schema in the CMN_Profile table.

Attachment File Size 
Limit (in Megabytes)

The file size entered in this field enables you to specify the maximum 
size limit for attaching a file. The upload limit defined here can be seen 
in the Attachments and References section of the Bookin screen. The 
maximum limit for uploading an attachment is 4 GB.

Field/Control Name Description
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The following table lists and describes the fields in this section.

Configuring Custom HTTP Header
The system enables you to attach a Custom SMTP Header along with the 
preconfigured text as the Header for every e-mail it sends.

■ The Custom SMTP Header text is enabled only when the Custom SMTP Header 
check box is checked.

– The user can define the Header and the Header text in the Custom SMTP 
Header configuration by separating them with a colon ( : ).

– The system does not validate the value for the Custom SMTP Header text.

■ You can enter a maximum of 255 characters.

■ All e-mail messages sent using the following processes are sent as Confidential:

– AG Service : Bulk Transmit Email

– AG Service : General Email

– ESM Service : Business / User / IT Email

■ The Audit Log tracks updates to this field.

Field/Control Name Description

Enable Data Lock Point Enables you to activate a data lock point by selecting this 
checkbox. If this checkbox is not selected, the Modify Data 
Lock Point section displays only this field as editable.

Use Last Completed Version Enables you to use the last completed version.

Use Next Completed Version 
(Includes Data Cleaning)

Enables you to use the next completed version that 
includes data cleaning.
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Configuring Case Processing
This section enables you to configure the case processing fields and items. Select 
System Configuration --> System Management to view the Common Profile 
Configuration screen

To view the list of field names associated with the Case Processing section, click the 
Case Processing folder in the left panel.

The field names associated with Case Processing Configuration appear in the right 
panel.

The Case Processing folder has been further categorized into the following sub-folders:

■ Configuring Assessments

■ Configuring Auto Archiving

■ Configuring Case Numbering

■ Configuring MedDRA Browser

■ Configuring Performance

Field Descriptions  The following table lists the fields available under Case Processing 
Configuration:

Tip: The Common Profile folder appears in a tree-view on the left panel. The 
components are categorized as folders.

Each folder contains all the field labels associated with that section.

Field/Control Name Description

Create follow-up on 
unblinding

The available options are Yes and No.

Allow User to 
regenerate reports

The available options are Yes and No.
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Use the following procedure to configure the case processing options.

1. Select the required option in Create follow-up on unblinding.

2. Select the required option in Allow User to regenerate reports.

3. Select the required option in Manually Schedule reports.

4. Select the required option in Events to Display on Assessment Tab.

5. Select the required option in Access on Patient Information.

6. Select the required option in Search product on Case Form.

7. Select the required option in Select Type of WHO drug search for auto drug 
encoding.

8. Select the required action item code from the drop-down list box in Action Item 
Code when QC info is entered.

Manually Schedule 
reports

The available options are:

■ Report scheduling will schedule follow up reports

■ Report scheduling will not schedule follow up reports

Events to Display on 
Assessment Tab

The available options are:

■ Event Assessment will display all Events

■ Event Assessment will display Diagnosis Events only

Access on Patient 
Information

The available options are:

■ Initials part of Patient information access group

■ Initials part of Personal Patient Information access group

Search product on 
Case Form

The available options are:

■ Product Name product lookup. Based on products configured in 
the system.

■ Trade Name product lookup. Based on the licenses configured in 
the system.

Select Type of WHO 
drug search for auto 
drug encoding

The available options are:

■ Default WHO schema

■ Use alternate who tables

Action Item Code 
when QC info is 
entered

The available action item codes are listed in the drop-down list box.

Default Network 
directory for scanned 
images

Enter the path of the default network directory of scanned images in 
this text box.

When the user selects New Case from Image from the Quick Launch 
toolbar, the Windows Open dialog opens, and displays the path 
specified in this textbox, by default.

Uploading Letter 
after generation

Select Auto Upload Letter (enabling Active X) to upload letters 
automatically through the Active X control. The Active X control 
supports the following versions of MS Office - Office XP, Office 2003 
and Office 2007.

Select Manually upload letter to manually upload a letter saved on the 
local machine.

Field/Control Name Description
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9. Enter the path of the default network directory of scanned images in the Default 
Network directory for scanned images text box.

10. Select whether to upload letters automatically or manually by making the required 
selection under Uploading Letter after generation.

11. Click Save to save the changes made to this section.

Configuring Assessments
This screen enables you to configure the case processing fields and items for 
assessments. Select System Configuration --> System Management to view the 
Common Profile Configuration screen.

To view the list of field names associated with the Case Processing --> Assessments 
section, click the Assessments folder in the left panel.

The field names associated with Assessments Configuration appear in the right panel.

Field Descriptions  The following table lists the fields available under Assessments 
Configuration:

Tip:  The Common Profile folder appears in a tree-view on the left 
panel. The components are categorized as folders. Each folder 
contains all the field labels associated with that section.

Field/Control Name Description

Display warning 
when Case Level 
Assessment does not 
match with Event 
Level Assessment

The available options are Yes and No.

Criteria for case level 
causality assessment

The available options are:

■ Derive the case level causality based on the As Determined event 
level causality.

■ Manually select case level causality.

Criteria for case level 
Seriousness 
determination

The available options are:

■ Derive the case level seriousness based on the events. If any event 
is serious, case level will be serious.

■ Manually select case level seriousness.
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Use the following procedure to Configure the Case Processing Options

1. Select the required option for Display warning when Case Level Assessment does 
not match with Event Level Assessment.

2. Select the required option for Criteria for case level causality assessment.

3. Select the required option for Criteria for case level Seriousness determination.

4. Enter the SUSAR Criteria.

5. Click Save to save the changes made.

Configuring Auto Archiving
This screen enables you to configure the auto-archiving. Select System Configuration 
--> System Management to view the Common Profile Configuration screen.

The default rule requires that the following options must be completed before a case is 
auto-archived:

■ All Action Items Closed

■ All Reports Submitted or Marked required for Non-Submission

■ All Events are encoded

■ All Letters are sent

■ All Cases are locked

Apart from this default rule, you can also configure additional rules/criteria for 
auto-archiving cases from this screen.

■ Workflow State (Configurable by the user) - This option enables you to select 
Workflow States. Cases that fall in the specified workflow states can be 
auto-archived.

■ Advanced Conditions selection (Configurable by the user) - This option enables 
you to specify advanced conditions. Cases that meet the specified advanced 
conditions, can be auto-archived.

This feature enables you to define rules for automatically archiving those cases that 
meet the defined rules.

To view the list of field names associated with the Case Processing --> Auto Archiving 
section, click the Auto Archiving folder in the left panel.

The field names associated with Auto Archiving Configuration appear in the right 
panel.

SUSAR Criteria Enables you to enter an SUSAR criteria as an SQL query.

An SUSAR is identified as a Serious, Unexpected, Related Case.

Note: The SQL should not exceed 2000 characters.

Tip:  The Common Profile folder appears in a tree-view on the left 
panel. The components are categorized as folders. Each folder 
contains all the field labels associated with that section.

Field/Control Name Description
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Field Descriptions  The following table lists the fields available under Auto Archiving 
Configuration:

Use the following procedure to configure the auto archiving options

1. Select the workflow states for auto-archiving cases from Workflow States.

2. Create the advanced conditions for archiving cases in Advanced Condition.

3. Enter the Case Archiving Comment as a pre-defined case close comment.

4. Enter how often the cases will be archived, as per number of days, under 
Execution Period.

5. Click Save to save the changes made.

Field/Control Name Description

Workflow States The Select button enables you to select workflow states from a list of 
workflow states. The selected workflow states are displayed in the text 
box.

Cases that belong to these workflow states are marked to be 
auto-archived.

Advanced Condition Enables you to specify advanced conditions for auto-archiving cases. 
Cases that meet the advanced conditions are marked to be auto-archived.

Refer to Advanced Conditions for details on creating advanced 
conditions.

Case Archiving 
Comment

Enables you to enter a pre-defined case close comment, of up to 200 
characters. The information entered in this field is displayed in the Case 
Routing and Case Archive notes.

Execution Period (in 
Days)

Enables you to define how often the cases will be archived.

Note: You can enter up to 99 days only.

If no value is entered, the cases will not be auto-archived.
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Configuring Case Numbering
This screen enables you to configure the case processing fields and items for case 
numbering. Select System Configuration --> System Management to view the 
Common Profile Configuration screen

To view the list of field names associated with the Case Processing --> Case 
Numbering section, click the Case Numbering folder in the left panel. The field 
names associated with Case Numbering appear in the right panel.

Field Descriptions  The following table lists the fields available under Case Numbering 
Configuration:

Use the following procedure to configure the case numbering options.

1. Select the required option for Date to use for numbering year placeholder.

2. Click Save to save the changes made.

Configuring Lot Number
A common profile switch determines whether a user can override an un-validated lot 
number and enter them in the case form.

Tip:  The Common Profile folder appears in a tree-view on the left 
panel. The components are categorized as folders. Each folder 
contains all the field labels associated with that section.

Field/Control Name Description

Date to use for 
numbering year 
placeholder

The available options are:

■ Use initial receipt date of the case entered for the automatic system 
numbering.

■ Use date on the local machine for the automatic system numbering.
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The following table lists and describes the fields available under Lot Number 
Processing:

Yes is the default. This enables the user to select the options for the Lot Number 
Validation as current functionality This message box displays the following message:

No matching lot number was found.

If centralized lot search is used, the system hides the Lookup button since a list is 
automatically returned and displayed.

■ No: The system does not permit the user to keep the existing value. The user can 
only obtain it from a Look up dialog that lists the available Lot Numbers.

Field/Control Name Description

Allow Users to enter 
non-configured Lot 
Numbers

Enables you to select whether or not to allow users to enter 
non-configured lot numbers. Select Yes to allow, and No to diallow.

Use Centralized Lot 
Number Validation

Enables you to select whether or not to allow centralized lot 
number validation. Select Yes to use, and No to not use this option.

Lot Number Web 
Service 
Configuration XML 
File

Enables you to select and/or edit (if required) the Lot Number 
Web Service Configuration XML File. The file path textbox is a 
read-only field, which displays the path of the uploaded file. This 
field stores the configuration of the Centralized Lot Number Web 
Service in XML format. The Edit button is enabled only after the 
XML file has been successfully uploaded.

Lot Number Web 
Service XSLT

Enables you to select and/or edit (if required) the Lot Number 
Web Service XSLT File. This field stores the XSLT associated with 
the Centralized Lot Number Web Service. The file path textbox is a 
read-only field, which displays the path of the uploaded file. The 
Edit button is enabled only after the XSLT file has been 
successfully uploaded.
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■ The system hides the Keep button.

A common profile switch determines whether lot validation uses Argus or a 
centralized lot validation.

■ No (default): This enables the user to select the options for the Lot Number 
Validation as current functionality from within the Argus Product Families Lot 
Numbers

■ Yes: This enables the system to query outside the Argus Safety system through 
a web service return the following parameters for Lot Number Validation

– Argus sends the user-entered lot number to central system for 
validation/look-up and retrieves a response to act on.

– The message format for the retrieved lot is as follows:

<Lots>

<Lot>

<Lot Number>: Lot number

<Expiration>: Lot expiration date

<Custom name=name metadata=text>: Custom data to a lot number

■ If more than one lot number is returned, the system displays a lot selection dialog.

The Custom Node  ■The metadata attribute is as labels in the selection dialog that 
displays the data. The name attribute is used to identify the case form field to be 
populated with the data in the node.

■ Clients can use an XSLT document to map the custom data to case fields present 
on the active case form page.

***********************************************************************************************
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If an error occurs during the web service transaction, a message box will appear with 
the proper error message.

Configuring MedDRA Browser
This screen enables you to configure the case processing fields and items for MedDRA 
Browser.

Select System Configuration --> System Management to view the Common Profile 
Configuration screen

■ The existing MedDRA browser category has been renamed Dictionary Browser.

■ A switch in Argus enables you to use either local MedDRA Coding or Central 
System MedDRA Coding (Web Service Method)

– Local (Default): Current functionality of MedDRA browser using Local 
Dictionary within the Database

– Web Services: Returns the MedDRA hierarchy via the configured Web 
Services.

This enables the User Local MedDRA if term is not found by Web Service" function.

To view the list of field names associated with the Case Processing --> MedDRA 
Browser section, click the MedDRA Browser folder in the left panel. The field names 
associated with MedDRA Browser are in the right panel.

Field Descriptions  The following table lists the fields available under MedDRA Browser 
Configuration:

Tip:  The Common Profile folder appears in a tree-view on the left 
panel. The components are categorized as folders. Each folder 
contains all the field labels associated with that section.

Field/Control Name Description



System Configuration Overview

System Configuration 4-33

Use the following procedure to configure the MedDRA Browser.

1. Select the required option for Date to use for numbering year placeholder.

2. Click Save to save the changes made.

Configuring WHO Drug
Argus supports WHO-Drug encoding using a locally installed version of the 
WHO-Drug dictionary through the WHO-Drug browser.

■ A switch in Argus enables you to use either local WHO-Drug Coding or Central 
System WHO-Drug Coding (Web Service Method) under the Dictionary browser 
category

– Local (Default): Uses the current functionality of WHO-Drug browser that 
uses the Local Dictionary in the Database

– Web Service: Returns the WHO-Drug fields via the configured Web Services

– The system enables the User Local MedDRA if term is not found by Web 
Service"

Configuring Performance
This screen enables you to configure the case processing fields and items for 
performance.

Select System Configuration --> System Management to view the Common Profile 
Configuration screen.

To view the list of field names associated with the Case Processing --> Performance 
section, click the Performance folder in the left panel. The field names associated with 
Performance appear in the right panel.

Term Selection in 
MedDRA Browser

The available options are:

■ Select any term to code if multiple are returned for the search

■ Select the Primary SOC term for encoding if multiple terms are 
returned from the search.

Tip:  The Common Profile folder appears in a tree-view on the left 
panel. The components are categorized as folders. Each folder 
contains all the field labels associated with that section.
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Field Descriptions  The following table lists and describes the fields available under 
Performance Configuration:

Use the following procedure to configure performance.

1. Select the required option for When to process field level validation, as 
applicable.

2. Select the required option for Where to store temporary case information during 
data entry, as applicable.

Field/Control Name Description

When to process field 
level validation

Enables you to configure the frequency of field level validation. 
Select Only on case save to validate only when a case is saved.

Alternatively, select Every page update to validate fields whenever 
a page is updated.

Where to store 
temporary case 
information during 
data entry

Enables you to select the location where you can save the 
temporary case information during data entry.

You can select the location to be On the database in web case table 
or On the fileserver cache directory.

Use Oracle Text for 
duplicate search 
querying

Enables you to select Oracle Text for duplicate search querying. 
Click Yes to enable this feature.

Refresh Oracle Text 
Index interval (in 
Minutes)

Enables you to configure the interval (in minutes) between each 
refresh of an Oracle Text Index.

This feature is useful while searching for duplicate cases. It is 
advisable to enter a high interval for low number of cases and vice 
versa.

Start Time for Oracle 
Text Refresh

Enables you to specify the time when the Oracle text will be 
refreshed.
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3. Select the required option for Use Oracle Text for duplicate search querying, as 
applicable.

4. Enter the time difference between each refresh (in minutes), under Refresh Oracle 
Text Index interval (in Minutes).

5. Enter the time (in military format) when the Oracle text refresh will begin, under 
Start Time for Oracle Text Refresh.

6. Click Save to save the changes made.

Configuring Documentum
The system enables you to configure to choose Document Management from the 
Common Profile Switches: Document Management

■ You may select from the following:

– External System: The system populates this dropdown with the supported 
external interfaces. Currently, selecting this radio button enables the 
drop-down. In this release, the drop-down list has only one option, 
Documentum 6.5"

– Argus: Selecting this option creates the documents described below within the 
Argus Safety database. When selected, the dropdown for the External System 
is disabled.

– The Cabinet Name contains length is 255 characters

– The Repository Type length is 255 characters
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■ The Documentum Login has been removed from the Case Form Configuration 
and placed in the Document Management dialog.

– The system enables the user to enter the User name and the Password while 
using a Central user for Document Storage System.

– The system enables the Document Common Login when the user selects User 
Documentum Login/Password".

– The system encrypts the Password in the DB (128 bit) in Audit Log

■ Docbase and Domain are text box field. The field can be a maximum of 255 
characters.

■ Configure the following for Document Management:

– E2B Reports

– Expedited Paper Reports

– Periodic Reports

– Attachments saved within the cases

– E2B Reports:

■ If the E2B switch is enabled and the user transmits an E2B Report (Before 
submission to the Gateway), the system stores the E2B XML Message in 
Documentum.

■ When the Report Submission is successful and the report is marked as submitted 
in Argus, the system updates a flag in the Documentum database to designate the 
same.

■ Expedited Reports

– If the Expedited switch is enabled and the user submits an expedited report, 
the Argus Safety Service inserts the report into Documentum as a PDF file.

– When the Report Submission is successful and the report is marked as 
submitted, the system updates a flag in the Documentum database to signify 
the same.

■ Periodic Reports:

– If the Periodic Switch is enabled and a Periodic Report is approved in Argus, 
an Argus Safety Service exports the report as a PDF file and saves it in the 
Documentum database.

– When the Report Submission is successful and the report is marked submitted, 
the system updates a flag in the Documentum database to indicate the same.

■ Attachments:

– When this switch is enabled, a new button is available on the Argus 
Attachments screen, LAM Attachments Section label Attach Documentum 
Link.

– The Argus Bookin dialog has an additional drop down option for attaching to 
Documentum.

– When the Links Switch is enabled, the system stores all Argus Attachments in 
the Documentum database.

– Clicking the Attach Documentum Link button opens a search dialog to enable 
the user to search the Documentum database for a document. This document 
is then linked as an attachment within Argus.
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***********************************************************************************************

– When the user clicks the Attach Documentum Link button, the following 
occurs:

– The system presents a search dialog to enable the user to search for a 
document in the Documentum database.

– The user must select a Table to Search. This list is a distinct Table List from the 
Documentum_table_info Table.

– After the user selects a Table, the system populates the Column drop down 
with all the columns available for that table based on configuration from the 
same table.

– When the user selects the Full Search option, the system performs a like search 
in Documentum.

■ If LDAP is enabled, the system automatically send the login information from 
Argus to Documentum.

■ After selecting a document from the Search results, the system saves the URL for 
the Argus attachment.

■ If the user clicks the URL, Argus automatically opens the document from 
Documentum.

■ Argus refers to two (2) that enables you to specify which tables/columns can be 
searched in Documentum and which Table Fields to display in the Search Results.

– documentum_table_info - This table holds the table / fields the user will be 
able to search.

Type_Name - Table to Search

Attribute_Name - Field in the Table to Search

Attribute_Type - Type of field being searched.

– Documentum_display_info - This table stores the Return Search Parameters.

Type_Name - Table to Search

Attribute_Name - Field in the Table to Search
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Sort_Id - The order in which the fields will be displayed

– The Document Management (Central or Documentum) database gets a new 
document each time a document attachment is added as a new attachment. 
Existing documents are modified for changes.

– The system does not create a new document in the Document Management 
(Central or Documentum) database each time a case /event is saved in Argus 
or Affiliate

– When cases are copied, the document copy has the same DOC ID (Object ID) 
as the original case. If the Document is modified after the cases are copied, the 
system gets a new DOC ID only for the case attachments that were modified.

– The icon is similar to the Additional Info requirements for attachment types

– When the user clicks the attachment to open it, the system retrieves the 
attachment from Documentum

– When events from the Affiliate are accepted in Argus as Argus cases, the 
system keeps the DOC ID(Object ID) from the Affiliate Event

– Attachments can be entered to the case / affiliate event via

Affiliate Events

Bookin in Argus or Affiliate

Case Form / Affiliate Event Form

Intake WL

■ Error Messages

– If the system cannot connect to the document system, it displays the following 
message:

Argus was unable to connect to the document management system. Please 
contact your Administrator for more details.

– If the document system does not return any rows, the system returns a dialog 
with the following message

No documents returned.

– Select System Configuration --> System Management to view the Common 
Profile Configuration screen

To view the list of field names associated with the Case Processing --> Documentum 
section, click the Documentum folder in the left panel. The field names associated 
with Documentum appear in the right panel.

Field Descriptions  The following table lists the fields available under Documentum 
Management:

Tip:  The Common Profile folder appears in a tree-view on the left 
panel. The components are categorized as folders. Each folder 
contains all the field labels associated with that section.
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Use the following procedure to configure Documentum

1. Select the Documentum Login to configure the login for the user.

2. Select the option for Enable Storage of E2B Reports in Documentum.

3. Select the option for Enable Storage of submitted expedited reports in 
Documentum.

Section Field Description

Common Login Use Common Login 
Password

Users use a common login password to access 
the system

Use Logged in User's 
Username/Password

■ Users login using their system user names 
and password.

■ This is the default.

Docbase The name of the document database.

Domain The name of the domain where the database 
resides.

Enable Storage of 
E2B Reports in 
Documentum 
Repository

Documentum Enables the system to store E2B reports in the 
Documentum document repository.

This is the default.

Argus Enables the system to store E2B reports in the 
Argus document repository.

Cabinet Name The storage location of the E2B reports.

Enable Storage of 
submitted 
expedited 
reports in 
Document 
Repository

Documentum Enables the system to store submitted expedited 
reports in the Documentum document 
repository.

This is the default

Argus Enables the system to store submittedd 
expedited reports in the Argus document 
repository.

Cabinet Name The storage location of the submitted expedited 
reports.

Enable storage of 
case attachment 
files in the 
Document 
Repository

Documentum Enables the system to store case attachment files 
in the Documentum document repository.

This is the default

Argus Enables the system to store case attachment files 
in the Argus document repository.

Cabinet Name The storage location of the case attachment files.

Document Type The type of document that is being stored.

Enable storage of 
submitted 
periodic reports 
in the Document 
Repository

Documentum Enables the system to store submitted periodic 
reports in the Documentum document 
repository

This is the default

Argus Enables the system to store submitted periodic 
reports in the Argus document repository.

Cabinet Name The storage location of the submitted periodic 
reports.
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4. Select the option for Enable storage of case attachment files in Documentum and 
additionally the searching and attaching files already existing in Documentum to a 
case.

5. Select the option for Enable storage of submitted periodic reports in Documentum.

6. Click Save to save the changes made.

Configuring E2B
This screen enables you to configure the E2B fields and items for E2B. Select System 
Configuration --> System Management to view the Common Profile Configuration 
screen

To view the list of field names associated with the Case Processing --> E2B section, 
click the E2B folder in the left panel. The field names associated with E2B appear in 
the right panel.

***********************************************************************************************

Field Descriptions  The following table lists the fields available under E2B:

Tip:  The Common Profile folder appears in a tree-view on the left 
panel. The components are categorized as folders. Each folder 
contains all the field labels associated with that section.

Field/Control Name Description

Onset Date 
Calculation

This field enables the user to configure if the onset date is to be 
calculated based on any suspect drug or on the primary suspect drug 
only.

Drug assessment 
method (used by 
E2B/ESM module)

This field enables the user to incorporate the drug assessment method 
used by E2B/ESM module.
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Use the following procedure to configure E2B

1. Enable the check-box option for Drug assessment method (used by E2B/ESM 
module), if required.

2. Select the option for Blind status during E2B report generation.

3. Select the option for Perform length check of Argus fields against E2B standard.

4. Select the option for Default viewing format of the E2B report (used with 
Electronic Submission Module (ESM)).

5. Select the option for Default DTD.

6. Select the required radio button under Onset Date Calculation, as applicable.

7. Select whether to send the nullification report in Send E2B Nullification Report.

8. Enter the comments for the automatically generated notes, when an E2B is 
accepted, under Auto Accept Notes.

9. Click Save to save the changes made to this screen.

Local Labeling
This section enables you to configure the common profile switches for Local Labeling 
and includes discussions of the following:

■ Configuring Local Labeling

■ Configuring Local Labeling LAM

Configuring Local Labeling  The Local Labeling Configuration screen enables you to 
modify the options available through local labeling. Select System Configuration --> 
System Management to view the Common Profile Configuration screen.

Blind status during 
E2B report 
generation

The available options are:

■ Blinded

■ Unblinded

Perform length check 
of Argus fields 
against E2B standard

The available options are:

■ Yes

■ No

Default viewing 
format of the E2B 
report (used with 
Electronic 
Submission Module 
(ESM))

The available options are:

■ SGML

■ CIOMS

■ MEDWATCH

■ DECODED VIEW

Default DTD This field enables the user to select the Default DTD from the 
drop-down list box.

Send E2B 
Nullification Report

This field enables the user to configure whether to send the E2B 
nullification report or not.

Auto Accept Notes Enables the user to enter notes (up to 190 characters). It is required for 
these notes to be entered for the acceptance of the E2B. The notes 
entered here, are automatically provided during E2B acceptance.

Field/Control Name Description
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To configure the fields associated with the Local Labeling section, click the Local 
Labeling folder in the left panel. The configurable fields associated with Local 
Labeling appear in the right panel.

***********************************************************************************************

Field Descriptions  The following table lists and describes the fields available under 
Local Labeling:

Use the following procedure to configure local labeling

1. Enter the number in Number of Cases returned in local labeling dialog: default.

2. Select the option for Action to be taken after timeout.

Tip:  The Common Profile folder appears in a tree-view on the left 
panel. The components are categorized as folders. Each folder 
contains all the field labels associated with that section.

Field/Control Name Description

Number of Cases 
returned in local 
labeling dialog: 
default X

This field enables the user to configure the number of cases that are 
returned in the local labeling dialog.

Example: If the value is entered as 20 then 20 cases are returned in the local 
labeling dialog.

Action to be taken 
after timeout

The available options are :

■ Discard

■ Submit

Timeout for 
assessment data lock 
(in minutes)

This field enables the user to enter the minutes after which the time-out for 
assessment data lock is applicable.
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3. Enter the value in minutes for Timeout for assessment data lock (in minutes).

4. Click Save to save the changes made.

Configuring LAM  The Local Labeling LAM Configuration screen enables you to modify 
the options available through local labeling for LAM.

Field Label Updates  The Argus Console Field Labels option enables the user to modify 
the field labels for the Argus Affiliate Event Information form.

■ The existing Argus fields are under the Argus Safety folder structure.

■ Please refer to the tables in the LAM Information section for the details about the 
Help Text for the fields.

■ The system enables the user to hide the field on the LAM form.

■ The system prints the Affiliate field labels.

■ The system tracks all field label updates in the audit log.

Field Validation Updates  Argus Affiliate enables the user to configure Field Validations 
for Mandatory and Warning for the LAM Event fields.

■ The existing Argus fields are under the Argus Safety folder structure.

■ Please refer to the table for LAM Event Info for the fields in the Field Validations.

■ The Affiliate fields for advanced conditions are only visible for field validations. 
They are not visible to the rest of the application.

■ The system prints the information for the configured field validations.

■ The system tracks all updates to field validations in the audit log.

■ The system displays the standard Justifications dialog to enable the user to enter 
the justifications for overriding the warnings, but does not permit the user to save 
the case for a mandatory error.

Select System Configuration --> System Management to view the Common Profile 
Configuration screen

To configure the fields associated with the Local Labeling LAM section, click the Local 
Labeling folder in the left panel.

■ The LAM sub-folder is displayed in the left panel.

■ Click on LAM sub-folder to configure the LAM options.

■ The configurable fields associated with Local Labeling Lam appear in the right 
panel.

Tip:  The Common Profile folder appears in a tree-view on the left 
panel. The components are categorized as folders. Each folder 
contains all the field labels associated with that section.
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***********************************************************************************************

Field Descriptions
The following table lists and describes the fields available under Local Labeling LAM:

Use the following procedure to configure local labeling for LAM.

1. Select the option for Allow hiding of the Local Labeling dialog from Users.

2. Select the option for Report Scheduling when Labeling Changes from the Local 
Labeling Screen.

3. Select the option for Re-evaluate all scheduled and generated reports related to a 
case when the labeling is changed from the Local Labeling dialog.

4. Click Save to save the changes made.

Field/Control Name Description

Allow hiding of the Local 
Labeling dialog from Users

The available options are:

■ Local Labeling will be visible to users

■ Local Labeling will be hidden from users

Report Scheduling when 
Labeling Changes from the Local 
Labeling Screen

The available options are:

■ No Report Scheduling will not be executed when the 
Local Labeling is changed

■ Report Scheduling will occur for those Licenses 
where the Labeling has changed

Re-evaluate all scheduled and 
generated reports related to a 
case when the labeling is 
changed from the Local Labeling 
dialog.

The available options are:

■ The system will not re-evaluate generated reports

■ Re-evaluate general reports.
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Configuring MedWatch  The MedWatch Configuration screen enables you to modify the 
customizable fields on the MedWatch form. Select System Configuration --> System 
Management to view the Common Profile Configuration screen.

To view the list of field names associated with the MedWatch Configuration section, 
click the MedWatch Configuration folder in the left panel.

***********************************************************************************************

The field names associated with MedWatch Configuration appear in the right panel.

Field Descriptions
The following table lists and describes the fields available under MedWatch 
Configuration:

Tip:  The Common Profile folder appears in a tree-view on the left 
panel. The components are categorized as folders. Each folder 
contains all the field labels associated with that section.

Field/Control Name Description

Firm Name as it Should Appear 
at the Top of Each Page

Enables the user to enter the name of the reporting firm on 
the MedWatch form.

Date of FDA Approval to appear 
on the first page

Enables the user to enter the FDA approval date of the 
manufacturer.

Disclaimer to appear at the 
bottom of the first page

Enables the user to enter a brief disclaimer.

Default text to appear on Block 
H10

Enables the user to enter default text.

Reset MedWatch Numbering Enables the user to reset the sequence number that appears 
on the MedWatch form for the manufacturer.
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Use the following procedure to configure the MedWatch form options.

1. Enter the Firm Name as it Should Appear at the Top of Each Page.

2. Enter the Date of FDA Approval to appear on the first page.

3. Enter the Disclaimer to appear at the bottom of the first page.

4. Enter the Default text to appear on Block H10.

5. ClickReset MedWatch Numbering to reset the sequence number that appears on 
the MedWatch form, for the manufacturer as required.

User Interface
This section enables you to configure the common profile switches for User Interface.

Configuring User Interface  

The User Interface Configuration screen enables you to configure the user interface, as 
per the options available. Select System Configuration --> System Management to 
view the Common Profile Configuration screen.

To configure the fields associated with the User Interface section, click the User 
Interface folder in the left panel. The configurable fields associated with User 
Interface appear in the right panel.

Mfr. Site FDA Number Displays the FDA number for the Manufacturer Site which 
submitted the MedWatch 3500 Device report in the year.

Year Displays the year of report submission.

# of Reports Displays the number of submitted reports for products 
associated with a Manufacturing Site in that year

Reset Number Enables the user to reset the Sequence Number.

Tip:  The Common Profile folder appears in a tree-view on the left 
panel. The components are categorized as folders. Each folder 
contains all the field labels associated with that section.

Field/Control Name Description
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Field Descriptions  
The following table lists and describes the fields available under User Interface:

Configuring LAM  
The Local Labeling LAM Configuration screen enables you to modify the options 
available through local labeling for LAM.

Field Label Updates  The Argus Console Field Labels option enables the user to modify 
the field labels for the Argus Affiliate Event Information form.

■ The existing Argus fields are under the Argus Safety folder structure.

■ Please refer to the tables in the LAM Information section for the details about the 
Help Text for the fields.

■ The system enables the user to hide the field on the LAM form.

■ The system prints the Affiliate field labels.

■ The system tracks all field label updates in the audit log.

Field Validation Updates  Argus Affiliate enables the user to configure Field Validations 
for Mandatory and Warning for the LAM Event fields.

■ The existing Argus fields are under the Argus Safety folder structure.

■ Please refer to the table for LAM Event Info for the fields in the Field Validations.

■ The Affiliate fields for advanced conditions are only visible for field validations. 
They are not visible to the rest of the application.

■ The system prints the information for the configured field validations.

Field/Control Name Description

Display Enterprise 
Short Name in the 
header

This field enables the user to select whether to display the 
enterprise short name in the header. Check this checkbox 
to display the enterprise short name.
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■ The system tracks all updates to field validations in the audit log.

■ The system displays the standard Justifications dialog to enable the user to enter 
the justifications for overriding the warnings, but does not permit the user to save 
the case for a mandatory error.

Select System Configuration --> System Management to view the Common Profile 
Configuration screen

To configure the fields associated with the Local Labeling LAM section, click the Local 
Labeling folder in the left panel.

■ The LAM sub-folder is displayed in the left panel.

■ Click on LAM sub-folder to configure the LAM options.

■ The configurable fields associated with Local Labeling Lam appear in the right 
panel.

***********************************************************************************************

Field Descriptions
The following table lists and describes the fields available under Local Labeling LAM:

Tip:  The Common Profile folder appears in a tree-view on the left 
panel. The components are categorized as folders. Each folder 
contains all the field labels associated with that section.

Field/Control Name Description

Allow hiding of the Local 
Labeling dialog from Users

The available options are:

■ Local Labeling will be visible to users

■ Local Labeling will be hidden from users
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Use the following procedure to configure local labeling for LAM.

1. Select the option for Allow hiding of the Local Labeling dialog from Users.

2. Select the option for Report Scheduling when Labeling Changes from the Local 
Labeling Screen.

3. Select the option for Re-evaluate all scheduled and generated reports related to a 
case when the labeling is changed from the Local Labeling dialog.

4. Click Save to save the changes made.

Configuring MedWatch  The MedWatch Configuration screen enables you to modify the 
customizable fields on the MedWatch form. Select System Configuration --> System 
Management to view the Common Profile Configuration screen.

To view the list of field names associated with the MedWatch Configuration section, 
click the MedWatch Configuration folder in the left panel.

Report Scheduling when 
Labeling Changes from the Local 
Labeling Screen

The available options are:

■ No Report Scheduling will not be executed when the 
Local Labeling is changed

■ Report Scheduling will occur for those Licenses 
where the Labeling has changed

Re-evaluate all scheduled and 
generated reports related to a 
case when the labeling is 
changed from the Local Labeling 
dialog.

The available options are:

■ The system will not re-evaluate generated reports

■ Re-evaluate general reports.

Tip:  The Common Profile folder appears in a tree-view on the left 
panel. The components are categorized as folders. Each folder 
contains all the field labels associated with that section.
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***********************************************************************************************

The field names associated with MedWatch Configuration appear in the right panel.

Field Descriptions
The following table lists and describes the fields available under MedWatch 
Configuration:

Use the following procedure to configure the MedWatch form options.

1. Enter the Firm Name as it Should Appear at the Top of Each Page.

2. Enter the Date of FDA Approval to appear on the first page.

3. Enter the Disclaimer to appear at the bottom of the first page.

4. Enter the Default text to appear on Block H10.

5. ClickReset MedWatch Numbering to reset the sequence number that appears on 
the MedWatch form, for the manufacturer as required.

Reporting Configuration
This section enables you to configure the common profile switches for Reporting. This 
topic has been divided into the following sub-topics:

Field/Control Name Description

Firm Name as it Should Appear 
at the Top of Each Page

Enables the user to enter the name of the reporting firm on 
the MedWatch form.

Date of FDA Approval to appear 
on the first page

Enables the user to enter the FDA approval date of the 
manufacturer.

Disclaimer to appear at the 
bottom of the first page

Enables the user to enter a brief disclaimer.

Default text to appear on Block 
H10

Enables the user to enter default text.

Reset MedWatch Numbering Enables the user to reset the sequence number that appears 
on the MedWatch form for the manufacturer.

Mfr. Site FDA Number Displays the FDA number for the Manufacturer Site which 
submitted the MedWatch 3500 Device report in the year.

Year Displays the year of report submission.

# of Reports Displays the number of submitted reports for products 
associated with a Manufacturing Site in that year

Reset Number Enables the user to reset the Sequence Number.
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Configuring Reporting
The Reporting Configuration screen enables you to modify the options available for 
reporting. Select System Configuration --> System Management to view the Common 
Profile Configuration screen

To configure the fields associated with the Reporting section, click the Reporting 
folder in the left panel. The configurable fields associated with Reporting appear in 
the right panel.

Section Sub-Section Description

Reporting Expedited Reports 
Configuration

The Expedited Reporting Configuration screen 
enables you to modify the options available for 
expedited reporting.

Expedited BfArM The Expedited BfArM Reporting Configuration 
screen enables you to modify the options 
available for expedited BfArM reporting.

Expedited Canada The Expedited Canada Reporting Configuration 
screen enables you to modify the options 
available for expedited Canada reporting.

Expedited CIOMS The Expedited CIOMS Reporting Configuration 
screen enables you to print fields such as Patient 
ID, Medically Confirmed and Worldwide 
Number in the "26. REMARKS" section of the 
CIOMS form.

Expedited 
MedWatch

The Expedited MedWatch Reporting 
Configuration screen enables you to modify the 
options available for expedited MedWatch 
reporting.

Periodic The Periodic Reporting Configuration screen 
enables you to modify the options available for 
periodic reporting.

Scheduling The Scheduling Reports Configuration screen 
enables you to modify the options available for 
scheduling reporting.

Tip:  The Common Profile folder appears in a tree-view on the left 
panel. The components are categorized as folders. Each folder 
contains all the field labels associated with that section.
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***********************************************************************************************

Field Descriptions
The following table lists the fields available under Reporting:

Use the following procedure to configure reporting.

1. Select the option for Determine the minimum length of the routing comment text 
length on report routing dialog.

2. Enter the numeric value in the Minimum length of text required text-box, if 
applicable.

3. Click Save to save the changes made to this screen.

Expedited Reports Configuration
The Expedited Reporting Configuration screen enables you to modify the options 
available for expedited reporting. When configuring expedited reporting rules, be 
aware of the following:

■ If the user does not have permission to access Advanced Conditions on the 
Expedited Reporting Rules, the system does the following:

– Displays the advanced condition name instead of displaying a blank.

– Does not permit the user to modify or view advanced condition details.

Field/Control Name Description

Determine the minimum length of 
the routing comment text length on 
report routing dialog

The available options are:

■ No routing comment will be required

■ Minimum length of text required
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– Disables the Adv Condition button.

■ The system enables the user configure the Blinding Study Products option for 
those included in the case (default unchecked).

– The system track updates to this field in the audit log.

– The Reporting Rules reports print the new options

■ For cases where expedited reports are due, the user can force-distribute expedited 
reports even if processing is incomplete.

■ The reporting rules have a Forced Distribute XXX days before due check box. The 
default is unchecked.

– If the user checks the Force Distribute option, the # of days before due field is 
entered and automatically checks the Auto Distribute check box on the 
reporting rule (grayed out).

– The user can enter the number of days from 0 - # of days defined within the 
time frame.

– If the user enters a value greater than the defined time frame, the system 
displays the following message:

– Please enter a value less than the Time Frame defined for the Reporting Rule.

– If the user has not checked Force Distribute, the system disables the days 
before due.

■ The system tracks updates made to the new Argus Console fields in the audit log.

■ The system prints the new fields on the Reporting Rules report.

Select System Configuration --> System Management to view the Common Profile 
Configuration screen.

To configure the fields associated with the Reporting section, click the Reporting 
folder in the left panel. The Expedited sub-folder opens in the left panel.

Click on Expedited sub-folder to configure the expedited reporting options. The 
configurable fields associated with ExpeditedReporting open in the right panel.

Tip:  The Common Profile folder appears in a tree-view on the left 
panel. The components are categorized as folders. Each folder 
contains all the field labels associated with that section.
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***********************************************************************************************

Field Descriptions
The following table lists and describes the fields available under Expedited Reporting:

Field/Control Name Description

Active moiety report scheduling 
evaluation (a report scheduled against a 
product/license that shares ingredients 
with a product in a case)

The available options are:

■ Enable

■ Disable (default)

Allows Bulk by Form to show Unlocked 
Cases for Final Report

The available options are:

■ Report by Form and Bulk Report By Case will 
filter final reports by Locked Cases only

■ Bulk Report By Form and Bulk Report By 
Case will allow selection of unlocked cases to 
be submitted as Final

License number on MedWatch Drug 
Report

The available options are:

■ Print License # only for the scheduled license 
on MedWatch Drug Report

■ Print all available license numbers for Drug 
as determined by the scheduled license

Default name of Regulatory Agency for 
New Draft Expedited Reports from 
Analysis Tab of the Case Form

This enables the user to select the Default Name of 
the Regulatory agency from the drop-down list.

Text to display as comment when a 
downgrade report is scheduled

This enables the user to enter the text to display 
when a downgrade report is scheduled.
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Use the following procedure to configure expedited reports.

1. Select the option for Active moiety report scheduling evaluation (a report 
scheduled against a product/license that shares ingredients with a product in a 
case).

2. Select the option for enables Bulk by Form to show Unlocked Cases for Final 
Report.

3. Select the option for License number on MedWatch Drug Report.

4. Select the option for Default name of Regulatory Agency for New Draft Expedited 
Reports from Analysis Tab of the Case Form from the drop-down text-box.

5. Enter the text in the Text to display as comment when a downgrade report is 
scheduled text-box, if applicable.

6. Select the option for CIOMS report format to use.

7. Select the relevant CIOMS form, from CIOMS Form Selection.

8. Enter the transmission comments in Auto Distribution Transmission Comments.

9. Enter the submission comments in Auto Distribution Submission Comments.

10. Select whether to enable or disable printing the case version of expedited reports 
in Print Case Version of Expedited Reports (x.y.z).

11. Click Save to save the changes made to this screen.

Expedited BfArM Reports Configuration  The Expedited BfArM Reporting Configuration 
screen enables you to modify the options available for expedited BfArM reporting.

Select System Configuration --> System Management to view the Common Profile 
Configuration screen.

CIOMS report format to use The available options are:

■ Standard

■ Custom

CIOMS Form Selection This enables the user to select the CIOMS form to 
be used across the application for Expedited 
Reporting / Periodic Reporting.

Auto Distribution Transmission Comments Enables the user to enter transmission comments 
of up to 2000 characters, for Expedited Reports 
Transmission.

These comments are auto-distributed, based on 
Expedited Reporting Rules or Reporting 
Destinations.

Auto Distribution Submission Comments Enables the user to enter submission comments of 
up to 2000 characters, for Expedited Reports 
Transmission.

These comments are auto-distributed, based on 
Expedited Reporting Rules or Reporting 
Destinations.

Print Case Version of Expedited Reports 
(x.y.z)

This switch enables the user to enable or disable 
the printing of the case version of expedited 
reports.

Field/Control Name Description
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To configure the fields associated with the Reporting section, click the Reporting 
folder in the left panel. The Expedited- BfArM sub-folder is displayed in the left 
panel.

Click on the Expedited-BfArM sub-folder to configure the expedited BfArM reporting 
options. The configurable fields associated with Expedited - BfArMReporting appear 
in the right panel.

***********************************************************************************************

Field Descriptions
The following table lists and describes the fields available under Expedited - 
BfArMReporting:

Tip:  The Common Profile folder appears in a tree-view on the left 
panel. The components are categorized as folders. Each folder 
contains all the field labels associated with that section.

Field/Control Name Description

Causality Value on 
BfArM Report

The available options are:

■ beh.Azrt

■ Hersteller

■ Arznel.Komm

Value of field 
"Grunderkrankung" 
on the BfArM/PEI 
form

The available options are:

■ Do not output suspect and concomitant product indication in this 
field

■ Output additional suspect and concomitant product Events & 
Indications.
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Use the following steps to configure the expedited BfArM reports.

1. Select the option for Causality Value on BfArM Report.

2. Select the option for Value of field "Grunderkrankung" on the BfArM/PEI form.

3. Click Save to save the changes made to this screen.

Expedited Canada Reports Configuration  The Expedited Canada Reporting Configuration 
screen enables you to modify the options available for expedited Canada reporting.

Select System Configuration --> System Management to view the Common Profile 
Configuration screen.

To configure the fields associated with the Reporting section, click the Reporting 
folder in the left panel. The Expedited- Canada sub-folder is displayed in the left 
panel.

Click on the Expedited-Canada sub-folder to configure the reporting options. The 
configurable fields associated with Expedited - CanadaReporting appear in the right 
panel.

***********************************************************************************************

Field Descriptions
The following table lists and describes the fields available under Expedited- Canada 
Reporting:

Tip:  The Common Profile folder appears in a tree-view on the left 
panel. The components are categorized as folders. Each folder 
contains all the field labels associated with that section.
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Use the following procedure to configure expedited Canada reports.

1. Enter the SQL syntax for SQL used to populate the "Is there an ongoing clinical 
trial for this drug in Canada" field on the Canadian Expedited ADR report form.

2. Enter the SQL syntax for SQL used to populate the "Is there a clinical trial 
application for this drug under review in Canada" field on the Canadian 
Expedited ADR report form.

3. Enter the SQL syntax for SQL used to populate the "Is there a new drug 
submission for this drug under review in Canada" field on the Canadian 
Expedited ADR report form.

4. Enter the SQL syntax for SQL used to populate the "Report ADR occurred in Phase 
I-III Study" field on the Canadian Expedited ADR report form.

5. Enter the SQL syntax for SQL used to populate the "Report ADR occurred in Phase 
I-IV Study" field on the Canadian Expedited ADR report form.

6. Click Save to save the changes made to this screen.

Expedited CIOMS Reports  The Expedited CIOMS Reporting Configuration screen 
enables you to modify the options available for expedited CIOMS reporting. Select 
System Configuration --> System Management to view the Common Profile 
Configuration screen.

To configure the fields associated with the Reporting section, click the Reporting 
folder in the left panel.

The Expedited- CIOMS sub-folder is displayed in the left panel. Click on the 
Expedited-CIOMS sub-folder to configure the expedited CIOMS reporting options.

Field/Control Name Description

SQL used to populate the "Is there an 
ongoing clinical trial for this drug in 
Canada" field on the Canadian 
Expedited ADR report form

This field enables the user to enter the associated SQL 
syntax.

SQL used to populate the "Is there a 
clinical trial application for this drug 
under review in Canada" field on the 
Canadian Expedited ADR report form

This field enables the user to enter the associated SQL 
syntax.

SQL used to populate the "Is there a 
new drug submission for this drug 
under review in Canada" field on the 
Canadian Expedited ADR report form

This field enables the user to enter the associated SQL 
syntax.

SQL used to populate the "Report ADR 
occurred in Phase I-III Study" field on 
the Canadian Expedited ADR report 
form

This field enables the user to enter the associated SQL 
syntax.

SQL used to populate the "Report ADR 
occurred in Phase I-IV Study" field on 
the Canadian Expedited ADR report 
form

This field enables the user to enter the associated SQL 
syntax.

Tip:  The Common Profile folder appears in a tree-view on the left 
panel. The components are categorized as folders. Each folder 
contains all the field labels associated with that section.
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The configurable fields associated with Expedited - CIOMSReporting appear in the 
right panel.

***********************************************************************************************

Field Descriptions
The following table lists the fields available under Expedited- CIOMS Reporting:

Use the following procedure to configure the expedited CIOMS reports.

1. Select the Print Patient ID, Study ID, Center ID in the &rdquor;26. REMARKS" 
section of the CIOMS form checkbox to print these fields in the CIOMS form.

2. Select the Print Medically Confirmed in the &rdquor;26. REMARKS" section of the 
CIOMS form checkbox to print this field in the CIOMS form.

3. Select the Print World Wide Number in the &rdquor;26. REMARKS" section of the 
CIOMS form checkbox to print this field in the CIOMS form.

4. Click Save to save the changes made to this screen.

Field/Control Name Description

Print Patient ID, Study ID, Center ID in 
26. REMARKS section of the CIOMS 
form

Enables the user to print the Patient ID, Study ID 
and Center ID fields in the &rdquor;26. REMARKS" 
section of the CIOMS form.

Print Medically Confirmed in the 26. 
REMARKS section of the CIOMS form

Enables the user to print Medically Confirmed in the 
26. REMARKS section of the CIOMS form.

Print World Wide Number in the 26. 
REMARKS" section of the CIOMS form

Enables the user to print World Wide Number in the 
&rdquor;26. REMARKS" section of the CIOMS form.
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Expedited MedWatch Reports Configuration  The Expedited MedWatch Reporting 
Configuration screen enables you to modify the options available for expedited 
MedWatch reporting.

Select System Configuration --> System Management to view the Common Profile 
Configuration screen.

To configure the fields associated with the Reporting section, click the Reporting 
folder in the left panel. The Expedited- MedWatch sub-folder is displayed in the left 
panel.

Click on the Expedited-MedWatch sub-folder to configure the expedited MedWatch 
reporting options. The configurable fields associated with Expedited - 
MedWatchReporting appear in the right panel.

***********************************************************************************************

Field Descriptions
The following table lists the fields available under Expedited- MedWatch Reporting:

Tip:  The Common Profile folder appears in a tree-view on the left 
panel. The components are categorized as folders. Each folder 
contains all the field labels associated with that section.

Field/Control Name Description

Value for Field E4 on MedWatch The available options are:

■ Incidence Country not USA will mark Unknown in 
E4.

■ Incidence Country not USA will use Sent to 
Authority field on case form to determine E4 value.
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Use the following procedure to configure expedited MedWatch reports.

1. Select the option for the Value for Field E4 on MedWatch.

2. Select the option for the Data to print on follow up MedWatch Device form.

3. Select the required option for Number from LM_REF_TYPES.REF_TYPE_ID for 
Reference Type containing Legacy Case Number (to print MedWatch forms) from 
the drop-down list box.

4. Click Save to save the changes made to this screen.

Periodic Reports Configuration  The Periodic Reporting Configuration screen enables you 
to modify the options available for periodic reporting.

Select System Configuration --> System Management to view the Common Profile 
Configuration screen.

To configure the fields associated with the Reporting section, click the Reporting 
folder in the left panel. The Periodic sub-folder is displayed in the left panel.

Click on the Periodic sub-folder to configure the periodic reporting options. The 
configurable fields associated with Periodic Reporting appear in the right panel.

Data to print on follow up 
MedWatch Device form

The available options are:

■ All information (initial + follow-up) is displayed. 
(Previous Behaviour).

■ Only Display changed information from the initial 
report.

Number from LM_REF_
TYPES.REF_TYPE_ID for Reference 
Type containing Legacy Case 
Number (to print MedWatch forms)

This field enables the user to select the required option 
from the drop-down list.

Tip:  The Common Profile folder appears in a tree-view on the left 
panel. The components are categorized as folders. Each folder 
contains all the field labels associated with that section.

Field/Control Name Description
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***********************************************************************************************

Field Descriptions
The following table lists and describes the fields available under Periodic Reporting:

Field/Control Name DescriptionDescription

Inclusion Criteria for cases in the 
ICH PSUR report

The available options are:

■ Use Causality of the primary event

■ Use case level causality

■ Use causality of all the events against products in the 
PSUR

Print footnote Non Serious Listed 
for non-serious listed cases in ICH 
PSUR report

The available options are:

■ Yes

■ No

Inclusion criteria of event for a 
product in the PSUR

The available options are:

■ Primary Event (Left Most Diagnosis or the left-most 
Event if there is no Diagnosis on the case form)

■ Most Severe Event for the Product

■ Case Level Seriousness is used

Determine Possible Causality 
from the causality score

This field enables the user to enter a numeric value.

Determine Probable Causality 
from causality score

This field enables the user to enter a numeric value.
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Use the following procedure to configure periodic reports.

1. Select the option for Inclusion Criteria for cases in the ICH PSUR report.

2. Select the option for Print footnote "Non Serious Listed" for non-serious listed 
cases in ICH PSUR report.

3. Select the option for Inclusion criteria of event for a product in the PSUR.

4. Enter the value for Determine Possible Causality from the causality score.

5. Enter the value for Determine Probable Causality from causality score.

6. Select the option for On PSUR, NDA, IND, Medical Review List Reports.

7. Select the option for Inclusion Criteria for case in the ICH PSUR report.

8. Select the option for Seriousness Determination for event in the PSUR.

9. Click Save to save the changes made to this screen.

Scheduling Reports Configuration  The Scheduling Reports Configuration screen enables 
you to modify the options available for scheduling reporting. Select System 
Configuration --> System Management to view the Common Profile Configuration 
screen.

To configure the fields associated with the Reporting section, click the Reporting 
folder in the left panel. The Scheduling sub-folder is displayed in the left panel.

Click on the Scheduling sub-folder to configure the scheduling report options. The 
configurable fields associated with Scheduling Reports appear in the right panel.

On PSUR, NDA, IND, Medical 
Review List Reports

The available options are:

■ Use Initial Receipt Date for report search date range

■ Do not see initial Receipt Date for report search date 
range

Inclusion Criteria for case in the 
ICH PSUR report

The available options are:

■ Use listedness of the primary event

■ Use case level listedness

Seriousness Determination for 
event in the PSUR

Enables the user to configure the seriousness 
determination for an event in the PSUR. The available 
options are:

■ (Default) Seriousness from either case level or primary 
event level

■ Product Primary Event Seriousness is used

■ Case Level Seriousness is used

Tip:  The Common Profile folder appears in a tree-view on the left 
panel. The components are categorized as folders. Each folder 
contains all the field labels associated with that section.

Field/Control Name DescriptionDescription
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***********************************************************************************************

Field Descriptions
The following table lists and describes the fields available under Schedule Reports:

Use the following procedure to configure scheduling.

1. Select the option for Report Scheduling.

2. Select the option for Enable separate scheduling of device reporting rules from 
drugs and vaccines.

3. Select the operand to use for scheduling a report from Report Scheduling 
Causality Operand.

4. Click Save to save the changes made to this screen.

Field/Control Name Description

Report Scheduling The available options are:

■ Report Scheduling will be run by the Middle Tier 
Service

■ All report scheduling will be done locally on the 
client machine

Enable separate scheduling of device 
reporting rules from drugs and 
vaccines

The available options are:

■ Yes

■ No

Report Scheduling Causality 
Operand

Enables the user to select from the causality operands 
AND/OR to use for scheduling a report.
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Configuring Security
The Security Configuration screen enables you to modify the options available for 
security. Select System Configuration --> System Management to view the Common 
Profile Configuration screen.

To configure the fields associated with the Security section, click the Common 
Profile--> Security folder in the left panel. The configurable fields associated with 
Security appear in the right panel.

***********************************************************************************************

Field Descriptions
The following table lists the fields available under Security:

Tip:  The Common Profile folder appears in a tree-view on the left 
panel. The components are categorized as folders. Each folder 
contains all the field labels associated with that section.

Field/Control Name Description

Number of previous passwords that 
cannot be repeated

Enables you to configure the number of passwords that 
can be allowed.

For example, if you enter 4 in this field, it configures the 
system to enable up to 4 previous passwords that 
cannot be used as passwords again.

Number of non-alpha characters in 
password

Enables you to configure the number of non-alpha 
characters that should exist in a password. Non-alpha 
characters include characters such as @, $, etc.

Note: To avoid bad configuration, we recommend that 
the value of this switch is kept as 0 or 1 only.
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Use the following procedure to configure security.

1. Enter the value for the number of unique previous passwords in Number of 
previous passwords that cannot be repeated.

2. Enter the value for the number of non-alpha characters in Number of non-alpha 
characters in password.

3. Enter the value for the minimum number of characters for a password in 
Minimum number of characters in the password.

4. Enter the value for the number of consecutive failed login attempts in Number of 
consecutive failed login attempts before account is locked out.

5. Click Save to save the configured values.

6. Click LDAP to configure the LDAP fields.

The configurable fields associated with LDAP appear in the right panel.

Field Descriptions
The following table lists and describes the fields available under LDAP:

Use the following procedure to configure security.

1. Select the option for Enable LDAP at system level.

2. Click Yes to enable the LDAP Search Domain Account. This displays the LDAP 
Search Domain Account dialog.

Minimum number of characters in 
the password

Enables you to configure the minimum number of 
characters that a password must have.

For example, if you enter 8 in this field, it configures the 
system to ensure that every password contains at least 8 
characters.

Number of consecutive failed login 
attempts before account is locked out

Enables you to configure the number of consecutive 
failed login attempts that can be allowed before an 
account is locked out.

For example, if you enter 3, it means that up to 3 
consecutive failed login attempts are allowed. If the 
fourth consecutive login attempt also fails, the account 
gets locked out.

Field/Control Name Description

Enable LDAP at system level The available options for this are :

■ Yes

■ No

Field/Control Name Description
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The following table describes the fields of the LDAP Search Domain Account 
dialog:

Field/Control Name Description

Use Secure Socket 
Layer

If your LDAP Server is configured to use SSL for communication, 
please check this box. Use of SSL enables for a Secure communication 
between the client and the server using secure keys.

Force Anonymous 
Binding for Search

When setting up the LDAP Server, you have the option to force users 
to bind (authenticate) to the LDAP Server prior to being able to search 
the LDAP Tree. If this option has been setup in your LDAP server, 
this option must be checked.

UserDN During the setup of the LDAP server, the distinguished name and 
tree structure is created for users to be configured under. Enter in the 
defined structure as defined in your LDAP server into this box. This 
is required only if the server is setup for Force Anonymous Binding 
for Search".

Password Enter in the password for the User entered in the UserDN box for the 
bind to the server.

Server Name Enter in the LDAP Server name or IP Address to which LDAP 
Authentication needs to occur on.

Port Number Enter the port on which the LDAP Authentication Services are 
enabled on the LDAP Server (Default Value: 389).

BaseDN Enter in the topmost distinguished name of your tree defined on the 
LDAP Server for which you would like to search for users under.

Time Out (Sec) Enter a value in seconds, which will tell Argus how long to wait for a 
response from the LDAP Server during any authentication before 
timing out (Default Value: 10).

LDAP Search Key Enter the key to authenticate the user name against in the LDAP Tree 
structure. For Example, when using Microsoft Active Directory, to 
authenticate using the Windows Username (Not Full Name), enter in 
sAMAccountName.
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■ If you select the Use Secure Socket Layer (SSL) checkbox, the Port Number is 
auto-populated with the value 636.

■ If this checkbox is not selected, the Port Number is auto-populated with the 
value 389.

■ A generic LDAP server can accept anonymous as well as non anonymous 
binding, based on the configuration.

■ If the Force anonymous binding for search? checkbox is not selected, both 
UserDN andPassword are enabled.

3. Enter the LDAP username and password in the UserDN and Password fields, 
respectively.

4. Enter the values for Server Name, Port Number, Base DN, Time Out and LDAP 
Search Key, as required.

■ The field length for Port Number and Time Out is 5 characters, while the 
Server Name, BaseDN, LDAP Search Key, UserDN and Password can be up 
to 255 characters.

5. Click Save to save the changes made to this screen.

Configuring Single Sign-on
A common profile switch determines whether the system uses the single sign on 
function. The Enable Single Sign-on checkbox, enables you to configure the system to 
use the single sign-on feature.

Before enabling the single sign-on feature, be aware of the following:

■ If the user enables the Single Sign on feature, the user must enter Single Sign on 
the HTTP Header element Argus application uses for authentication.

– This field can contain a maximum of 40 characters

– If the single sign on feature is enabled and the user does not enter the Single 
Sign On HTTP Header, the system displays the following error message:

■ Please enter the Single Sign on HTTP Header or disable the Single Sign on feature.

The following table lists dialog boxes in the Argus Application that must require 
passwords. In such cases, the system single sign on feature redirects the password to 
Argus for validation. When single sign-on is enabled, the system locks the user 
account if the user enters and incorrect password three consecutive time. The 
Administrator must unlock the account to enable the user to log in to the application.

Function Section Procedure

Case Locking Activities|Lock Locking a case

Case Unlocking Activities|Lock Unlocking a case

Case Closing Activities|Close Closing a case

Case Unclosing Activities|Close Unclosing a case.

Case Unblinding General|Blinding Status Breaking a blind

E2B Incoming Accept Reports|Incoming E2B 
Reports

Accepting E2B Reports

E2B Incoming Reject Reports|Incoming E2B 
Reports

Rejecting E2B Reports
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The following modules launched in the Argus Application, continue to use single sign 
on feature:

■ Argus Insight

■ Argus PV Asset

■ Argus Affiliate

■ Argus J

The following modules do not use the Single Sign on feature:

■ End of Study Unblinding

■ Argus Safety Services

■ Argus Interchange Services (ESM)

■ Argus Interchange Mapping (ESM Mapping Utility)

Error Messages
Once the user is configured, the system automatically logs the user into the Argus 
Application without requiring reauthentication on the Argus Login application. If 
there is an authentication error, the system displays the current login page so the user 
can log in manually.

Configuring SMTP
This screen enables you to configure SMTP.

Currently there are multiple issues such as, Outlook related problems with AG Service 
due to new security features introduced by Microsoft. Due to these security 
enhancements, a new method to submit emails from AG Service has been 
implemented using the SMTP Protocol.

Select System Configuration --> SMTP Configuration to view the SMTP 
configuration pop-up dialog. The pop-up dialog opens as shown.

E2B Incoming Follow-up 
Accept

Reports|Incoming E2B 
Reports

Accepting E2B Follow-up Reports

E2B Incoming Follow-up 
Reject

Reports|Incoming E2B 
Reports

Rejecting E2B Follow-up Reports

E2B Incoming 
Nullification Accept

E2B Incoming Nullification 
Accept

Accepting E2B Nullification 
Reports

E2B Incoming 
Nullification Reject

E2B Incoming Nullification 
Reject

Rejecting E2B Nullification 
Reports

LAM Incoming Local Affiliate Incoming 
Review

Accepting an Affiliate Event

Workflow Routing Workflow Routing on 
Password on Route

Workflow Routing on Password 
on Route

Function Section Procedure
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***********************************************************************************************

Field Descriptions
The following table lists and describes the fields associated with this section.

Use the following procedure to modify SMTP.

1. Enter the SMTP Server IP or Name.

2. Enter the Port number to use for SMTP server.

3. Select the Authentication mode for the SMTP configuration, from the drop-down 
list.

4. Enter the SMTP User Name.

5. Enter the SMTP Password.

6. Select Enable SMTP? to ensure that the AG Service implements SMTP to send 
e-mails.

7. Click OK to save the changes made.

Configuring Workflow Items
The Workflow Items screen enables you to modify the options available for Workflow 
Items.

Select System Configuration --> System Management to view the Common Profile 
Configuration screen.

Field/Control Name Description

Server IP or Name Enables the user enter the SMTP server name / IP address.

Port Enables the user to enter the port number to use for SMTP server.

Authentication Enables the user to select the Authentication mode for SMTP 
configuration

SMTP User Name This is the username that the AG Service authenticates with for SMTP 
Emailing.

SMTP Password This is the password that the AG Service authenticates with for SMTP 
Emailing.

This field is required when Basic Authentication is selected in 
Authentication.

Enable SMTP When this checkbox is checked, SMTP is used by AG Service to send 
emails.
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To configure the fields associated with the User Interface section, click the Common 
Profile--> Workflow folder in the left panel. The configurable fields associated with 
Workflow appear in the right panel.

***********************************************************************************************

This section enables you to configure the total number of hours remaining for the 
present workflow state as well as the Total Number of the hours remaining for the case 
lock.

■ The first element displays the number of hours remaining for the case to be 
processed with the current workflow state.

■ The second element displays the number of hours remaining for the entire 
workflow for the case till Case Approval (Case Lock).

■ If the time remaining is less than the specified value in % for Yellow Indicator on 
the Case form for Dynamic Workflow, the elements are highlighted in yellow.

■ If the time remaining is more than the specified value in % for Yellow Indicator 
on the Case form for Dynamic Workflow, the elements are highlighted in green.

■ If the time remaining has exceeded the allocated time for the case process, the 
value is displayed in red, with the time displayed in negative.

■ The exceptions to this feature are those cases, which are archived and locked.

The Worklist>New and Worklist>Open also display a !" status beside Priority, 
denoting that the time remaining has exceeded the allocated time.

Tip:  The Common Profile folder appears in a tree-view on the left 
panel. The components are categorized as folders. Each folder 
contains all the field labels associated with that section.
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***********************************************************************************************

The total number of units is calculated by navigating across the possible routes the 
case can traverse. In case a case has to traverse through multiple possible routes, the 
preferred route is selected.

Field Descriptions
The following table lists the fields available under Workflow:

Use the following procedure to configure workflow items.

Field/Control Name Description

Case Routing The available options are:

■ Case form to close after use performs a manual routing

■ Case form to remain open

Display Locked/All 
cases on the worklist

The available options are:

■ Display option on the Worklist screen to view Locked Cases 
requiring follow-up only. (Default)

■ Display all the cases at the time

Minimum length of 
the routing comment 
text length

The available options are:

■ None

■ Text field

Display date for cases 
in the worklist

The available options are:

■ Display Initial Receipt Date of the Case in the Worklist. (Default)

■ Display Follow-up Date of the Case in the Worklist. Follow-up date 
is the last entered follow-up date

Due Soon Duration 
(in Days) for Worklist 
Calculation

Enter the number of days in which the worklist calculation is due.

Due Soon Red 
Indicator (in Days) 
for Worklist Display

Enter the number of days in which the red indicator is to due to be 
displayed for the worklist.

% for Yellow 
Indicator on the Case 
form for Dynamic 
Workflow

Enter the percentage for the yellow indicator on the case form for 
dynamic workflow. This field cannot have a value more than 99.

Enable Dynamic 
Workflow Timing

Select this checkbox to view the dynamic workflow indicators on the 
case form.
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1. Select the option for Case Routing.

2. Select the option for Display Locked/All cases on the worklist.

3. Enter the Minimum length of the routing comment text length in the text box.

4. Select the option for Display date for cases in the worklist.

5. Enter the number of days in which the worklist calculation is due in Due Soon 
Duration (in Days) for Worklist Calculation.

6. Enter the number of days in which the red indicator is to due to be displayed for 
the worklist in Due Soon Red Indicator (in Days) for Worklist Display.

7. Enter the percentage for the yellow indicator on the case form for dynamic 
workflow in % for Yellow Indicator on the Case form for Dynamic Workflow.

8. Select the Enable Dynamic Workflow Timing checkbox to view the dynamic 
workflow indicators on the case form.

9. Click Save to save the changes made to this screen.

Configuring Workflow
When a case is received by the company and initial details have been entered and 
saved into Argus Safety, its status in the system becomes 'New' or 'Data Entry'. Various 
actions may be required before a case makes the transition from one workflow state to 
another.

Example: The case may require review, letters may need to be issued, the case may 
need to be reported elsewhere in the company, or regulatory reports need to be 
submitted to regulatory authorities. The case can be closed after all outstanding 
actions have been carried out and it flows through its life cycle.

For each stage in case processing, Argus Safety enables responsibility for cases to be 
assigned to specific user or group of users. Click the following link for information 
about how worklist permissions have changed.

Worklist Updates
The Worklist is driven by the group permissions defined for each user.

■ Granular permissions have replaced the current worklist options for the following 
worklist elements in group permissions:

– Worklist - New

– Worklist - Open

– Worklist - Reports

– Worklist - Action Items

– Worklist - Coding Action Items

– Worklist - Contacts

– Worklist - Bulk Transmit

– Worklist - Bulk Print

– Worklist - Bulk E2B Transmit

– Worklist - Local Labeling

– Worklist - Coding Status
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– Worklist - Letters

– Worklist - Intake (default is disabled)

■ If the worklist is disabled during the upgrade, then all the sub-elements are 
disabled; otherwise, all are enabled.

■ The default for New Group Creation is enabled.

■ The User Group Permissions Report has been updated to reflect granular 
permissions.

Configuring Case Workflow
Configuring case workflow involves configuration of:

■ Workflow States

■ Workflow Rules

Configuring Workflow States  This screen enables you to configure the workflow states. 
The following illustration shows the fields associated with this section.

***********************************************************************************************

Field Descriptions
The following table lists and describes the fields available under Total Number of 
Rows:

Field/Control Name Description

State Name Displays the name of a workflow state.

State Description Displays a brief description about the workflow state.

Site Displays the site associated with a workflow state.
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Use the following to modify workflow states

1. Enter the name of the workflow state under State Name.

2. Enter the description of the workflow state under Description.

3. Select the site to be associated with the workflow state from the Site drop-down 
list.

4. The drop-down list is populated with the configured user sites.

5. Click Save to save the changes made.

Configuring Workflow Rules  This screen enables you to configure workflow rules. The 
following illustration shows the fields associated with this section.

***********************************************************************************************

Field Descriptions
The following table lists the Field Descriptions for this section.

Tip:  Click Add New to add a new workflow state to the list of 
existing workflow states.

Tip:  This name is displayed as Case Status in the General 
Information section of the Case Form.

Field/Control Name Description

From Defines the original state for the transition.

To Defines the destination state for the transition.



System Configuration Overview

System Configuration 4-76

Group Specifies the group which will own the case once it moves from the 
From state to the To state (via this transition).

The drop-down list displays all the configured user groups of Argus.

Normal Time (days) The workflow system monitors the time frames of each case in a state 
with respect to the Normal and Maximum parameters through AG 
Service.

■ The AG Service evaluates the status of each open case.

■ If a case has existed in its current state longer than the Normal time 
specified for the transition, the system raises the priority of the case 
by one level.

This escalation occurs only once for a case within a given state.

■ The case priority is not reset to its assigned priority upon 
transition.

■ If a case has existed in its current state longer than the Maximum 
time specified for the transition, the system raises its priority to 
level one (the highest priority).

■ In addition, an email notification is sent to the group's supervisor, 
indicating that the case has exceeded its maximum time.

■ The email message identifies the Case ID, Current State, Current 
Owner, and the time it has spent in its current state.

Max Time (days)

Units Enables the user to specify the number of units.

Product Group Enables the user to associate a specific Product group as additional 
criteria for the workflow transition.

Restrict to Workflow 
Group

Enables the user belonging to the identified workflow rule group to 
have case access rights, based on the definitions of only the identified 
group.

Email When checked, the system sends an email notification to the user group 
address specified in group information whenever a case makes this 
particular transition.

By default, the checkbox is unchecked.

Require Password on 
Route

■ If the switch PASSWORD_ON_ROUTING" is disabled (0), the 
password option on the Workflow Dialog is not displayed and the 
Routing dialog does not ask the user for a password.

■ If the switch PASSWORD_ON_ROUTING" is enabled (1), the 
password option on the Workflow Dialog is displayed to users. If 
the Workflow Rule has the password option checked and the case 
being routed passes that workflow rule criteria, the password 
option is displayed on the routing dialog.

■ If the Workflow Rule that the case has passed does not have the 
Password option checked, no password option is displayed on the 
routing dial.

Lock Case on Route Enables the user to not require a password when routing the case.

Reason for not being 
able to route

Enables the user to enter the description needed by the system to 
display while routing the case, when the case is ineligible to be routed 
to any of the configured To State".

Field/Control Name Description
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Use the following procedure to modify workflow rules.

1. Select the appropriate Filter Criteria.

■ Execute the following steps to apply a filtering criteria to search for specific 
workflow rules.

■ Select the check boxes to enable the drop-down lists containing a filtering 
criteria.

■ Select the appropriate filtering criteria from the drop-down lists.

■ Click Search to remove the selected criteria or click Apply Filter to apply the 
selected criteria. This displays the search results under Total Number of 
Rows.

2. The entities in Total Number of Rows display the From and To states, the 
Advanced Condition, Group, Normal Time/Max Time and Number of User 
Defined Attributes in the Workflow.

3. Select the rule displayed under Total Number of Rows that needs to be modified.

4. The ModifyWorkflow Rules section is populated with information about the 
selected rule.

5. Select the original state of the workflow rule from the From drop-down list.

6. Select the destination state of the workflow rule from the To drop-down list.

7. Select the group from the Groups drop-down list.

8. Select the product from the Product Group drop-down list.

9. Select the Email checkbox, if required.

10. Select the Lock Case on Route checkbox, if required.

11. Select the Require Password on Route checkbox, if required.

12. Enter the number of days in the Normal Time (days) field.

13. Enter the number of days in the Max. Time (days) field.

14. Enter the number of units in the Units field.

15. Select the preferred state for the rule from Preferred State.

16. Select the relevant Advanced Condition, if any from the button.

17. Enter the reason for not being able to route, if applicable, under Reason for not 
being able to route.

Privileges to others Specifies the access rights for groups other than To Group' of the 
transition have to the case when it follows that transition. The choices 
are:

■ No Access

■ Read-Only

■ Read/Write (default)

Preferred State Enables the user to specify the preferred state for the rule.

Tip:  Click here for details on Advanced Conditions

Field/Control Name Description
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18. Specify the access levels available to others from the Privilegesto others 
drop-down list. The options available under this list are No Access, Read-Only 
and Read/Write.

19. Specify the checklist of items to appear under Checklist.

20. Define custom attributes for a workflow rule under User Defined Attribute.

21. Click Save to save the changes made.

Worklist Intake
This section provides information about the Worklist Intake feature.

Pending Dialog  The system enables the user to view a list of incoming attachments in 
Worklist View. In this view, the user can select an attachment for the case creation for 
Argus and Affiliate cases in the Pending dialog.

***********************************************************************************************

The following table lists and describes the fields available for the worklist

Tip:  Select the No Access option to disallow users outside the 
transition's group to open the case when it follows the transition.

Select the Read-Only option to enable users outside the transition's 
group to view the case, but not to modify it.

Select the Read/Write option to enable users outside the transition's 
group to modify the case when it follows the transition.

Tip: The Checklist row cannot be left blank. Click Add and Delete to 
add and delete checklist items.

Field/Control Name Description Bookin Field Property

Priority Enables you to view the 
priority of a case

N/A Non-scrollable 
field label
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Initial Date Enables you to view the Initial 
Receipt Date of the case.

Initial Receipt 
Date

Non-scrollable 
field label

Intake Date Enables the user to view the 
date the system imported the 
attachment in the Intake 
Worklist

N/A Non-scrollable 
field label

Product Name Enables you to view the 
suspect product in questions.

Product Name Scrollable field 
label

Generic Name Enables you to view the 
generic name of the suspect 
product in question.

Generic Name Scrollable field 
label

Event PT Enables you to view the 
primary event and verbatim as 
reported

N/A Scrollable field 
label

Event Verbatim The following format will be 
used:

Primary Event (Verbatim as 
Reported)

N/A Non-scrollable 
field label

Serious Enables you to view the Case 
Level Assessments Serious 
(Y/N)

N/A Non-scrollable 
field label

F, LT, or H Fatal (F) or Life Threatening 
(LT) or Hospitalized (H)

■ If the case is Fatal, print F

■ If the case is Life 
Threatening, print LT

■ If the case is Hospitalized, 
print H

■ If any of the preceding are 
present together, Fatal 
takes precedence 
followed by LT, followed 
by H

■ If the case is neither, 
display No

Death for F

Hospitalized for H

Life Threatening 
for LT

Non-scrollable 
field label

Case Type Enables you to view report 
type information.

Report Type Non-scrollable 
field label

Study ID Enables you to view the Study 
ID for the study cases

This field is empty for cases 
where the Study ID is not 
available.

Study ID Non-scrollable 
field label

Reporter Type Enables you to view the 
reporter type for the primary 
reporter in the case.

This field is empty if the 
reporter type is not available.

N/A Non-scrollable 
field label

Country Enables you to view the 
country of incidence

Country of 
Incidence

Scrollable field 
label

Field/Control Name Description Bookin Field Property
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Worklist Intake View  The following table describes the Worklist Intake View:

Worklist  ■The system reads the XML that contains the preceding fields as tags and 
creates the Worklist based on the tags.

Central/Affiliate Site Enables you to view the 
current Argus or Affiliate site 
of the case.

You can view all the source 
documents from the site folder 
the user belongs to

Workflow enterprise users can 
view all cases across all site

N/A Scrollable field 
label

Attachment Enables you to view the 
attachment associated with the 
case. If there are multiple files, 
they are separated by a 
comma.

N/A Non-scrollable 
field label link

Classification Enables you to view the 
attachment classifications 
associated with the 
attachment.

Classification Scrollable field 
label

Description Enables you to view the 
attachment description 
associated with the case.

Description Scrollable field 
label

View All Enables the administrator and 
workflow manager/enterprise 
to see all items in the system 
across all sites.

N/A Radio button

View Individual Enables you to view all items 
assigned to this user site.

■ If there are no sites 
defined then all users 
have access to the case 
attachment.

■ This button is disabled if 
the user is not a workflow 
manager or enterprise 
user.

N/A Radio button

Argus Site Folder Worklist Intake View

US C:\USINTAKE All users belonging to the US site can see the 
case and workflow enterprise users.

DE C:\EUINTAKE All users belonging to the DE, FR, CH site can 
see the case and workflow enterprise users.

CH C:\EUINTAKE All users belonging to the DE, FR, CH site can 
see the case and workflow enterprise users.

FR C:\EUINTAKE All users belonging to the DE, FR, CH site can 
see the case and workflow enterprise users.

JP C:\JPINTAKE All users belonging to the JP site can see the 
case and workflow enterprise users.

Field/Control Name Description Bookin Field Property
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<Cases>

<Case>

<PRIORITY>: Single number from 1 - 8. All others to be ignored

<INITIAL_DATE>: Format of Date DD-MMM-YYYY

<PRODUCT_NAME>: Text Field up to 70 Characters

<GENERIC_NAME>: Text Field up to 70 Characters

<EVENT_PT>: Text Field up to 250 Characters

<EVENT_VERBATIM>: Text Field up to 250 Characters

<SERIOUS>: Yes / No. All others are ignored

<FLTH>: Format of F. All other after that are ignored

<LT>: Format of LT All other after that are ignored

<H>: Format of H. All other after that are ignored

<CASE_TYPE>: Text field of report type

<STUDY_ID>: Text field of Study ID

<REPORTER_TYPE>: Text field of Reporter Type

<COUNTRY_OF_INCIDENCE>: Text field of Country

<ASSIGNED_TO>: Text field of User

<GROUP>: Text field of Group

<SITE>: Text field of Site

<ATTACHMENTS>

<ATTACHMENT>:

<FILENAME>: Text field of Attachment File Name

<DOCID>: Document ID from Document Storage System

<CLASSIFICATION>: Text field of Attachment Classifications

<DESCRIPTION>: Text field of Attachment Classifications Descriptions

■ The text on the worklist prints as specified in the XML and no lookup is 
performed.

■ If any of the Tag elements are empty they will be empty in the Intake Worklist.

■ If any fields are not available on the initial case entry, the system ignores them.

■ If there are multiple tags for the same element, the system retrieves the first tag 
element.

■ If the values do not match any elements in the Initial Case entry, the system 
ignores them.

■ The minimum fields required for the Attachment to be visible in the Intake 
Worklist are

– Filename

– DocID
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– DocID is only required if a central document system is enabled. If DocID is 
blank then the physical file with the same name as specified in the tag 
<Filename> is also required in the same folder.

■ If there is an error occurs while processing the Worklist, AG Service sends an 
e-mail to the General E-mail address.

■ The system enables you to select only one case at a time when creating cases in the 
Initial Case entry dialog.

– When you select an attachment row and click Create case, the system locks the 
file to prevent others users from booking in the same case.

– The system displays the following message:

The case attachment is being currently used by XXXX user.

where:

XXXX is the full name of the user who has locked the attachment row

– The system displays the standard Initial Case Entry where the system  
populates the fields within the XML Properties to the Initial Case entry dialog 
and display the PDF file for 40% of the screen (Similar to the New case from 
Image functionality)

– If multiple attachments are available, the system opens them. The end user 
system must be setup to open multiple documents in the same window in 
Internet Explorer.

– If the system is setup to use a central document storage system and the user 
clicks Create Case, the system retrieves the PDF from the central document 
system.

– The system adds the attachment to the Initial Case entry dialog and also 
includes the Classifications and Descriptions for the attachment.

– If the system is setup to use a central document storage system, Argus stores 
the document ID from the central document system. The file attachment will 
not be stored in Argus.

–

– The system fills all available fields in the Initial Case Entry dialog with data 
from the XML Messages.

– If you choose to open the cases after book-in, the system keeps the Attachment 
open in the split screen to enable the user to complete the case data entry.

– If you book in the case from the Worklist Intake and chooses not to open the 
case from the Initial Case Entry dialog after book in is complete, the system 
returns to the Worklist Intake dialog.

■ When you perform a Duplicate Search and select a Case from the list, you can 
attach an incoming file to an existing case.

– The system displays the Accept As Follow-up button and enables it when the 
user selects a case from the Duplicate search for the current Attachments to be 
added.

– When you click Accept as Follow-up, the system opens the selected case and 
continues to display the Source attachments.

– The system adds the attachments with the Classification and description (if 
provided) to the follow up case
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– The system opens multiple attachments if they are available. The end user 
system must be setup to open multiple documents in the same window.

■ Once you accept the initial or Follow up case and successfully create the case in 
Argus / Affiliate, the system generates an Acknowledgement in the OUT folder at 
the same level. For example, if the incoming folder for Site US is 
C:\USSITE\Incoming, the system generates ACKS in the C:\USSITE\OUT folder.

– a. The Message format for the ACK is as follows::

<CASES>

<CASE>

<CASE_NUMBER>: Argus Generated Case Number

<PRODUCT_NAME>: Text Field up to 70 Characters for Primary Suspect 
Product of Case

<DATETIME>: The Date and time in the DD-MMM-YYYY hh:mm:ss format 
when the file was accepted / rejected by the system

<ATTACHMENTS>

<ATTACHMENT>:

<FILENAME>: Text field of Attachment File Name

<DOCID>: Document ID from Document Storage System

■ If you click Copy to copy a case in Argus, the system generates an ACKS and puts 
it into the out folder for the site the original case belongs to. For example, Case A 
belongs to US Site and the user copies the case to Case B. The system creates an 
ACK in the US\Out Folder as configured in the US Site.

Rejected Cases  In Argus Safety, the Workflow Manager or Enterprise User can click 
Reject Case to reject cases from the Intake Worklist.

■ Affiliate Users can reject cases in the Intake Worklist.

– When you try to reject a case, the system presents the Standard Justification 
dialog.

– The Status row displays the following message:

Case Rejected by XXXX on YYYY at MMM due to: ZZZZ

where:

XXX is the User Full Name,

YYYY is the Date when the case was rejected in GMT

MMM is the time in GMT

ZZZ is the justification for rejecting the case as entered by the user.

– Rejected Date: Date in GMT when the user rejected the case

– Rejected By: User Full Name who rejected the case.

■ The system displays the Total number of Rows in the Worklist header section.

■ You can select the number of cases to display on the by selecting a value from page 
size drop-down list on the Worklist dialog.

■ The page drop-down list contains the following values:

– 50
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– 100 (default)

– 250

– 500

– 1000

– 2000

■ The system displays the number of cases currently in view and updates the range 
automatically. For example. if you select 100 from the page size drop-down list, the 
system separates the displaying rows into groups of 100 cases.

■ The system enables you to go directly to a range of cases from the Displaying 
Rows drop-down list.

■ The system enables you to scroll through the Worklist page-by-page increments as 
defined by the Page Size drop-down list.

■ The system enables you to sort on ALL the columns in the Worklist view by 
clicking the header column. The system displays a triangle to show which column 
is sorted currently.

– The initial sorted column is Initial Date.

– The default sort order is ascending

– Clicking the column header again, toggles between ascending and descending 
order.

■ The system maintains the worklist view with the sorting and filtering options 
defined by the user.

■ The Intake Worklist enables you to filter on each element.

■ The system enables you to filter on any element when you click the Filter button.

– The system provides a Type Ahead feature to enables users to filter on any 
text/date element.

– The system enables you to Close the filtering options by clicking the X icon on 
the filtering options.

– If filtering criteria are specified, the Filter icon has the paper clip icon to 
indicate there are filtering elements.

– The system permits a Like search (e.g. if you search for Cure, it returns all 
elements starting with Cure).

– The system enables wild card searches . For example, if the user searches for 
%Cure, the system returns all elements containing Cure

– Clicking the Search button enables you to filter for the reports in the list of 
reports.

– These are filtering options are available from Worklist-specific views and 
when you drill down for cases or reports.

■ The system saves all user preferences for future use.

■ Clicking the Search button enables you to filter the elements on the dialog.

User Site Updates and Access Management  You can configure the Path for the File Intakes 
per Site (Argus and LAM) in the Site configuration
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■ When you click the Browse button, the system enables you to browse to the Folder 
for the Site where the XMLS and the PDFs are stored

■ The Path length is up to 255 characters

***********************************************************************************************

■ The current Worklist options are replaced with granular permissions for Worklist 
elements in the Group Permissions as per the following:

■ Worklist Intake (default is disabled)

■ The Audit Log tracks the updates made to Site Configuration

■ The User Site print out displays the File Intake Path.

Configuring System Numbering
This screen enables you to specify the case numbering preferences. Select System 
Configuration --> System Numbering to view the LAM System Numbering screen.

The screen appears as shown.
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***********************************************************************************************

Field Descriptions
The following table lists and describes the fields for this section.

Field/Control Name Description

Manually Number 
Cases

Enables the user to manually number the cases on booking or while 
copying the case, using the save as' option on the case form.

Automatically 
Number Cases

On selection, the system automatically numbers the cases as defined by 
the user in the numbering format.

Start at Enables the user to initialize the counter of the sequence number.

Separate sequence for 
each site

Enables the user to separate the sequence numbering for cases on site 
by site basis. If there are cases being entered from two different sites 
then each site will have different sequencing of case numbers.

Separate sequence for 
each report type

Enables the user to separate the sequence numbering for cases by the 
report type of the case.

Separate sequence for 
each year

Enables the user to reset the sequence numbering for cases after each 
year based on the initial receipt date of the case.

Separate sequence for 
each month

Enables the user to reset the sequence numbering for cases after each 
month based on the initial receipt date of the case.

Separate sequence for 
each product 
abbreviation

Enables the user to reset the sequence numbering for cases for each 
different product abbreviation.

Numbering Format Enables the user to select the numbering format by selecting the 
different placeholders.

Define the numbering format by typing in custom keywords to print on 
every case number and selecting different placeholders.

[YY][MM]-[###] is the default format.
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Use the following procedure to configure LAM system numbering.

1. Select the Numbering feature as required. This can be manual numbering or 
automatic numbering of cases.

2. Select the Sequencing Options as required.

3. Select the Numbering Format.

Placeholder Placeholders are used to pickup values from the database to be used in 
the Case numbering format.

The possible values populated in this list are:

# - Number: defines the digits to be used as the sequence number in the 
format. The field is used to display the sequence number on the case 
numbers.

CC- Country Code: When selected, this uses the A2 code for the country 
of incidence for the case number.

DD - Day: When selected, this uses the date of the Initial receipt date' 
field of the case.

MM - month: When selected, this uses the month of the Initial receipt 
date' field of the case.

P - When selected , this uses either of the two values:

If report type is Spontaneous' or other' during booking: the system uses 
the value of the Product Abbreviation' field specified in the Product 
configuration for the selected Primary suspect product.

If report type is of the type report from study' during booking: the 
system uses the Product Abbreviation' field specified in the study 
configuration.

SSS - User Site: When selected this uses the Site abbreviation of the site 
belonging to the user who booked in the case.

TTT - Report Type: When selected this uses the report type abbreviation 
of the report type selected during bookin of the case.

YY- Year: When selected, this uses the year of the Initial receipt date' 
field of the case.

Tip:  For the complete explanation of the sequencing options refer to 
the Field Descriptions

Tip: To customize the Numbering Format, use the placeholder 
values.

Example: To select Country Code, Month and Year (as values to be 
incorporated from the database ) as the Case numbering format, 
execute the following steps.

■ Click on Country Code. This appears in the Numbering Format 
field.

■ Click on Month. This appears in the Numbering Format field next 
to the Country Code.

■ Click on Year. This appears in the Numbering Format field next to 
the Country Code and Month.

The final data listed in the Numbering Format field is the Case 
Numbering Format.

Field/Control Name Description
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4. Click Save to save the changes made.

Configuring Field Labels
This section enables you to change field label names and hide or display fields in the 
Case Form.

Select System Configuration --> Field Labels to view the Case Form Field 
Configuration screen shown in the following illustration.

***********************************************************************************************

Field Descriptions
The following table describes the fields associated with this section.

Tip:

The Case Form tabs appear in the left panel and are categorized as 
folders. Each folder contains all the field labels associated with that 
section.

Example : The General Tab in the Case Form contains sections such as 
Study, Follow-Up, Case Literature etc.

■ To view the list of field names associated with the Study section , 
click Study in the left panel.

■ The field names associated with Study appear in the right panel.
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Use the following to modify case form field names.

1. Select the folder (or section) in the left pane, for which the field names are to be 
modified.

2. The places the list of field labels associated in the right panel.

3. Click on the Field Name to be modified.

4. The system highlights the selected row is highlighted and puts the details about 
this field in the Modify section at the bottom of the screen.

5. Enter the new field name in Field Form Label.

6. Select the Hidden preference. Select Yes if you want to hide the field on the Case 
Form.

7. Click this checkbox to indicate which fields are required for E2B.

8. Select any or all of the following options Drug, Device or Vaccine as Read Only 
based on your requirement.

9. Click Save to save the changes made.

Configuring User Defined Fields
The Argus Safety administrator can customize a user-defined field as a drop-down list. 
These drop-down lists may contain customized lookup data which can be 
independent of Argus data.

Field/Control Name Description

Field Name Enables the user to view the field name. This is a read only field.

Field  Form Label Enables the user to enter the field label names for those fields that can 
be edited.

Help Text Enables you to enter help text for fields that can be edited.

Selectable When checked, enables you to???

Read Only Enables you to make  inrug, device, or vaccine field read- only.

Drug Enables the user to make a field Read only in the Product tab, when the 
Argus user chooses Drug" option on the Product screen.

Device Enables the user to make a field Read only in the Product tab, when the 
Argus user chooses Device" option on Product screen.

Vaccine Enables the user to make a field Read only in the Product tab, when the 
Argus user chooses Vaccine" option on Product screen.

Hidden Enables the user to hide or unhide a field by selecting the radio button.

Select Yes to hide the field on case form; select No to unhide the field on 
case form.

Note: Some fields cannot be hidden. Hidden fields do not appear in the 
case form printout.

E2B Field When checked, hows which fields are required for E2B.

Tip:  : This label will appear in the Case Form section.

Note:  Label Changes will not be reflected in Argus Case Form 
unless IIS is reset.
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Use the following procedure to create a user-defined field.

1. Identify the User Defined field in the CMN_FIELDS table.

2. Create a custom table containing lookup information.

3. Create a custom index and specify the required values for the table.

4. Update the record in the CMN_FIELDS table for the User Defined Field.

5. Create a Role and Synonym for the table.

6. Restart IIS.

7. Verify the update made in the application.

Consider the following example that show a sample set of scripts required to configure 
User Defined Fields as a drop-down list. Assume the requirement is for a User 
Defined Field (UDF) with the following features:

Requirement: A User Defined field "SOURCE_OF_INFORMATION" to be created, 
with its drop-down values as Fax, E2B, Letter, Email and Telephone under Case Form 
-> General Tab -> General Information.

Use the following procedure to create a user-defined field:

1. Login to Argus --> Argus Console --> System Configuration --> Field Labels.

2. Enter the Field Form Label as Source of Information.

3. Select No against Hidden and click Save.

4. Query the following required field for an update, based on the field_label

SELECT

field_ID, field_label, table_name, column_name, tree_view, data_type, data_length

FROM

cmn_fields

WHERE

field_label LIKE '%SOURCE_OF_INFORMATION%';

5. Create a Custom Table

create table pf_SOURCE_OF_INFORMATION(

pf_SOURCE_OF_INFORMATION_code number,

pf_SOURCE_OF_INFORMATION_desc varchar2(100))

/

6. Create a Custom Index

create index idx_pf_SOURCE_OF_INFORMATION

on pf_SOURCE_OF_INFORMATION (pf_SOURCE_OF_INFORMATION_code)

Attribute Value

Field Name SOURCE_OF_INFORMATION

Drop-down Values Fax, E2B, Letter, Email and Telephone

Field Location Case Form => General tab => General Information
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/

7. Insert values

insert into pf_SOURCE_OF_INFORMATION values (1, MI Fax');

insert into pf_SOURCE_OF_INFORMATION values (2, MI E2B');

insert into pf_SOURCE_OF_INFORMATION values (3, MI Letter');

insert into pf_SOURCE_OF_INFORMATION values (4, MI Email');

insert into pf_SOURCE_OF_INFORMATION values (5, MI Telephone');

8. Update CMN_FIELDS table

update cmn_fields

set join_type = 1,

GUI_field_type = 6,

field_length = 100,

JOIN_FLD_ID = 50001,

select_table = 'pf_SOURCE_OF_INFORMATION',

join_field = 'PF_SOURCE_OF_INFORMATION_CODE',

select_column = 'PF_SOURCE_OF_INFORMATION_DESC'

where field_id = 2150032

/

commit;

/

9. Grant select to ARGUS_ROLE

grant select on pf_SOURCE_OF_INFORMATION to argus_role;

10. Create Public Synonym

create public synonym pf_SOURCE_OF_INFORMATION for argus_app.pf_
SOURCE_OF_INFORMATION;

11. Restart the Web Server

12. Go to the command prompt and enter the iisreset command for changes to take 
effect.

13. Verify the outcome from the front end

14. Login to Argus Safety and open a Case Form.

Go to General tab | General Information and check that the configured user-defined 
fields display the updated drop-down text.
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5Code List Configuration

Information about configuring the following code list items is included in this chapter.

■ Autosignals

■ Batch Reports

■ Letters

■ Justification

■ Electronic Transmission Recipient

■ Literary Citation

■ Reporting Destination

■ Routes of Administration

■ Study Center

■ Other Code List Items

Configuring Code Lists
Code List items appear at several locations in the Case Form. It is essential to configure 
relevant Code List items in order to ensure that case entry in Argus Safety is done 
according to your company's policies. Before configuring Code List items , the 
Administrator should consult the company's policies and the terminology used by the 
company.

To ensure that the Administrator does not have to enter excessive amounts of data 
during Code List configuration, Argus Safety is shipped with factory data for many of 
the Code List items.

Tip: The following Code List Items have been described to 
familiarize you with the Code List configuration.

■ For the complete set of Code Lists refer to the Argus 
Console->Code List section.

■ The default help text associated with each code list item is 
displayed at the bottom of the left panel.

Code List Item Description

Autosignals This screen helps in capturing Auto Signal information. Users can 
define the criteria that triggers Autosignal within Argus
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General Requirements for Code Lists
All code lists have the following common behaviors:

■ You can access code lists from Argus Safety Console-->Code Lists Menu-->Argus J.

■ Argus J is available to you only when the license is enabled. 

■ Code list items that use common English terms that are familiar in Japanese are 
shown in their original language.

■ The following code list items are not translated:

– Autosignal Configuration

– Batch Reports

– Electronic Transmission Recipients

– Message Type

– User Sites

■ All translation fields end with (J)

■ If a  Japanese translation isn’t available for any drop-down list, the corresponding  
J values  will have a ? on the drop-down list.

■ When copying data, the words "Copy of" are before the data in the  field. 

■ The name of the document must be unique. If it is not unique the system  presents 
the following error message: "A duplicate <field name> already exists!"

Configuring Autosignals
This screen enables you to capture the Auto Signal information.Using this screen, you 
can define the criteria that triggers Autosignal within Argus.

Example: If an event is reported within x number of days, an email is sent to the 
defined individual or workgroup. The system checks for patterns each time new data 
is entered, and sends e-mails to the appropriate individuals or departments on finding 
a matching pattern.

Select Code Lists --> Argus to view the Code List Maintenance screen.

Batch Reports This screen helps in capturing Batch Reports information.

Letters The screen helps in configuring the system to create and schedule 
letters automatically, according to pre-defined business rules.

Justification This screen helps in capturing justification information.

Electronic 
Transmission 
Recipient

This screen helps in capturing electronic transmission recipient 
information.

Literary Citation This screen helps in capturing information about Literary Citations.

Reporting 
Destination

This screen helps in capturing Reporting Destination information.

Routes of 
Administration

This screen helps in capturing Route of Administration information.

Study Center This screen helps in capturing Study Center information.
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Field Descriptions
The following table describes the fields associated with this section.

Use the following procedure to configure Autosignals.

1. Click on the Autosignals folder in the left panel. The associated autosignal data 
appears in the Total Number of Rows section in the right panel.

***********************************************************************************************

Tip:  The code list items are displayed in the left-panel. Click on the 
required Code List folder to be configured. The details of this code list 
item appear in the right panel.

Field/Control Name Description

Name Enables the user to enter the name of the Autosignal. This is a 
required field.

Number of 
Occurrences

Enables the user to enter the number of occurrences of the 
autosignal.

Occurrences of Enables the user to enter the user to select or create an advanced 
condition for the autosignal through Select icon. 

Number of days Displays the number of days for the autosignal.

As cases are entered Enables the user to perform autosignal as cases are entered.

Every N Days Enables the user to enter the number of days, when autosignal 
should be executed.

Email Enables the user to enter the email address of Argus users to whom 
the email about autosignal occurrence should be sent.



Configuring Code Lists

Code List Configuration 5-4

2. Click on the Name (or row), to view the details associated with the selected 
autosignal. The details appear in the Modify Autosignal section.

You can use the Autosignals Filter to make your search specific to an autosignal. 
The filtering criterion is essential as it helps you to search for specific items.

3. Select the appropriate Field as the filtering criteria from the drop-down list.

4. Once you have selected the Field, you can specify whether your search should 
contain or start with specific alphabets.

5. Enter the search criteria in Value.

6. Click Filter to apply the selected criteria.

This displays the search results under Total Number of Rows.

7. Enter the name of the autosignal in the Name field.

8. Enter the number of occurrences of the autosignal in the Number of Occurrences 
field.

9. Select or create an Advanced Condition, if any from the button in the Occurrences 
of field.

10. Enter the number of days for the autosignal under the Number of days field.

11. Select the As cases are Entered checkbox to perform autosignal as cases are 
entered.

12. Enter the number of days when the autosignal should perform under the Every N 
Days field.

13. Enter the e-mail address that receives email about autosignal occurrence in the 
Email field.

14. Click Save to save the changes made to this screen.

Configuring Batch Reports
This screen enables you to configure Batch Reports information.

Tip: You can alternatively click Add New to create a new auto sig-
nal.: Click Copy to make an editable copy of an existing autosignal.

Click Delete to delete a selected autosignal.

Tip:  Click here for details on Advanced Conditions
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***********************************************************************************************

■ Scheduled reports can be automatically generated and stored in the database by 
Argus Safety Service. This screen displays a list of all the existing Batch Reports.

■ By default the Batch reports shown are report regeneration. The Argus user can 
see the list of scheduled reports for memorized reports, using the Memorized 
Reports option.

■ Select Code Lists --> Argus to view the Code List page.

■ Click on the Batch Reports folder in the left panel.

The associated report data appears in the Total Number of Rows section in the right 
panel.

Field Descriptions
The following table describes the fields associated with this section.

Tip:  : The code list items are displayed in the left-panel. Click on the 
required Code List folder to be configured. The details of this code list 
item appear in the right panel.

Field/Control Name Description

Title Name This is the unique name for the batch report name.

Report Enables the user to select a report that has to be scheduled.

Report Regeneration

Memorized report

Product Enables the user to select a product for which the report is generated.

Frequency: Every 
Hrs.

Enables the user to enter the number of days after which the report is to 
be generated. The value has to be --> 0.
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Use the following procedure to configure Batch Reports

1. Click on the Report Title (or row), to view the details associated with that report. 
The details appear in the Modify Batch Report section.

You can use the Batch Reports Filter to make your search specific to a batch 
report. The filtering criterion is essential as it helps you to search for specific items.

2. Select the appropriate Field as the filtering criteria from the drop-down list.

3. Once you have selected the Field, you can specify whether your search should 
contain or start with specific alphabets.

4. Enter the search criteria in Value

5. Click Filter to apply the selected criteria.

6. This displays the search results under Total Number of Rows.

7. Enter the Title Name for the batch report.

8. Select the Report Type from the drop-down list.

9. Select the Group to which the report must be assigned.

10. Select the report to be scheduled as Memorized Reports or Reports Regeneration.

11. Select the Frequency of generating the report after the specified number of days 
have elapsed.

12. Select the Product for which the report is to generated, from the drop-down list 
box.

13. Select the Report from the drop-down list.

14. Enter the Next Run Date. This is the next date from which the report has to be 
scheduled.

15. Select the Advanced Condition associated with the report configuration.

16. Click Select icon to launch the Advanced Conditions browser.

17. Click Save to save the changes made to this section.

Next Run Date Enables the user to enter the next date from which the report has to be 
scheduled.

Advanced Condition Enables the user to select the Advance Condition that satisfies the 
criteria which will trigger the Signal. You can either select an existing 
criteria or create a new one.

Report Type Enables the user to select the type of the report.

Group Enables the user to select the group to which the report must be 
assigned.

Tip:

You can alternatively click Add New to create a new report.

■ Use Copy to make an editable copy of an existing report.

■ Use Delete to delete an existing report.

Tip:  : Click here for details on Advanced Conditions

Field/Control Name Description
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Configuring Letters
Argus Safety enables the customization of letter templates in order to correspond with 
reporters or health officials and keep them updated with case activity. Access to the 
Letter Configuration dialog can be granted to any user or user-group, as found 
appropriate by the Administrator.

***********************************************************************************************

■ To automatically generate a letter, the system reads a template that specifies the 
information that must appear in the letter.

■ The template is a file in Rich Text Format (".rtf" format) that contains the letter text 
and some field identifiers (also called placeholders). The system substitutes 
information specific to the current case for the placeholders in the template. Thus, 
a letter containing case-specific information is automatically generated.

■ The administrator can set up the system to create and schedule letters 
automatically, according to pre-defined business rules. This section discusses the 
creation, modification, and deletion of letter templates.

Select Code Lists--> Argus to view the Code List page.

Field Descriptions
The following table describes the fields associated with this section.

Tip: The code list items are displayed in the left-panel. Click on the 
required Code List folder to be configured.

The details of this code list item appear in the right panel.
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Use the following procedure to configure letters.

1. Click on the Letter Configuration folder in the left panel. The associated data 
appears in the Total Number of Rows section in the right panel.

2. Click on the Name (or row), to view the details associated with that letter. The 
details appear in the Modify Letter Configuration section.

3. You may use the Letter Configuration Filter to make your search specific to a 
letter. The filtering criterion is essential as it helps you to search for specific items.

4. Select the appropriate Field as the filtering criteria from the drop-down list.

5. Once you have selected the Field, you can specify whether your search should 
contain or start with specific alphabets.

6. Enter the search criteria in Value.

7. Click Filter to apply the selected criteria.

8. This displays the search results under Total Number of Rows.

Field/Control Name Description

Name Enables the user to specify the name of the letter as it will appear in 
the Letters menu.

Name (J) Enables the user to specify the Japanese name of the letter as it will 
appear in the Letters menu.

Edit Template Enables the user to open the letter in MS-Word (template) for 
editing.

Menu The Menu check box enables the user to indicate whether this letter 
template should appear on the Letters menu or in the template 
selection dialog.

If the Menu check box is cleared, the letter template will be available 
in the More Letters selection in the Letters menu.

Regulatory Cover 
Letter

Enables the user to indicate whether this letter template should 
appear in the Regulatory Rules dialog Cover letter drop-down list 
box.

Schedule - Letter Enables the user to enter the number of days (from the receipt date) 
when the letter will be due.

Schedule - Action The Action field enables the Administrator to specify the number of 
days (from the current date) after which the Action Item for 
following up on this letter will be due.

Sites Argus Console provides the ability to configure letters to user sites. 
Enables users to select single or multiple sites for that letter. The 
system will only allow users to see letters that are configured to 
their site.

Action Items The action items list is a drop-down list of action item codes from 
the Action Type List Maintenance.

Return Email 
Address

Enables the user to enter a default email address where the mails 
will be sent. This address is displayed by default in the Activities tab 
of the Case Form.

Advanced Condition Enables the user to configure Advanced Conditions. If the case 
matches with the Advanced Condition, the configured letter is 
scheduled for the case.
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9. Click Select to specify the path of the letter template to be used.

10. Enter the name of the letter, as it will appear, in the Letters Menu section in Enter 
a new item.

11. Click Add or Delete to configure letter to the user Sites.

12. Select the Action Item from the drop-down list box. The action items list is a 
drop-down list of action item codes, from the Action Type List Maintenance.

13. Configure the Advanced Condition for the case.

14. Enter the Schedule (days)-Letter. This is the number of days from the receipt date 
when the letter is due.

15. Enter the Schedule (days)-Action. This is the number of days from the current 
date, after which the Action Item for the follow up on this letter will be due.

16. Enable the Regulatory Cover Letter option to indicate whether this letter template 
should appear in the Regulatory Rules dialog.

17. Enter the default e-mail address in Return Email Address.

18. Click Save to save the changes made for this section.

Configuring Justifications
This screen enables you to capture justification information.

Tip: Tip : You can alternatively click Add New to create a new letter.

■ Use Copy to make an editable copy of an existing letter.

■ Use Delete to delete an existing letter.

Tip:  Click Edit Template to save the existent template on to your 
local drive of the system.

You can edit this template and repeat the step listed above, to ensure 
that the updated template is used for letters.
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***********************************************************************************************

Argus Safety users can enter the reasons for overriding system determinations using 
the Justifications dialog. The Justification items appear on the Action Justification 
dialog on the screen.

Select Code Lists--> Argus to view the Code List page.

Field Descriptions
The following table describes the fields associated with this section.

Use the following procedure to configure justification.

1. Click on the Justifications folder in the left panel. The associated report data 
appears in the Total Number of Rows section in the right panel.

2. Click on the Type (or row), to view the details associated with that justification. 
The details appear in the Modify Justification section.

3. You may use the Justifications Filter to make your search specific to a justification. 
The filtering criterion is essential as it helps you to search for specific items.

4. Select the appropriate Field as the filtering criteria from the drop-down list.

Tip: The code list items are displayed in the left-panel. Click on the 
required Code List folder to be configured.

The details of this code list item appear in the right panel.

Field/Control Name Description

Type Enables the user to configure the type.

Value Enables the user to configure the value.
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5. Once you have selected the Field, you can specify whether your search should 
contain or start with specific alphabets.

6. Enter the search criteria in Value.

7. Click Filter to apply the selected criteria. This displays the search results under 
Total Number of Rows.

8. Select the Type from the drop-down list.

9. Enter the Value for the justification.

10. Click Save to save the changes made for this section.

Configuring Electronic Transmission
This screen enables you to configure electronic transmission recipient information.

■ Details of electronic transmission recipient such as name, title, address etc. are 
submitted here.

■ Select Code Lists--> Argus to view the Code List page.

***********************************************************************************************

Tip: You can alternatively click Add New to create a new 
justification.

■ Use Copy to make an editable copy of an existing justification.

■ Use Delete to delete an existing justification.

Tip: The code list items are displayed in the left-panel. Click on the 
required Code List folder to be configured. The details of this code list 
item appear in the right panel.
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Field Descriptions
The following table lists and describes the fields associated with this section.

Use the following procedure to configure the electronic transmission recipient.

1. Click on the Electronic Transmission Recipient folder in the left panel. The 
associated data appears in the Total Number of Rows section in the right panel.

2. Click on the Name Title (or row), to view the details associated with that 
electronic transmission. The details appear in the Modify Electronic Transmission 
Recipient section.

3. You may use the Electronic Transmission RecipientFilter to make your search 
specific to an electronic transmission recipient. The filtering criterion is essential as 
it helps you to search for specific items

4. Select the appropriate Field as the filtering criteria from the drop-down list.

5. Once you have selected the Field, you can specify whether your search should 
contain or start with specific alphabets.

6. Enter the search criteria in Value.

7. Click Filter to apply the selected criteria. This displays the search results under 
Total Number of Rows.

Field/Control Name Description

Name Enables the user to enter the name of Electronic Transmission 
Recipient.

Title Enables the user to enter the title of Electronic Transmission 
Recipient.

Address Enables the user to enter the address of Electronic Transmission 
Recipient.

City Enables the user to enter the city of Electronic Transmission 
Recipient.

State/Province Enables the user to enter the state/province of Electronic 
Transmission Recipient.

Country Enables the user to select the country of the user.

Postal Code Enables the user to enter the postal code of Electronic Transmission 
Recipient.

Phone Enables the user to enter the phone number of Electronic 
Transmission Recipient.

Fax Enables the user to enter the fax of Electronic Transmission 
Recipient.

Email Enables the user to enter the email of Electronic Transmission 
Recipient.

Preferred Method Enables the user to select the preferred method of transmission 
from the drop-down list. This can be by fax or by email.

Tip: Tip : You can alternatively click Add New to create a new 
electronic transmission recipient.

■ Use Copy to make an editable copy of an existing electronic 
transmission recipient.

■ Use Delete to delete an existing electronic transmission recipient.
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8. Enter the Name of the electronic transmission recipient.

9. Enter the Title of the electronic transmission recipient.

10. Enter the Address of the electronic transmission recipient.

11. Enter the City of the electronic transmission recipient.

12. Enter the State/Province of the electronic transmission recipient.

13. Select the Country of the electronic transmission recipient, from the drop-down 
list.

14. Enter the Postal Code of the electronic transmission recipient.

15. Enter the Phone of the electronic transmission recipient.

16. Enter the Fax of the electronic transmission recipient.

17. Enter the Email of the electronic transmission recipient.

18. Select the Preferred Method of communication (by fax or email) for the electronic 
transmission recipient.

19. Click Save to save the changes made to this section.

Configuring Literary Citations
This screen enables you to configure information about Literary Citations.

■ The information configured in this form is displayed in the Literature Info section 
of the Case Form.

■ Select Code Lists --> Argus to view the Code List Maintenance screen.

***********************************************************************************************
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Field Descriptions
The following table lists and describes the fields associated with this section.

Use the following procedure to configure literary citations.

1. Click on the Literary Citations folder in the left panel. The associated data appears 
in the Total Number of Rows section in the right panel.

2. Click Journal/Author (or row) to view the details associated with the literary 
citation. The details appear in the Modify Literature section.

3. You may use the Literary Citation Filter to make your search specific to a citation. 
The filtering criterion is essential as it helps you to search for specific items.

4. Select the appropriate Field as the filtering criteria from the drop-down list.

5. Once you have selected the Field, you can specify whether your search should 
contain or start with specific alphabets.

6. Enter the search criteria in Value.

7. Click Filter to apply the selected criteria. This displays the search results under 
Total Number of Rows.

8. Enter the name of the journal in the Journal field.

9. Enter the name of the author of the citation in the Author field.

10. Enter the title of the citation in the Title field.

11. Enter the Volume Number in the Volume field.

12. Enter the year in the Year field.

13. Enter the number of pages in the Pages field.

14. Click Save to save the changes made.

Tip: The code list items are displayed in the left-panel. Click on the 
required Code List folder to be configured. The details of this code list 
item appear in the right panel.

Field/Control Name Description

Journal Displays the name of the journal where the citation appears. This is a 
required field.

Author Displays the name of the author.

Title Displays the title of the citation.

Volume Displays the volume number of the journal where the citation appears.

Year Displays the publication year of the journal where the citation appears.

Pages Displays the number of pages in the journal where the citation appears.

Tip: You can alternatively click Add New to create a new citation.

■ Click Copy to make an editable copy of an existing citation.

■ Click Delete to delete a selected citation.

■ Click Print to print the selected information as a PDF.
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Configuring Message Type
This screen enables you to configure information about message type.

■ The message type specified in this section enables you to specify auto-submission 
of reports.

■ Select Code Lists --> Argus to view the Code List Maintenance screen.

***********************************************************************************************

Field Descriptions
The following table lists and describes the fields associated with this section.

Tip: The code list items are displayed in the left-panel. Click on the 
required Code List folder to be configured. The details of this code list 
item appear in the right panel.

Field/Control Name Description

Message Type Displays the message type for a report.

English ICSR Displays if the message type belongs to English ICSR.

Expedited/Periodic Displays if the message type is expedited or periodic.

Note: By default, ICHICSR is considered as Expedited, while the other 
message types are considered as Periodic.

Description Displays a description about the message type.

Auto Submit Displays if the report has been auto submitted.

Japan ICSR Displays if the report belongs to Japan ICSR.

Display Displays if the report needs to be displayed or hidden.
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Use the following procedure to configure message type.

1. Click on the Message Type folder in the left panel. The associated data appears in 
the Total Number of Rows section in the right panel.

2. Click Message Type (or row) to view the details associated with the message type. 
The details appear in the Modify Message Type section.

3. You may use the Message Type Filter to make your search specific to a message 
type. The filtering criterion is essential as it helps you to search for specific items.

4. Select the appropriate Field as the filtering criteria from the drop-down list.

5. Once you have selected the Field, you can specify whether your search should 
contain or start with specific alphabets.

6. Enter the search criteria in Value.

7. Click Filter to apply the selected criteria. This displays the search results under 
Total Number of Rows.

8. Enter the type of message in the Message Type field.

9. Enter the description for the message type in the Description field.

10. Select the English ICSR or Japan ICSR radio button, as applicable.

11. Click the Expedited checkbox if the message type is for an expedited report.

12. Click the Mark as Auto Submit checkbox if you wish to mark for auto submission.

13. Click the Display checkbox if you wish to display the message type.

14. Click Save to save the changes made.

Configuring Reporting Destination
Regulatory reports are submitted to the Reporting Destination. Local company contact 
information is also provided on this screen.

The system enables the user to configure the XML Source Classification and the PDF 
Source Classifications used for classifications defined while the Source E2B File / PDF 
for Initial Intake or E2B Differences report is classified.

Tip: You can alternatively click Add New to create a new message 
type.

■ Click Copy to make an editable copy of an existing message type.

■ Click Delete to delete a selected message type.

■ Click Print to print the selected information as a PDF.
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***********************************************************************************************

Be aware of the following

■ During upgrade the system automatically populates the Selection source 
classification as &rdquor;E2B Differences Report" from existing classifications and 
the XML Source Classifications are empty

■ The system tracks updates made in the Audit Log

■ The system prints the additional fields on the Printout as shown in the following 
illustration.

***********************************************************************************************

When a case is accepted as an initial or follow-up case, the system attaches the source 
XML and the Initial Selection PDF to the case on the Additional Info tab with the as 
follows.

Initial/Follow-up Source XML
Attachment Classification: As specified in the Reporting Destination for XML Source 
Classification.

Date: System Date when the user accepted the case for XML.

Description: Acceptance Notes the user entered for XML.
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***********************************************************************************************

When you click the Source ICSR, the system you can view the ICSR opening the ICSR 
Viewer (E2B Viewer) as configured for the ICSR Viewer. The following is an 
illustration of the icon that identifies the XML Attachment.

Initial Selection PDF
Attachment Classification: As specified in the Reporting Destination for Selection 
Source Classification

Date: The system date the user accepted the Case for XML

Description: Acceptance Notes the user entered r for XML

***********************************************************************************************

Follow-up Source XML
On clicking the Source ICSR PDF or the E2B Difference Report, the system enables the 
user to view the Initial Selection PDF or the E2B Difference Report in a different IE 
dialog.



Configuring Code Lists

Code List Configuration 5-19

***********************************************************************************************

Be aware of the following:

■ Once the Case is accepted as an Initial or a Follow-up ICSR, the system prefixes 
the Business Level Acknowledgement Notes with the Case Number in the 
following format:

– Notes Imported Case #: XXXXX followed by the current Notes which are sent 
in the Business Level Acknowledgement

■ If the ICSR is received via the Physical Gateway (Configured at the reporting 
destination level) the system sends out a low level ACK in the following format to 
indicate that the file was received by the Interchange Services at Argus.

■ For the Auto Accepted ICSR's, the system does not attach the Source PDF within 
the case since the Source XML is attached as is with the case.

Name Description

M.1 
ICHICSRMESSAGE
HEADER

Type: Entity

Source Format: None

E2B Element Format: None

Notes: This is an entity name that appears as first line of each E2B 
acknowledgment.

M.1.1 
MESSAGETYPE

Type: Data element

Source Format: None

E2B Element Format: Alphanumeric (16)

Notes: The message type contains the value ARGUSINTERACK
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M.1.2 
MESSAGEFORMAT
VERSION

Type: Data element

Source Format: Character(5)

E2B Element Format: Alphanumeric (3)

Notes: The message format version is the DTD version of the 
acknowledgment and contains the value 1.1"

M.1.3 
MESSAGEFORMAT
RELEASE

Type: Data element

Source Format: Character(5)

E2B Element Format: Alphanumeric (3)

Notes: The message format release is the release version of the 
acknowledgment DTD and contains the value 1.0"

M.1.4 
MESSAGENUMBER

Type: Data element

Source: Sequence from the table where the acknowledgment 
information stored that way this value will be always unique Source 
Format: Number

E2B Element Format: Alphanumeric (100)

Notes: The message number is a unique identifier for the 
acknowledgment message assigned by the sender of the 
acknowledgment. Each acknowledgment has a unique message 
number automatically created by ESM.

M.1.5 
MESSAGESENDERI
DENTIFIER

Type: Data element

Source: Element M.1.6 of the ICH ICSR message header, i.e. receiver 
of the ICSR reports.

Source Format: Alphanumeric (60)

E2B Element Format: Alphanumeric (60)

Notes: This field identifies the sender of the E2B acknowledgment. In 
other words, this field contains the receiver of the E2B message (ICSR 
report) i.e. value from M.1.6 of the E2B Message.

M.1.6 
MESSAGERECEIVE
RIDENTIFIER

Type: Data element

Source: Element M.1.5 of the ICH ICSR message header, i.e. sender of 
the ICSR reports.

Source Format: Alphanumeric (60)

E2B Element Format: Alphanumeric (60)

Notes: This field identifies the receiver of the E2B acknowledgment. 
In other words, this field contains the sender of the E2B message 
(ICSR report) i.e. value from M.1.5 of the E2B Message.

M.1.7a 
MESSAGEDATEFOR
MAT

Type: Data element

Source: Hard code to 204"

Source Format: None

E2B Element Format: Number (3)

Notes: The value is hardcoded to 204" and 204 means format 
CCYYMMDDHHMMSS. Where C = Century, Y = Year, M= Month, 
D= Day, H= Hour and S= Second.

Name Description
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M.1.7b 
MESSAGEDATE

Type: Data element

Source: sysdate (Database date)

Source Format: Date

E2B Element Format: Number (14)

Notes: This data element contains the system date (database date in 
GMT) on the day the acknowledgment was initiated.

A.1 
MESSAGEACKNOW
LEDGMENT

Type: Entity

Source Format: None

E2B Element Format: None

Notes: This is an entity name that appears as first line of each E2B 
acknowledgment.

A.1.1 
ICSRMESSAGENUM
B

Type: Data element

Source: Element M.1.4 of the ICH ICSR message header, i.e. message 
tracking number of the ICSR message.

Source Format: Alpha Numeric (100)

E2B Element Format: Alpha Numeric (100)

Notes: This field identifies the unique tracking number assign to a 
specific ICH ICSR message file. The sender of the E2B message 
assigns this number.

Transmit: When system generates the acknowledgment for the 
received E2B message. The system assigns the value to this element 
from M.1.4 of the received E2B message.

Receive: This element is used to find the E2B message in the system.

A.1.2 
LOCALMESSAGEN
UMB

Type: Data element

Source Format: None

E2B Element Format: Alpha Numeric (100)

Notes: This field identifies the unique number assign to a specific ICH 
ICSR message file by the receiving organization of the ICH ICSR 
message. Example if Pharma company transmitting an E2B message 
to regulatory authority. The regulatory authority assigns a unique 
message number to E2B message. This number is used for this 
element in building the acknowledgment.

A.1.3 
ICSRMESSAGESEN
DERIDENTIFIER

Type: Data element

Source: Element M.1.5 of the ICH ICSR message header, i.e. sender of 
the ICH ICSR message.

Source Format: Alpha Numeric (60)

E2B Element Format: Alpha Numeric (60)

Notes: This field identifies the sender of the ICH ICSR message file.

A.1.4 
ICSRMESSAGERECE
IVERIDENTIFIER

Type: Data element

Source: Element M.1.6 of the ICHICSR message header, i.e. receiver of 
the ICH ICSR message.

Source Format: None

E2B Element Format: Alpha Numeric (60)

Notes: This field identifies the receiver of the ICH ICSR message file.

Name Description
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Use the following procedure to configure reporting destination.

1. Select Code Lists --> Argus to view the Code List Maintenance screen.

2. Select Reporting Destination. The screen appears as shown.

A.1.5a 
ICSRMESSAGEDAT
EFORMAT

Type: Data element

Source: Hard code to 204"

Source Format: None

E2B Element Format: Number (3)

Notes: The value is hardcode to 204" and 204 means format 
CCYYMMDDHHMMSS. Where C = Century, Y = Year, M= Month, 
D= Day, H= Hour and S= Second.

A.1.5b 
ICSRMESSAGEDAT
E

Type: Data element

Source: sysdate (Database date) Element M.1.7b message date of the 
E2B message was initiated

Source Format: Date

E2B Element Format: Number (14)

Notes: This data element contain the system date (database date) on 
the day the E2B message was initiated. The value can be assign from 
M.1.7b message date of the E2B message was initiated.

A.1.6 
TRANSMISSIONAC
KNOWLEDGMENT
CODE

Type: Data element

Source Format: Number

E2B Element Format: Number (2)

Notes: This data element is used to inform the sender about the status 
of each report. The value of this element can be 01,02,03. If all reports 
successfully loaded without any error then value of this element is 01. 
If some reports are loaded and some has the errors then the value of 
this element is 02. If none report is loaded due to the SGML parsing 
error, then the value of this element is 03.

A.1.7 
PARSINGERRORME
SSAGE

Type: Data element

Source Format: None

E2B Element Format: Alphanumeric (250)

Notes: If the above element A.1.6 (transmission acknowledgment 
code) has value 03 then only this element contains the value. The 
value of this element is the description of SGML parsing

■ This file is placed in the Physical Out folders as configured for 
the reporting destination within the E2B Mapping configuration.

■ For EDI received files, the system continues to let the EDI 
Gateway send the Low level ACK as current functionality.

■ The Low Level ACK received in the Physical In folder for the 
destination does not  process by the Interchange Service but  
enters any errors in the Log file as the file will always be rejected 
by the ESM Service.

Tip:  The code list items are displayed in the left-panel. Click on the 
required Code List folder to be configured. The details of this code list 
item appear in the right panel.

Name Description
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***********************************************************************************************

Agency Information
The Agency Information tab is displayed by default, on selecting Reporting 
Destination.

Field Descriptions
The fields under the Agency Information tab are described in the following table:

Field/Control Name Description

Agency Name Displays the name of the agency. This is a required field.

Agency Type Enables the user to select the agency type.

Department Enables the user to enter the name of the department.

Email Address Enables the user to enter the email address of the agency.

Preferred Method Enables the user to select the preferred method of agency 
information.

Registration # Enables the user to enter the registration number.

FAX Enables the user to enter the FAX Number.

FAX Cover Enables the user to enter the FAX Cover.

Contact Type ■ Manufacturer - Enables the user to select manufacturer as the 
type of contact

■ Importer - Enables the user to select importer as the type of 
contact

■ Distributor - Enables the user to select distributor as the type of 
contact

Offline Recipient Enables the user to configure the regulatory agency as an offline 
agency.
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Use the following procedure to configure agency information.

1. Select the Agency Name (or row) of the reporting destination displayed under 
Total Number of Rows that needs to be modified. The Modify section displays 
the information about the selected code list.

2. You may use the Reporting Destination Filter to make your search specific to an 
agency. The filtering criterion is essential as it helps you to search for specific 
items.

3. Select the appropriate Field as the filtering criteria from the drop-down list.

Title Enables the user to enter the title of the regulatory contact.

First Name Enables the user to enter the first name of the regulatory contact.

Middle Enables the user to enter the middle name of the regulatory contact.

Last Enables the user to enter the last name of the regulatory contact.

Address Enables the user to enter the address of the regulatory contact.

Phone Enables the user to enter the phone number of the regulatory contact.

Ext Enables the user to enter the extension number of the regulatory 
contact.

Country Code Enables the user to enter the country code of the regulatory contact.

FAX Enables the user to enter the fax number of the regulatory contact.

Ext Enables the user to enter the extension number of the regulatory 
contact.

Country Code Enables the user to enter the country code of the regulatory contact.

City Enables the user to enter the city of the regulatory contact.

State/Province Enables the user to enter the state/province of the regulatory contact.

Country Enables the user to enter the country of the regulatory contact.

Postal Code Enables the user to enter the postal code of the regulatory contact.

Report per Email Enables the user to enter the number of reports to be received in each 
email.

Attachments Enables the user to select the format of attachments.

Email Text Body ■ Select - Enables the user to select a .txt or .rtf file to be uploaded.

Note: The file should be in .txt, or .rtf format.

After the uploaded file is saved, the Edit button displays a clip 
button, denoting an attachment.

■ Edit - Enables the user to open the uploaded file / text in a word 
document from the server and edit the text inside it. If no file 
was uploaded earlier, a blank document is opened.

Note: You can save the edited document on the local machine 
and click Select to save the file.

Report for Marketed Enables the user to select whether reports are to be marketed always 
or only for the Spontaneous cases or no Investigational.

Allow WHO Drug 
reporting

Enables the user to schedule a report for WHO Drug Reporting.

Report for 
Investigational

Enables the user to select if the reports are to be investigational 
always or only for clinical case or no marketed license.

Field/Control Name Description
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4. Once you have selected the Field, you can specify whether your search should 
contain or start with specific alphabets.

5. Enter the search criteria in Value

6. Click Filter to apply the selected criteria. This displays the search results under 
Total Number of Rows.

7. Enter the name of the agency in the Agency Name field.

8. Select the type of agency in the Agency Type field.

9. Enter the department in the Department field.

10. Enter the email address in the Email field.

11. Select the preferred method from the Preferred Method drop-down list. The 
options available are Fax or Email.

12. Enter the registration number in the Registration # field.

13. Enter the Fax Number in the FAX field.

14. Enter the Fax Cover in the FAX Cover field.

15. Select the preferred contact type by clicking the checkboxes available under 
Contact Type.

The options available are Manufacturer, Importer and Distributor.

16. Select the Offline Recipient checkbox to configure the regulatory agency as an 
offline agency.

17. Select the Title of the regulatory contact. The options available are Mr., Miss and 
Mrs.

18. Enter the first name of the regulatory contact under the First Name field.

19. Enter the middle name of the regulatory contact under the Middle field.

20. Enter the last name of the regulatory contact under the Last field.

21. Enter the postal contact address of the regulatory contact under the Address field.

22. Enter the phone number of the regulatory contact under the Phone field.

23. Enter the extension number of the regulatory contact under the Ext field.

24. Enter the country code to be dialed in calling up the regulatory contact under the 
Country Code field.

25. Enter the fax number of the regulatory contact under the FAX field.

26. Enter the fax extension number of the regulatory contact under the Ext field.

27. Enter the country code required in faxing up the regulatory contact under the 
Country Code field.

28. Enter the name of the city where the regulatory contact lives in the City field.

Tip: Tip: You can alternatively click Add New to create a new 
agency information.

■ Click Copy to make an editable copy of an existing agency 
information.

■ Click Delete to delete the selected agency information.

■ Click Print to print the selected information as a PDF.
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29. Enter the name of the state/province where the regulatory contact lives in the 
State/Province field.

30. Enter the name of the country where the regulatory contact lives in the Country 
field.

31. Enter the postal code of the place where the regulatory contact lives in the Postal 
Code field.

32. Enter the number of reports that need to be sent in every email to the regulatory 
contact in the Report per Email field.

33. Select the format of the attachments being sent with the emails through the 
Attachments drop-down list.

The formats available to be sent as attachments are PDF or RTF formats.

34. Click Text or RTF to save and view a letter attachment in text or RTF format.

This enables the user to select the email body in Text or RTF format.

35. Select how the report is to be marketed from the Report to be marketed 
drop-down list.

36. The options in this list are Always or Spontaneous or No Investigational.

37. Select the Allow WHO Drug Reporting checkbox to schedule the report for WHO 
Drug Reporting.

38. Select the type of reports as Investigational always or Only for clinical case or No 
marketed license from the Report for Investigational drop-down list.

39. Click Save to save the changes made.

Local Company Contact
This section lists the Field Descriptions and configuration steps for the Local 
Company Contact tab.

Field Descriptions
The fields the following table lists and describes the fields on the Local Company 
Contact tab.

Field/Control Name Description

Company Name Displays the name of the company. This is a required field

Sender Type Enables the user to select the sender type

Department Enables the user to enter the name of the department

Email Address Enables the user to enter the email address of the agency

Lab Code Enables the user to enter the lab code

Event Term on 
Expedited Reports

Enables the user to select the event term on expedited reports.

Title Enables the user to enter the title of the local company contact

First Name Enables the user to enter the first name of the contact

Middle Enables the user to enter the middle name of the contact

Last Enables the user to enter the last name of the contact

Address Enables the user to enter the address of the contact
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Use the following procedure to configure the local company contact.

1. Select the Agency Name (or row) of the reporting destination displayed under 
Total Number of Rows that needs to be modified. The Modify section is 
populated with information about the selected code list.

2. You can use the Reporting Destination Filter to make your search specific to a 
company. The filtering criterion is essential as it helps you to search for specific 
items.

3. Select the appropriate Field as the filtering criteria from the drop-down list.

4. Once you have selected the Field, you can specify whether your search should 
contain or start with specific alphabets.

5. Enter the search criteria in Value

6. Click Filter to apply the selected criteria. This displays the search results under 
Total Number of Rows.

7. Enter the name of the company in the Company Name field.

8. Select the type of sender in the Sender Type drop-down list.

9. Enter the name of the department under the Department field.

10. Enter the email address of the agency under the Email Address field.

11. Enter the lab code of the agency under the Lab Code field.

12. Select the type of event term on preferred reports from the Event Term on 
Preferred Reports drop-down list. The options available under this list are 
Preferred and Lower Level.

13. Select the Title of the regulatory contact. The options available are Mr., Miss and 
Mrs.

Phone Enables the user to enter the phone number of the contact

Ext Enables the user to enter the extension number of the contact

Country Code Enables the user to enter the country code of the contact

FAX Enables the user to enter the fax number of the contact

Ext Enables the user to enter the fax extension number of the contact

Country Code Enables the user to enter the fax country code of the contact

City Enables the user to enter the city of the contact

State/Province Enables the user to enter the state/province of the contact

Country Enables the user to enter the country of the contact

Postal Code Enables the user to enter the postal code of the contact

Tip: You can alternatively click Add New to create a new company 
contact.

■ Click Copy to make an editable copy of an existing company 
contact.

■ Click Delete to delete a selected company contact.

■ Click Print to print the selected information as a PDF.

Field/Control Name Description
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14. Enter the first name of the regulatory contact under the First Name field.

15. Enter the middle name of the regulatory contact under the Middle field.

16. Enter the last name of the regulatory contact under the Last field.

17. Enter the postal contact address of the regulatory contact under the Address field.

18. Enter the phone number of the regulatory contact under the Phone field.

19. Enter the extension number of the regulatory contact under the Ext field.

20. Enter the country code to be dialed in calling up the regulatory contact under the 
Country Code field.

21. Enter the fax number of the regulatory contact under the FAX field.

22. Enter the fax extension number of the regulatory contact under the Ext field.

23. Enter the country code required in faxing up the regulatory contact under the 
Country Code field.

24. Enter the name of the city where the regulatory contact lives in the City field.

25. Enter the name of the state/province where the regulatory contact lives in the 
State/Province field.

26. Enter the name of the country where the regulatory contact lives in the Country 
field.

27. Enter the postal code of the place where the regulatory contact lives in the Postal 
Code field.

28. Click Save to save the changes made.

Configuring EDI
This section lists the field descriptions and configuration steps for the EDI tab.
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***********************************************************************************************

Field Descriptions
The following table lists and describes the fields on the EDI tab.

Field/Control Name Description

SGML/XML Enables the user to select whether to send the report in SGML of XML 
format.

Mark as Auto Submit Enables the user to mark the report for auto submission.

Imported Cases are 
assigned to

Enables the user to select the country, where the imported cases need to 
be assigned.

Note: This list comprises the configured Argus sites. The default value 
is the site of the importing user.

Initial Workflow 
State

Enables the user to configure the initial workflow state of the case.

Note: This list comprises Argus workflow states, with the default value 
being blank. If you select blank as the workflow state, it is treated as a 
new case being booked-in.

Agency Identifier Enables the user to enter the routing ID configured in Cyclone for the 
sender community.

Identification Code Enables the user to enter the agency Duns code, a unique identification 
code that identifies the trading partner.

Code Qualifier Enables the user to enter the code qualifier here. The code qualifier is 
used to interpret the identification code.

Message Profile Enables the user to select a message profile.

ACK Profile Enables the user to select the acknowledgement profile.

Identification Code Enables the user to enter the company Duns code, a unique 
identification code that identifies the trading partner.

Company Identifier Enables the user to enter the company identifier

Code Qualifier Enables the user to enter the code qualifier here. The code qualifier is 
used to interpret the identification code.

File Name Enables the user to enter the file name

SGML Declaration 
File

Enables the user to enter the SGML Declaration File.

Maximum # of 
reports to include in 
the msg

Enables the user to enter the maximum number of reports that will be 
transmitted in one message.

Method Enables the user to select a method here. This field contains E2B ESTRI 
Gateway and E2b Media values.

EDI Header Enables the user to generate the EDI Header

XML Version Enables the user to enter the XML Version.

URL of Message DTD Enables the user to enter the path where the message DTD resides on 
the internet or enter full path if it is located on the disk.

Encoding Enables the user to select the character set encoding used in XML

URL of ACK DTD Enables the user to enter the path where the ACK DTD resides on the 
internet or enter the full path if it is located on the disk.

Auto Accept ICSR's Click this checkbox to auto accept ICSR's. This checkbox is visible only 
when case numbering is set to Automatic.
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Use the following procedure to configure EDI.

1. Select the Agency Name (or row) of the reporting destination displayed under 
Total Number of Rows that needs to be modified. The Modify section is 
populated with information about the selected code list.

2. You may use the Reporting Destination Filter to make your search specific to an 
EDI. The filtering criterion is essential as it helps you to search for specific items.

3. Select the appropriate Field as the filtering criteria from the drop-down list.

4. Once you have selected the Field, you can specify whether your search should 
contain or start with specific alphabets.

5. Enter the search criteria in Value

6. Click Filter to apply the selected criteria. This displays the search results under 
Total Number of Rows.

7. Select the format in which the report is to be sent by selecting the SGML and XML 
radio buttons.

8. Click the Mark as Auto Submit checkbox if you wish to mark the report for 
auto-submission.

9. Select the country where the imported cases need to be assigned.

10. Select the initial workflow state of the case.

11. Enter the routing ID configured in Cyclone for the sender community under the 
Agency Identifier field.

12. Enter the Agency Duns code under the Identification Code field.

13. Enter the Code Qualifier under the Code Qualifier field.

14. Select the message profile from the Message Profile drop-down list.

15. Select the acknowledgement profile from the ACK Profile drop-down list.

16. Enter the Agency Duns Code in the Identification Code field.

17. Enter the Company Identifier in the Company Identifier field.

18. Enter the Code Qualifier in the Code Qualifier field.

19. Enter the name of the file in the File Name field.

20. Select the SGML file in the SGML Declaration File drop-down list.

21. Enter the maximum number of reports that need to be included in the message 
under the Maximum # of reports to include in the msg field.

Transmit E2B 
Attachments

Click this checkbox to transmit E2B attachments.

Tip: You can alternatively click Add New to create a new EDI.

■ Click Copy to make an editable copy of an existing EDI.

■ Click Delete to delete a selected EDI.

■ Click Print to print the selected information as a PDF.

Field/Control Name Description
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22. Select the method from the Method drop-down list. This list contains options like 
E2B - Gateway, Physical Media and XML Transmission.

23. Click the EDI Header checkbox to generate an EDI Header.

24. Enter the version of XML in which it is coded in the XML Version field.

25. Enter the path where the message DTD resides on the internet or enter full path if 
it is located on the disk under the URL of Message DTD field.

26. Select the character set encoding used in XML in the Encoding drop-down list.

27. Enter the path where the ACK DTD resides on the internet or enter the full path if 
it is located on the disk in the URL of ACK DTD.

28. Click Auto Accept ICSR's to auto accept ICSR's.

29. Click Transmit E2B Attachments to transmit E2B attachments.

30. Click Save to save the changes made.

SMTP
This section lists the Field Descriptions and configuration steps for the SMTP tab.

***********************************************************************************************

Field Descriptions
The following tables lists and describes the fields on the SMTP tab.

Field/Control Name Description

From Enables the user to enter the email address of the sender.

CC Enables the user to enter the email addresses to send email as CC.

BCC Enables the user to enter the email addresses to send email as BCC.
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Use the following procedure to configure SMTP.

1. Select the Agency Name (or row) of the reporting destination displayed under 
Total Number of Rows that needs to be modified. The Modify section is 
populated with information about the selected code list.

2. You may use the Reporting Destination Filter to make your search specific to an 
SMTP. The filtering criterion is essential as it helps you to search for specific items.

3. Select the appropriate Field as the filtering criteria from the drop-down list.

4. Once you have selected the Field, you can specify whether your search should 
contain or start with specific alphabets.

5. Enter the search criteria in Value

6. Click Filter to apply the selected criteria. This displays the search results under 
Total Number of Rows.

7. Enter the email address of the sender under the From field.

8. Enter the email addresses to send email as CC under the To field.

9. Enter the email addresses to send email as BCC under the BCC field.

10. Click the Delivery Receipt checkbox to receive a delivery receipt.

11. Click the Read Receipt checkbox to receive a read receipt.

12. Click Save to save the changes made.

13. Click Save to save the changes made.

Configuring Routes of Administration
This screen enables you to configure the Route of Administration information. This 
describes the route of drug administered to the patient. This data is reflected in 
Expedited and Periodic regulatory reports.

■ The values entered here and marked under Display appear in the in the Route of 
Administration list on the Products tab.

■ Select Code Lists --> Argus to view the Code List Maintenance screen.

Delivery Receipt Enables the user to check this box to receive a delivery receipt.

Read Receipt Enables the user to check this box to receive a read receipt.

Tip: You can alternatively click Add New to create a new SMTP.

■ Click Copy to make an editable copy of an existing SMTP.

■ Click Delete to delete a selected SMTP.

■ Click Print to print the selected information as a PDF.

Field/Control Name Description
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***********************************************************************************************

Click on the Routes of Administration folder in the left panel. The associated data 
appears in the Total Number of Rows section in the right panel.

Field Descriptions
The following table describes the fields associated with this section.

Use the following procedure to configure routes of administration.

1. Click the Administration Route (or row) to view the details associated with the 
administration route. The details appear in the Modify Administration Route 
section.

Tip: The code list items are displayed in the left-panel. Click on the 
required Code List folder to be configured. The details of this code list 
item appear in the right panel.

Field/Control Name Description

Administration 
Route

Displays the administration route information. This is a required field.

Short Name Displays the short name of the administrator route.

Description Displays a description of the administrator route.

E2B Code Displays the E2B Code of the administrator route.

Display Enables the user to display the record in the Administrator Route in the 
Products screen.
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2. You may use the Routes of Administration Filter to make your search specific to a 
route. The filtering criterion is essential as it helps you to search for specific items.

3. Select the appropriate Field as the filtering criteria from the drop-down list.

4. Once you have selected the Field, you can specify whether your search should 
contain or start with specific alphabets.

5. Enter the search criteria in Value

6. Click Filter to apply the selected criteria. This displays the search results under 
Total Number of Rows.

7. Enter information about the administrator route in the Enter Administrator Route 
field.

8. Enter a short name about the administrator route in the Short Name field.

9. Enter the E2B Code of the administrator route in the E2B field.

10. Select the Display checkbox to display the record in the Administrator Route in 
the Products screen.

11. Enter the description about the administrator route in the Enter Description field.

12. Click Save to save the changes made.

Configuring Study Center
This screen enables you to configure the Study Center information. This screen is used 
to enter information regarding each Study Center. The Study Centers defined in this 
dialog appear on a drop-down list in the Clinical Studies Information dialog under 
the Centers tab in List Maintenance. You can create a Study Center with the same 
Center ID but with a different name and address. When you select the studies in the 
Study Look and Center Lookup in the Console, the system concatenates the Center 
Name (Center ID) in the look-up dialog.

■ Investigators for each Center can also be added via this dialog.

■ Select Code Lists --> Argus to view the Code List Maintenance screen.

■ Click on the Study Center folder in the left panel. The associated data appears in 
the Total Number of Rows section in the right panel.

Tip: Tip: You can alternatively click Add New to create a new route.

■ Click Copy to make an editable copy of an existing route.

■ Click Delete to delete a selected route.

■ Click Print to print the selected information as a PDF.



Configuring Code Lists

Code List Configuration 5-35

***********************************************************************************************

Field Descriptions
The following table lists and describes the fields associated with this section.

Use the following procedure to configure study center.

1. Click the Center ID (or row) to view the details associated with the administration 
route. The details appear in the Modify StudyCenter section.

2. You may use the Study Center Filter to make your search specific to a center. The 
filtering criterion is essential as it helps you to search for specific items.

Tip: The code list items are displayed in the left-panel. Click on the 
required Code List folder to be configured. The details of this code list 
item appear in the right panel.

Field/Control Name Description

Center ID Enables the user to enter the Center ID.

Name Enables the user to enter the name of the center.

Address Enables the user to enter the address of the center.

Copy from Reporters Enables the user to copy the information from Reporters.

# Displays the row count of the number of investigators.

Investigator Enables the user to enter the name of the investigator.

Phone Enables the user to enter the phone number of the investigator.

Fax Enables the user to enter the fax number of the investigator.

Notes Enables the user to enter comments or remarks.
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3. Select the appropriate Field as the filtering criteria from the drop-down list.

4. Once you have selected the Field, you can specify whether your search should 
contain or start with specific alphabets.

5. Enter the search criteria in Value

6. Click Filter to apply the selected criteria. This displays the search results under 
Total Number of Rows.

7. Enter the ID of the center in the Center ID field.

8. Enter the name of the center in the Name field.

9. Enter the address of the center in the Address field.

10. Select the Copy from Reporters checkbox to copy the information from Reporters.

11. Enter the name of the investigator in the Investigators field.

12. Enter the phone number of the investigator in the Phone field.

13. Enter the fax number of the investigator in the Fax field.

14. Enter comments, if any, under the Notes field.

15. Click Save.

Other Code List Items
The following table lists and describes addition code list items that you should be 
aware of.

Tip: You can alternatively click Add New to create a new center.

■ Click Copy to make an editable copy of an existing center.

■ Click Delete to delete a selected center.

■ Click Print to print the selected information as a PDF.

Tip: Tip: Click Add to add a new investigator. Click Delete to delete 
a selected investigator record.

Code List Item Description

Accidentl Exposure Enables you to capture Accidental Exposure information. 
Accidental Exposure is in the Dosage regimen section of the 
Products tab as a drop-down.

Action Taken Enables you to capture Action Taken information. Action Taken 
information is required when  capture information about steps 
taken when a an adversee drug eevent occurs.  The values you 
enter in this field are read-only and appear in the Dosage Regimen 
section on the Action Take drop-down on the Case Form Product 
tab.

Action Type Enables you to capture Action Type information that describes the 
action type required for the case. Values entered in this field are 
read-only and appear in the Code/Description list of the Activities 
tab. 

Select Code List Maintenance-->Cde List-Argus and click Action 
Type in the browser tree.
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Age Group Enables you to capture Age Group information. An Age Group is 
the range of lower and upper age limits. Patients are categorized in 
diferent age groups. This data appears in Expedited and Periodic 
regulatory rpoerts. The values you enter in this field appear on the 
Patient Information Screen, Age Group drop-down list.

Age Unit Enables you to capre Age Unit information. An Age Unit 
isexpresses time in periods su as year, month, day, hours, and so 
forth. This dta appears in the Expedited and Periodic regulatory 
reports and in the Age Unit drop-down list on the Patient 
Information screen.

Anatomical Location Enables you to capture information about the location where 
vaccination aregiven. This data appears in the epedited and 
periodic regulatory reports. The values you enter in these fields 
appear on the Anatomical Location drop-down list on the Vaccine 
screen.

Attachment 
Classifications

Enables you to capture attachment classification used to describe 
attachment types. The values you enter in these fields appear in the 
Attahment Classification section on the Additional Information 
screen.

Attachment 
Keywords

Enables you to capture information about  the attachment 
keywords used to define an attachment type. The values appear in 
the Attachment Keywords section on the Additional Informtion 
screen.

Birth Type Enables you to capture birth type information when capturing 
pregnancy information. This data appears in multiple regulatory 
reports and appear in the Birth Type drop-down list on the 
Pregnancy information screen.

Case Classifications Enables you to capture Case Classification to help categorizee cases. 
This information does not  impact any report or screen but is used 
during case searches to narrow the results set. These values appear 
on the 

Causality Category Enables you to capture information about the causality type. This 
data appears in expedited and periodic regulatory reports amd on 
the Event Causality drop-down list in the Eve Assessment section 
on the Event screen.

Clinical Reference 
Type

Enables you to capture information about the clinical refernce type. 
The Clinical Reference Type appears as a drop-down list in the 
Study configuration

Condition Type Enables you to capture information about the condition of the 
patient. Categories for condition types are Medical history relevant 
to AE, historical condition, and current condition. This data appears 
in expedited and periodic regulatory reports and in the Condition 
Type drop-down list on the Other Relevant History screen.

Contact Type Enables you to capture information about the type of contact (e.g., 
Follow-up, Investigator). The values appear in the Contact Type 
drop-down list in the Contact Log section of the Activity Tab.

Code List Item Description
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Countries Enables you to capture information about the country where the 
adverse event occurred. If you enter A2, A3, or the numeric country 
code, the system automatically populates the Country field with the 
name of the country. Obtain the country name and country codes 
from the ISO 3166 country code specification.

You may receive the following error messages:

■ "A duplicate country name already exists! "  -- The country 
name you entered already exists in the system.

■ "A duplicate A2 code already exists!" -- The A2 code you 
entered already exists in the system.

■ "A duplicate A3 code already exists!" -- The A3 code you 
entered already exists in the system.

■ "A duplicate country number exists!" -- The country number 
you entered already exists in the system.

■ "Please enter a valid code (A2)." -- The two-character code is 
not specified.

■ "Please enter a valid code (A3)." -- The three-character code is 
not specified..

Date Ranges Enables you to capture date range information as follows:

■ Description -- Enables you to enter a description of the date 
range.

■ Duration -- When selected, enables you to specific a specific 
length of time as opposed to a range of dates. Must be used in 
conjunction with Amount and Units. When you select 
"Duration," the system disables the "Range" radio button.

■ Amount -- The numeric value that specifies the length of the 
time period when combined with a value selected from the 
Units drop-down list (e.g., days, weeks, months, years, etc.)

■ Units -- The unit of the duration (e.g., days, months, years, etc.

■ Range --  Enables you to select a specific range of dates. Must 
be used in conjunction with the Start and End fields. When you 
select "Range," the system disables the "Duration" radio button.

■ Start -- The beginning date of the date range.

■ End -- The ending date of the date range.

Delivery Types Enables you to capture information about the type of delivery that 
occurred during pregnancy. This data appears in expedited and 
periodic regulatory reports and on the Delivery Types drop-down 
list on the Pregnancy Information screen.

Device Preliminary 
Comments

Enables you to capture comments about medical devices. Device 
Preliminary Comments appear on the Product screen when the user 
selects the Device option.

Device 
Subcomponents

Enables you to capture information about subcomponents that are 
part of a medical device. This information appears on the Product 
screen when the user selects the Device option.

Causality Source Enables you to capture Causality Source information. It appears on 
the Case Form Event Assesment tab.The E2B report uses this 
information to determine the drug assessment method.

Device Type Enables you to capture information about patient device types. This 
data appears in expedited and periodic regulatory reports.

Code List Item Description
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Dosage Frequency Enables you to capture information about how often medication is 
given (e.g., daily, bid, weekly, etc.) This information appears on the 
frequency drop-down list on the Products screen.

■ Frequency -- how often the dose is given

■ Number of doses per day -- The number of doses administered 
each day.

■ Number of separate dosage -- Enables the use to define the 
dosage verbatim.

■ Number of units in the interval -- Enables the user to define the 
dosage verbatim.

■ Definition of Interval -- The length of time between doses (i.e., 
year, month, day week (default), hour, minute).

Dosage Unit Enables you to capture dosage units information. This information 
is required when captureing the quantity of drug on sale and also 
appears in expedited and periodic reports.

■ Unit Name -- The name of the dosage unit.

■ E2B Code -- The E2B code associated with the Dosage Unit.

■ Dosage Unit -- When checked, indicates that the current item is 
the dosage unit.

■ Lab Test Unit -- When checked, indicates that this is a lab test 
unit.

■ Display -- When checked, indicates that the Unit Name 
displays in the application.

Ethnicity Enables you to capture information about the ethnic groups 
patients belong to. This information appears in periodic regulartory 
reports and on the Ethnicity drop-down list on the Patient 
Information screen.

Evaluation Reason Enables you to capture information about the reason the product is 
being evaluation. This information appears in the Evaluation 
Reason list on the case form Product tab.

Event Frequency Enables you capture information about the frequency of the event. 
It includes categories such as intermittent, continuous, and single 
episodel The values enter in this field appear in the Event 
Frequency drop-down list on the Event Information screen.

Event Intensity Enables you to capture information about the intensity of the 
adverse event and includes categories such as mild, moderate, and 
severe. The values you enter on this screen appear on the Event 
Intensity drop-down list on the Event Information screen

Event Outcome Enables  you to capture event outcome informatioin such as Fatal, 
Abortion due to AE/Infection, and Recovered. This data appears in 
expedited and periodic regulatory reports and on the Event 
Outcome drop-down list on the Event Informationi screen.

Fetal Outcome Enables you to capture information about fetal outcome and 
includes informtion such as abnormal development or perinatal 
complications. This data appears in expedited and periodic 
regulatory reports and values entered here appear on the Fetal 
Outcomes drop-down list on the Pregnancy Information screen.

Formulation Enables you to capture information about the formulations (cream, 
drop, capsule, etc) available for a product. The values you enter 
appear on the Formulation drop-down list on the Product screen. 

Gender Enables you to capture gender information. This information 
appears in expedited and periodic regulatory reports.

Code List Item Description
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Ingredients Enables you to capture information about the ingredients in the 
product. This includes the ingredient and the concentration and 
units of ingredients used to make the product. This information 
appears in expedited and periodic regulatory reports. 

Intermediary Enables you to capure information about intermediaries such as 
sales rep, licensee, regulatory authority or local affiliate. The values 
you enter appear on the Intermiediary drop-down list on the 
Reporters screen.

Justifications Enables you to capture justification information. You can enter 
reasons for overriding system determinations in the Justifications 
dialog box. The values you enter appear in the Action Justification 
dialog.

Lab Assessment 
Terms

Enables you to capture the lab reuslt assessment terms that define 
the terms that describe the patient’s results on various lab tests 
(e.g., elevated and depressed, etc.). This data is reflected in 
expedited and periodic regulatory reports. The values you enter 
appear on the Lab Result Assessment Terms drop-down list on the 
Laboratory Data screen.

Lab Test Type Enables you to capture the lab test type. This defines test type and 
its normal, high, and low values and can be coded as defined in the 
MedDRA dictionary. The values you enter appear on the Lab Test 
drop-down on thePatient screen.

Literary Citations Enables you to literary citations information.

Local Evaluation 
Comment Type

Enables you to capture the category of a local comment such as 
French, German, English, etc. The values you enter appear in the 
Analysis, Local Comment type.

Manufacturer Enables you to capture information about the product 
manufacturer. Manufacturer is required while captureing, adding, 
or modifying information on manufacturer sites. This data appears 
in expedited and periodic regulatory reports and on the 
Manufacturer drop-down list on the Product Configuration screen.

Medical Status Enables you to capture medical information about patient status. 
This data appears in both the expedited and periodic regulatory 
reports. The values you enter here appear on the Medical Status 
drop-down list,

Message Type Enables you to enter information about each E2B message type. The 
system uses the defined message types when it creates an E2B file.

Nature of Event Enables you to capture information about the type of adverse event 
that occurred.

Occupations Enables you to capture information about patient and reporter 
occupations such as physician, regulatory agent, and journalist. 
This data appears in both expedited and periodic regulatory 
reports. The values you enter are marked as ICH Occupation 
appear in the Reporter’s Occupation drop-down list on the General 
Screen.

Package Units Enables you to capture information about product packaging. The 
package units defines the number of units in a package.

Product Group Enables you to capture information about a specific Product Group. 
Users can use the Product group field to categorize Product 
Families based on  therapeutic area. The values you enter here 
appear in the drop-down list associated with the Project Group 
field of the Product Family.

Code List Item Description
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Formulation Factory Data
The following table  provides information about the Formulation Factory Data.

Project ID Enables you to capture project ID information used to group similar 
studies under a single project. The values you enter in this field 
appear on the Project ID field drop-down on the Study 
Configuration.

Reference Types Enables you to capture reference type information and defines a list 
a reference types such as Parent-Child Link, Patient ID, etc. The 
values you enter appear in the Type drop-down in the References 
section on the Additional Info tab.

Report Media Enables you to capter Report Media information. The values you 
enter appear on a drop-down field in the Reporter Information 
section.

Report Types Enables you to capture information about report types. The report 
type describes the type of report and the abbreviation associated 
with the specific type. This data appears in expedited and periodic 
regulatory reports. The values you enter here appear on the Report 
Type drop-down list on the General Screen.

Reporter Type Enables you to capture information about the  person reporting the 
adverse event and includes categories such as lawyer, nurse, doctor, 
etc. The values you enter here appear on the Treporter Type 
drop-down list on the Product screen.

Reporting 
Destination Type

Enables you to capture information about the reporting destination. 
The values you enter here appear on the Reporting Destination 
configuration.

Routes of 
Administration

Enables you to capture information about how a drug is 
administered to a partient  such as shot, by mouth, etc..

Study Center Enables you to capture information about the study centers. Values 
entered here appear on a drop-down in the Clinical Studies 
Information dialog and on the Centers tab in List Maintenances. Yu 
can also add investigators for each center.

You can carete a study center with the same center ID but with a 
different name and address.

Formulation 
ID Formulation Formulation Name

Formulation 
Symbol

38 Aerosol (Spray and Inhalation) Aerosols AER

13 Alternative Form

23 Cachet (including wafer) Cachet CTS

2 Capsule Capsules CAP

24 Chewable Tablet Chewing Tablest CTB

25 Drop Drops DRO

32 Dusting Powder Dusting Powders DPO

39 Ear Drops Ear Drops EDR

8 Effervescent Tablet

Code List Item Description
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47 Enema Enemas ENM

21 Enteric Table Enteric-coated dosage 
forms

ENT

49 External Use

12 Extra Formulation External Preparations 
of Uncertain Dosage 
Form

EXT

40 Eye Drops Eye Drops EED

41 Eye Ointment Eye Ointments EOI

20 Grain Granules GRA

18 Granule Fine Granules FGR

46 Implantation Inserting Preparations IMP

43 Inhalation Gas Gas Inhalant INS

6 Infusion Infusing Preparations INF

9 Inhaler Inhalants INH

5 Injection Injections INJ

48 Jelly Jellies JEL

11 Liquid External Liquids LIQ

33 Lotion (except lotion for eye) Lotions LOT

28 Lozenge (troche and candy too) Lozenges LOZ

45 Mouthwash Throat Washings MWH

17 N/A

42 Nasal Drops/Spray Nose Drops NDF

34 Ointment/Cream Ointments/Creams OIT

31 Oral Drug Unspecified Form Oral Preparations of 
Uncertain Dosage Form

POR

4 Patch

26 Pill (except tablest) Pills PIL

19 Powder (except DPO) Powders POW

35 Shampoo Shampoos SHP

22 Slow Release Capsules Slow-release Capsules SRC

30 Slo Release Granule Slow-release Granules SRG

29 Slow Release Tablet Slow-release Tablets SRT

27 Solution (except Syrup) Solutions for Oral Use SOL

44 Spin Cap Spin Cap SPC

36 Spray (except Inhalation) Sprays SPR

3 Suppository Rectal Suppositories SUP

7 Syrup Syrups SYR

1 Tablet Tablets TAB

Formulation 
ID Formulation Formulation Name

Formulation 
Symbol
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Literary Citations Code List Item
When configuring the Literary Citations code list item, be aware of the following:

■ You can save a literary citation. If a literary citation with the same name is already 
in the system, the system presents an error message. Otherwise it simply saves the 
Literary Citation information.

■ The main English screen has a J Data Entry button. This button is available only to 
J users. 

■ When you click J Data Entry, the system prompts you to enter the data in required 
fields in the English screen before opening the Japanese Translation window. The 
system opens a dialog box where you can enter Japanese equivalent text for the 
corresponding field as shown in the following illustration.

j_literarycitations.gif

■ If you click  J Data Entry and a litereary citation exists, the system does the 
following:

– Prompts the user to save the data on the English screen before opening the J 
screen with the following message: "Do you want to save the changes before 
opening the Japanese screen?"

– If the user chooses to save the data, the system saves the data and the changes 
reflect on the J screen,

– If the user chooses not to save the data, the changes made on the English scre 
are not reflected on the J screen.

■ If you click JData Entry for a new literary citation, the system does the following:  

– Prompts the user to save the data on the English screen before opening with 
the following message: "Data  must be saved before opening the Japanese 
screen. Do you want to save?"

– If the user chooses to save the data, the system saves the data and the changes 
reflected on the J screen.

– If the user choose not to save the data, the J screen does not open.

■ When using the copy function, be aware of the following:

– When you copy data, the system does not copy the equivalent Japanese data.

– When you copy the data, the system prefixes the data with the words "Copy 
of" in the English UI but not in the Japanese UI.

– If the English Journal name is not unique, and the user clicks Save or J Data 
Entry, the system displays the following message: "A duplicate Journal already 
exists!" to force the user to change the name.

Additional Information about the  Manufacturer Code List Item
When configuring the Manufacturer Code List item, be aware of the following:

37 Tape (including Poultice) Tapes TAP

16 Unknown Uncertain XXX

Formulation 
ID Formulation Formulation Name

Formulation 
Symbol
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■ The screen contains the following note: "Note: Clicking the SAVE button will 
reflect the changes made on this English screen to the Japanese pop-up."

■ The main English screen has a J Data Entry button available only to J users.

■ When you click J Data Entry, the system prompts you to enter the data in required 
fields in the English screen before opening the Japanese Translation window. The 
system opens a dialog box where you can enter Japanese equivalent text for the 
corresponding field as shown in the following illustration.

j_mfg.gif

■ If you click JData Entry for an existing  manufacturer the system does the 
following:  

– Prompts the user to save the data on the English screen before opening with 
the following message: "Do you want to save changes before opening the 
Japanese screen? "

– If the user chooses to save the data, the system saves the data and the changes 
reflected on the J screen.

– If the user choose not to save the data, the J screen does not open.

■ If you click J Data Entry for a new manufacturer, the system does the following:  

– Presents the user with the following message: "Data must be saved before 
opening the Japanese screen. Do you want to save?"

– If the user chooses the save the data, the system saves the data and the 
changes are reflected on the J screen.

– If the user chooses not to save the data, the system will not open the J screen.

■ When using the copy function, be aware of the following:

– When you copy data, the system does not copy the equivalent Japanese data.

– When you copy the data, the system prefixes the data with the words "Copy 
of" in the English UI but not in the Japanese UI.

– If the English Journal name is not unique, and the user clicks Save or J Data 
Entry, the system displays the following message: "A duplicate Journal already 
exists!" to force the user to change the name.

– If the Japanese name is not unique, the system presents the user with the 
following message: "A duplicate name already exists!" This forces the user to 
change the duplicate name in the J data entry field.

Additional Information about the Reporter Information Code List Item
This code list item enables you to capture reporter information.

j_reporterinfo.gif

Information you can capture is described in the following table: 

Field Name Description

Sal Enables you to capture the method of address (for example, Mr., 
Mrs., Dr., etc.)

First Name Enables you to capture the reporter’s first name.

Last Name Enables you to capture the reporter’s last name.
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When configuring the Reporter Information Code List item, be aware of the following:

■ The screen contains the following note: "Note: Clicking the SAVE button will 
reflect the changes made on this English screen to the Japanese pop-up."

■ The main English screen has a J Data Entry button available only to J users.

■ When you click J Data Entry, the system prompts you to enter the data in required 
fields in the English screen before opening the Japanese Translation window. The 
system opens a dialog box where you can enter Japanese equivalent text for the 
corresponding field as shown in the following illustration.

j_reporterinfo.gif

■ You must enter required data before opening the Japanese pop-up. If you fail to do 
so, the system presents the following message: "Enter data in all the mandatory 
fields!"

■ If you click JData Entry for an existing  reporter the system does the following:  

– Prompts the user to save the data on the English screen before opening with 
the following message: "Do you want to save changes before opening the 
Japanese screen? "

Suffix Enables you to capture any suffix to the reporter’s name (for 
example, Sr, Jr, III, etc.)

ID Enables you to capture the unique value that identifies the 
reporter.

Occupation Enables you to capture the reporter’s occupation.

Reporter Type Enables you to capture the reporter’s occupation type.

Health Care 
Professional

Indicates whether the reporter is a healthcare professional

Institution Enables you to capture the reporter’s institution.

Address Enables you to capture the street address for the report.

City Enables you to capture the city for the reporter.

State/Province Enables you to capture the reporter’s state or province.

Preferred Method Enables you to capture information about the reporter’s 
preferred communication method: Fax or e-mail. This field is 
enabled only if "Electronic Transmission Recipient" is checked.

Country The country associated with the reporter.

Postal Code The reporter’s postal code.

Electronic 
Transmission 
Recipient

When checked enables the user to mark this reporter as an 
electronic transmission recipient.

Phone The reporter’s telephone number.

Alt. Phone Enables you to capture an alternate telephone for the reporter.

FAX Enables you to capture the reporter’s fax number.

Email Enables you to capture the reporter’s e-mail address.

Department Enables you to capture the department the reporter is associated 
with.

Field Name Description
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– If the user chooses to save the data, the system saves the data and the changes 
reflected on the J screen.

– If the user choose not to save the data, the J screen does not open.

■ If you click J Data Entry for a new reporter, the system does the following:  

– Presents the user with the following message: "Data must be saved before 
opening the Japanese screen. Do you want to save?"

– If the user chooses the save the data, the system saves the data and the 
changes are reflected on the J screen.

– If the user chooses not to save the data, the system will not open the J screen.

■ When using the copy function, be aware of the following:

– When you copy data, the system does not copy the equivalent Japanese data.

– When you copy the data, the system prefixes the data with the words "Copy 
of" in the English UI but not in the Japanese UI.

– If the English Journal name is not unique, and the user clicks Save or J Data 
Entry, the system displays the following message: "A duplicate Journal already 
exists!" to force the user to change the name.

– If the Japanese name is not unique, the system presents the user with the 
following message: "A duplicate name already exists!" This forces the user to 
change the duplicate name in the J data entry field.

Additional Information about the Reporting Destination Code List Item
Regulatory Reports are submitted to a reporting destination. The code list element 
enables you to capture  information about the reporting destination. A number of 
fields on the screen are unique to Argus J. 

j_reportdestination.gif

The following table lists and describes these fields. 

Field Name Description

Agency Name (J) Enables the user to enter the name of the agency in Japanese.

Company Name (J) Enables the user to enter the name of the company in Japanese.

Message Profile 2 Enables the user to select a message profile to accommodate ESM-J 
reporting.

Use Japanese Aware 
Date for Reporting

Enables the user to specify whether the Japanese Aware Date is ued for 
reporting.  If checked, all automatic caluclation of scheduled due dates 
for scheduled report to the selected authority are based on the japanese 
Aware date rather than the standard aware date.

Allow Multiple 
Reports for Marketed 
Drugs

When checked, the reporting rul schedules a report for each suspected 
marketed drug for the case. 

Allow Multiple 
Reports for 
Investigational Drugs

When checked, the reporting rule schedules a report for each suspected 
investigation drug for the case.
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Study Development Phase Code List Element
This code list element enables you to capture development phase information. Values 
you specify appear on the drop-down list and in te Studies LM section and for E2B. 

j_studydevphase.gif

The following tables lists and describes the available fields.

Event Occurred as Consequence of Code List Element
This code list item enables the capture of information about the circumstances that 
triggered the adverse event. Both the Event Occurred as Consequence of and the Term 
field are required.

j_eventoccured.gif

Method Enables the user to select a transmission method as follows:

■ E2B--EDI Gatewau

■ EwB-Pyhsical Media

■ E2B-XML Transmission

■ E2B-Binary Transmission

Field Name Description

Development Phase Enables the use to enter the Japanese equivalent of the development 
phase information. Development Phase can be one of the following:

■ Phase I

■ Phase II

■ Phase III

■ Biloogical equivalence study

■ Clinical pharmacology study

■ Preparation NDA submission

■ NDA submitted

■ Other

Display Enables the user to select whether to display the item or not.

E2B Code Enables the user to enter the E2B code.

Development Phase J The user can enter the Japanese equivalent of the develop phase 
information in Japanese.

■ Phase I

■ Phase II

■ Phase III

■ Biloogical equivalence study

■ Clinical pharmacology study

■ Preparation NDA submission

■ NDA submitted

■ Other

Field Name Description
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Emperor Code List Element
This code list element enables the user to add and configure various Japanese Emperor 
Data/Era.  

j_emperor.gif

The following table lists and describes the  fields

The following factory data is loaded with the product.

License Category Code List Element
This code list element enables  the user to add and configure various Japanese License 
categories. 

j_licensecategory.gif

License categories include the following:

■ 1 -- Under surveillance immediately after put on market

■ 2 -- Within 2 year of approval

■ 3 -- Not approved

■ 4 -- Under clinical trial for partial change

■ 5 -- Does not apply

The following table lists and describes the fields on the screen.

Field Name Description

Emperor Name (J) Enables the user to enter the names of the Japanese Emperors.

Date in Office Enables the user to enter the dates the Japanese Emperors assumed their 
office. The date format is DD-MON-YYYY.

Display Enables the user to display the record in the Adminsistrator route in the 
Products screen.

Emperor Name Date in Office

Meiji 1/1/1868

Taisho 7/30/1912

Syowa 12/25/1926

Heisei 1/8/1989

Field Name Description

Category (J) Enables the user to enter the PMDA license category in Japanese.

E2B Code Enables the user to enter the E2B value associated with the License 
Category name.

Display Enables the use to display the record in Administrator route in  the 
Products screen.

Category Enables the user to enter the PMDA license category in English.
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Reporting Category Code List Element
This code list item enables the user to enter report category information. 

j_reportingcategory.gif

The following table lists and describes the fields on the screen.

The following factory data is loaded with the product.

Field Name Description

Reporting Category Enables the user to enter the new report categoryl

Description (J) Enables the user to enter a description in Japanese.

Display Enables the user to enter the E2B code for the report.

Description Enables the user to enter a description of the report category in English.

Report Category Description E2B Code

A Domestic/Infection report (marketed drug) 1

B Domestic/ADR report (marketed drug) 2

C Overseas/Infection report (marketed drug) 3

D Overseas/ADR report (marketed drug) 4

E Research/Infection report (marketed drug) 5

F Research/ADR report (marketed drug) 6

G Measures in foreign countries including 
discontinuation of manufacture, recall, and withdrawn 
(marketed drug)

7

H Domestic/Infection report (investigational drug) 8

I Domestic/ADR report (investigational drug) 9

J Overseas/Infection report (investigational drug) 10

K Overseas/ADR report (investigational drug) 11

L Research/Infection report (investigational drug) 12

M Research/ADR report (investigational drug) 13

N Measures in foreign countries including 
discontinuation of manufacture, recall and withdraw

14

O Research report (quasi drug) 15

P Research report (cosmetics) 16
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Accessing Tools
This section explains the report (features and purpose) generated when Tools->E2B 
Length Check is accessed. 

When Argus Code List item length is greater than the E2B field length, the data is 
truncated when maximum length is entered and an E2b report is generated.

Report Features
Each profile is printed on a new page of the same report. The report prints the 
Code-List items length check and the error messages warnings. The report prints all 
terms that are not encoded.

The report contains the following fields as illustrated:

***********************************************************************************************

PV Asset Access
The following changes have been made to PV Asset Access.

■ A New checkbox for PV Asset in "Application Access" is based on the license key 
and, if enabled, is available at the user configuration level.

■ The default is unchecked.
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■ The Default (Application) drop down includes a PV Asset item for the default 
application the system launches as PV Asset.

Viewing the E2B Length Check Report
This section enables you to view the E2B Length Check Report.

Use the following procedure to view the E2B length report.

1. Select Tools->E2B Length Check.

***********************************************************************************************

2. The E2B Length Check PDF report opens in a separate window.

***********************************************************************************************

Tip: This report compares the lengths of the code list elements with 
the maximum E2B length allowed for each of the DTD profiles (ICH, 
FDA, EMEA).

It also displays the elements where the length of the code-list element 
is greater than the allowed E2B length.
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Using Advanced Conditions
This section discusses how to create and use Advanced Conditions. If you not have 
access to the advanced conditions on certain screens, the system displays only the 
Advanced Condition Names you can access (instead of displaying a blank) and does 
not permit you to modify or view the advanced condition details. The system displays 
a warning message stating that you do not have permissions to update the advanced 
conditions. The following screens are affected by this change:

■ Expedited Reporting Rules

■ Auto Signals

■ Batch Reports

■ Letters

■ Studies

■ Case Priority

■ Field Validation

■ Narrative Templates

■ Profile Switches | Auto Archiving

This option is available from the Advanced Conditions icon.

Argus Safety provides a powerful search tool that enables complex queries to be built 
in order to retrieve data from the system. Detailed knowledge of the database schema 
is not required.

Complex or non-standard queries are constructed by means of the Advanced 
Conditions dialog, that enable users to define field level search criteria.

Sets of search criteria (advanced conditions) can be saved and retrieved from the 
Advanced Conditions dialog. These conditions may then be added, edited, or deleted.

Access rights and permissions can be assigned to individual advanced conditions. You 
can execute and modify rights to one or more groups on a per-advanced condition 
basis.
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Features within Advanced Conditions
By default, the Advanced Conditions drop-down list enables you to view only the 
New, None and already selected Advanced Conditions.

1. Select New or None from the drop-down list and click the AC button to create a 
new advanced condition.

2. Click the lookup icon to filter for existing advanced conditions.

3. Execute the steps below to filter for existing Advanced Conditions:

4. Click Lookup in the Case Search Criteria section. The Advanced Conditions 
Lookup dialog is displayed.

***********************************************************************************************

5. Select one of the following options from the drop-down list under Filter.

■ Contains - Enables you to filter for advanced conditions that contain the 
entered criteria.

■ Starts With - Enables you to filter for all advanced conditions that start with 
the entered criteria.

6. Enter the search criteria for the advanced conditions in the text box, as applicable.

7. Click Filter.

The advanced conditions matching the specified filtering criteria are displayed.

8. Select an advanced condition from the list, as per your search requirements.

9. Execute any of the actions below, as applicable:

■ Click OK. The selected advanced condition is listed in the Advanced 
Condition drop-down list.
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■ Click AC. The details of the selected advanced condition are displayed in the 
Advanced Conditions dialog.

■ Click Cancel. The Advanced Condition Lookup dialog is closed without 
saving any changes.

■ Select a previously selected advanced condition from the drop-down list to 
apply the search criteria for that condition.

Using Advanced Conditions
Use the following procedure when using advanced conditions.

1. Click Select lookup to view/edit/create the Advanced Condition in the Advanced 
Condition dialog.

2. To use advanced conditions, the following options are available, depending on 
how the set of criteria is to be used:

■ To use a set of previously saved criteria, select the appropriate set of criteria from 
the Advanced Condition list

■ To add a new condition to a set of criteria, select the set of criteria from the 
Advanced list and click the adjoining Advanced Condition icon.

■ To enable the creation of new advanced conditions by associating logical operators 
(like AND, OR) with items from the Case Form, refer to Creating Advanced 
Conditions.

■ To create an advanced condition query set from existing advanced condition 
search criteria, refer to Creating a Query Set of Advanced Conditions.

Creating Advanced Conditions
Use the following procedure to create advanced conditions.

1. Select New from the Advanced Conditions drop-down list or click the Advanced 
Conditions icon 

2. This displays a confirmation dialog. 

***********************************************************************************************

3. Select whether you wish to create a query set by using previous advanced 
condition query sets or by creating one through logical operators.

■ Click Yes to create a new advanced condition query set.

■ Click No to create a new advanced condition by associating logical operators 
(like AND, OR) with items from the Case Form.

4. If you select No, an Advanced Condition Set dialog is displayed.
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***********************************************************************************************

5. Select a property type from the Properties tree list.

The items available under the folders in the Properties list represent those fields on 
the Case Form that can be used to perform the search in the advanced conditions.

Note: The Advanced Condition Set dialog enables you to search for those 
entities under the Properties tree-list, which are from either the case data or 
from the code list. For this, the dialog provides two radio buttons - From 
Code List and From Case Data.

■ Select the relevant entity and one of the radio buttons, as applicable.

■ This searches the entity based from the code list or case data, as 
specified.

■ The radio buttons are displayed only if the selected entity belongs to a 
code list.

■ If the selected entity is part of the code list, and the user selects:

■ From Code List - If this option is selected, the 
Value drop-down list displays the list of all values 
configured in the Code List.

■ From Case Data - If this option is selected, the 
Value drop-down list displays the list of only 
those values, which are actually present in the 
cases.
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6. In the Conditions list, select a condition that must apply to the item selected 
above.

The available conditions are "equal to", "contains", "less than", "greater than", "not 
equal to", "missing", "greater than or equal to", "less than or equal to", "exists", 
"does not contain" or "begins with".

7. Under Value, enter the value which will apply to the property, or select an 
appropriate value from the list, as applicable.

8. If the condition created in steps 4 through 6 above is to be linked with another 
condition, select the appropriate logical operator in the list adjoining Value.

9. Click Add to add the newly created condition to the advanced condition.

10. Repeat steps 3 through 7 to add more conditions to the advanced condition.

11. When each of the required conditions for the advanced condition is entered, click 
Save.

12. Enter a name for the advanced condition and click OK.

Note: When a Property for which terms can be encoded is selected, the 
Select button is enabled. You can use the MedDRA Browser to select 
(possibly) multiple terms for the property.

An SMQ icon is enabled when the SMQ-related properties are selected 
from the Properties tree-list. Click this icon to view the SMQ Info dialog. 
The SMQ Info dialog contains details about the selected SMQ.

Tip: The logical operators that can be used to link the existing 
condition to a new condition are AND/OR.

Note: To enable other users to use the advanced condition, the Share with 
other users check box should be selected. More about sharing advanced 
conditions

■ If an Advanced Condition is not shared with other users, it does not 
appear in the Advanced Condition list for any user except the 
Administrator and the user that created it.

■ If the Advanced Condition is shared, all users can view the advanced 
condition, but they cannot modify it.

■ Not allowed if the Advanced Condition is in use 
in the system.

■ The console manages access to the Advanced 
Condition Library screen.

■ The Advanced Condition Library option has been 
added to enable or disable (default) access to the 
following screen:

Access Management --> Argus --> Groups> Menus> Utilities (subarea) 
section
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Creating a Query Set of Advanced Conditions
The user can configure the Action Items type to be scheduled based on the Advanced 
Conditions rules as shown in the following.

New Action Type Fields and Field Description

Be aware of the following:

■ The Advanced Conditions, User Group, Letter Placeholder Content, and Due In 
fields are enabled only if Query Action is checked.

■ The system tracks any changes made to the profile switch in the audit log.

■ The Action Type report prints any additional fields.

■ The system has a profile switch to enable the user to generate open queries when 
he/she saves the case.

– No (Default) - When the user clicks No, the system does not generate open 
queries in the case when the user saves the case.

– Yes - When the user clicks Yes, the system generates all action items with a 
query action type based on the advanced conditions defined for the Action 
Taken due in xxx days for User group yyy

where:

xxx is the number of action items defined + the System Date for the defined 
user group

yyy is the user group

– The system tracks changes made to the Profile Switch in the audit log.

Use the following procedure to create a query set of advanced conditions.

1. Select New from the Advanced Conditions drop-down list or click the Advanced 
Conditions icon 

2. A dialog that prompts for the creation of an advanced condition query set opens.

Tip: To enter a customized date range, select Custom Date Range 
from the list. Enter an appropriate date range in the custom date range 
dialog and click OK.

Field/Control Name Description Property

Query Action Defines the Action Item as a Query Action used to 
generate the letter and used as a placeholder.

Checkbox

Advanced 
Conditions

Enables the user to configure an Advanced 
Conditions Rule for creating the Query Type Action 
Item in the case.

User Selectable

User Group Enables the user to define a User group (undeleted 
user groups in Access Management) for the Action 
Item created in the case.

Type Ahead

Letter Placeholder 
Content

Enables the user to enter Letter Text that prints in 
the letter using the Open Query placeholder.

Text (1000 
characters)

Due In (days) When the action item is created on the Case form, 
this option enables the user to define the number of 
days until the Action Item is due..

-
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3. Click Yes to create a set of advanced conditions by linking together those 
advanced conditions that have been defined previously.

4. The Advanced Condition Set dialog opens.

In this dialog, previously-created advanced conditions can be linked together 
using set operators like UNION, MINUS, and INTERSECT.

***********************************************************************************************

5. Click Add to add an advanced condition to the query set. A new row opens in the 
advanced condition selection area. In this row, select an appropriate advanced 
condition from the Advanced Condition list.

6. Select an appropriate set operator from the Set Operator list. This set operator will 
link this advanced condition to the next advanced condition.

7. To add the next advanced condition to the query set, click Add.

8. Repeat steps 5 through 7 for each advanced condition that must be entered in the 
query set.

Tip: To modify, open, or delete advanced conditions, click Open in 
the Advanced Conditions dialog. A list of all the advanced conditions 
will be displayed. In this list, select the appropriate advanced 
condition and click Open to open or modify it, or Delete to delete it.

To view or modify the SQL statement associated with an advanced 
condition, click Show SQL. Make the required modifications to the 
SQL statement, if necessary.
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9. When each of the advanced conditions for the query set is entered, click Save.

10. Enter a name for the advanced condition and click OK.

The Hit List Tab
The Hit List tab in the Advanced Condition Set dialog can be used to search for cases 
that match the query set criteria.

***********************************************************************************************

1. Click Find Now in the Hit List tab of the Advance Conditions dialog.

This runs a search based on the selected query set criteria and displays a list of 
cases (if any) that satisfy the advanced condition query set.

2. Perform these operations to do the following:

Tip: If the required advanced condition is not already present in the 
list, it can be created by selecting (New) from the list.

■ If an existing advanced condition requires modification, select it 
and click Edit.

■ The advanced condition can be edited by a user only if it was 
created by that user.

Tip: Tip: To view or modify the SQL statement associated with an 
advanced condition, click Show SQL. Make the required 
modifications to the SQL statement, if necessary.

To... Click...

Manually add an existing case to the hit 
list

Add and enter the Case ID
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Remove a case from the hit list Remove

Save the hit list result for future use Store Hit List

Retrieve results of the saved hit list Retrieve Hit List

Save the hit list as a text file Export

View SQL for Query Show SQL

Run a Query Find Now

To... Click...
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8Multi-Tenancy Best Practices

This chapter provides the administrator of a multi-tenant environment  best practice 
information. 

Best Practices in a Multi-Tenant Environment

Single Sign On
Single Sign On needs to be enabled to have the capability to switch client context and 
to open the Argus Safety application from the Global Worklists/Application Access 
Portlet. If SSO is enabled, then it becomes mandatory for a user to be configured as an 
LDAP user in all the enterprises where the data displays on the screen/portlet.

Accessing Argus Safety directly via URL
It is expected that the you will pass the internal Enterprise ID as a URL parameter for 
the Argus Safety application to open with the appropriate Enterprise context. If 
Enterprise ID is not passed, the user is validated against the default enterprise.

For ESM Mapping Utility and EOSU Tool which are client-server applications and do 
not have a mechanism to specify the Enterprise ID, will always validate users against 
the default enterprise. Hence, users that are expected to login into these applications 
are configured with appropriate access/roles within default enterprise. For this reason, 
"Active" checkbox for the default enterprise is always marked checked and disabled in 
Global Enterprise Management screen.

Global Homepage and Portlets 
Set up appropriate Portal user and user group privileges to restrict access to Portlets 
and the Global Homepage. It is recommended that the you configure the 
out-of-the-box Portlets so these (specified below) are accessible to all multi-tenant 
users who need to access data across multiple enterprises except the ones specifically 
recommended for administrators. 

■ Global Worklist - New

■ Global Worklist - Open

■ Global Worklist - Action Items

■ Global Worklist - Contacts

■ Global Enterprise Management: Recommended for Administrators
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■ Global User Management: Recommended for Administrators

■ Application Access Portlet

Global Worklists columns
The system allows flexibility to hide some of the fields/columns in the Global Worklist 
Portlets through the Global Worklist grid/menu XML(s) which resides on the Web 
Server(s). It is advisable to hide only those fields/columns which are not updated nor 
referred by any Worklist context menu actions.

Global User Management
In order to apply updates to the "Synchronizable" fields to all the enterprises in the 
system, you should maintain some administrative users with the Console'Access 
Management 'Groups' Menus 'Console: Access Management: User menu access 
enabled for all enterprises in the system.

User-Enterprise Association 
When a user is copied from one enterprise to another, it is expected that you have set 
up the appropriate site and the usergroups in the target enterprise. Otherwise the 
user-association with fail with the appropriate error message.

New User creation/association
Argus Console allows same UserID to be used to create different users across multiple 
enterprises. It is recommended that this feature is only be used if users are not 
expected to be shared across enterprises. Otherwise, if users are expected to be shared 
across multiple enterprises, then same UserID will not be used to create different users 
across different enterprises. Instead of that, a user created in one enterprise is 
associated to other enterprises through Global User Management.

Inactivating an enterprise
It is recommended that you first archive all the cases belonging to the Enterprise 
before inactivating the Enterprise.

New Enterprise Setup
It is expected that you create and choose the appropriate Enterprises with generic 
configuration data which can be used as source for copying the configuration data for 
creation of a new enterprises. Following is a list of items that the you are  
recommended to ensure that the values being copied from the source enterprise are 
appropriate for the newly created enterprise:

■ Advanced Conditions used within any configuration item

■ Reporting Destination Code List ' Company identifier field values

■ System Numbering and LAM System Numbering Formats

■ ESM Mapping Utility ' Setup INI File Setup ' Service DB Setup ' Outgoing and 
Incoming folders for each Agency.

Common Profile Switches

■ MedWatch Configuration

■ Documentum configuration

■ Lot Number Web Service Configuration
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Segregated by Enterprise
Following is the list of items that are segregated by enterprises. It is recommended that 
you configure distinct values across enterprises to ensure proper data segregation 
across enterprises

■ Literature Intake folder: Argus Console ' Common Profile Switches ' Argus J ' 
Shared Path for the Literature Intake

■ Case Intake folder: Argus Console ' Code List ' User Sites ' Intake File Path

■ Path for New Case from Image: Argus Console ' Common Profile Switches ' Case 
Processing ' Default Network directory for scanned images

■ E2B Incoming Folder: ESM Mapping Utility ' Setup INI File Setup ' Service DB 
Setup ' Incoming Folder

■ Site Printers: Argus Console ' Code List ' User Sites ' Site Printers ' Path

Maintain Consistent Across Enterprises
Following is the list of items that are segregated by enterprises but the CRO is 
recommended to maintain consistent across all enterprises:

■ Common Profile Switches ' Argus Insight URL

■ Common Profile Switches ' Argus Safety Load Balancer Server

■ System Configuration ' Enabled Modules

Shared Across Enterprises
Following is the list of items that are common for all enterprises

■ MedDRA and WHO Web Services

■ Common Profile Switches ' Security ' LDAP ' Enable/disable LDAP 

■ Common Profile Switches ' Security ' LDAP ' LDAP Server configuration

■ Common Profile Switches ' Security ' Enable/disable SSO

■ Common Profile Switches ' Security ' SSO Header Configuration

■ Common Profile Switches ' Case Processing ' Where to store temporary case 
information during data entry

■ Common Profile Switches ' Case Processing 'Auto Archiving ' The database job 
and its frequency - "Execution Period (in Days)"

■ Default Enterprise

The common profile switches (related to SSO, LDAP, Auto Archiving job & 
frequencyand Temporary Case Data Storage) which are common for all enterprises 
will only be displayed, updated and audit logged in DEFAULT enterprise. This is 
because any update to global level profile switches impacts all enterprises and is 
controlled. Also, such an update will also require propagation of the audit log to all 
other enterprises where the current user may not even exist or may not have proper 
access.

Pre-upgrade considerations for existing databases
Make sure that all the AG Service users (login user id) in all the databases that are to 
be merged into single database are in sync with the DEFAULT ENTERPRISE. If there 
are AG Service users in other enterprises which do not exist in the DEFAULT 
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ENTERPRISE, then you can either rename their login user IDs to map them to existing 
AG Service users in the DEFAULT ENTERPRISE or delete them. If extra users are 
found in other enterprises during multi-tenant database migration, then they will be 
marked disabled and you will not be enable them later.

Make sure that all the event & indication and who-drug encoding dictionaries used in 
Argus Console ' System Configuration 'Common Profile Switches 'Case Form 
Configuration 'Auto Encoding, Dictionary and Central Encoding section and Argus 
Console ' Business Configuration 'Studies 'Enable Study Specific Encoding 'Auto 
Encoding dialog, in all databases that are to be merged into single database are already 
loaded in the target database with the same name. This is required to enable the 
automatic linking of dictionaries configured in the separate databases to the already 
existing dictionaries present in the target database during the database merge 
script/process.

Post-upgrade considerations for existing databases
E2B Outgoing and Incoming folders is configured again in ESM Mapping Utility 
because various folders for different transmission methods are now merged as one 
pair of folders for all transmission methods. Now these are saved into database rather 
than the ESM Service INI file.

Document Type field value from ESM Service configuration and AG Service 
configuration tool is now be configured again into Argus Console ' Common Profile 
Switches ' Documentum configuration as these fields are now moved to Argus 
Console.

Make sure that all the event & indication and who-drug encoding dictionaries used in 
Argus Console ' System Configuration 'Common Profile Switches 'Case Form 
Configuration 'Auto Encoding, Dictionary and Central Encoding section and Argus 
Console ' Business Configuration 'Studies 'Enable Study Specific Encoding 'Auto 
Encoding dialog, in the newly migrated enterprises are linked properly to the global 
dictionaries already present in the target database. This is required to correct any 
dictionary configuration linking that could not be done automatically by the database 
merge script due to mismatch in dictionary names in the source and target databases.

 Documentum Migration
Existing single-tenant as well as multi-tenant Documentum users upgrading  to AS 7.0 
release, and are migrating/keeping all the documents in the Documentum server, is 
also add additional attributes- "enterprise_id" and "enterprise_short_name" and 
populate these appropriately for all their documents that are to be accessed by Argus 
Safety in Documentum server.

Existing single-tenant as well as multi-tenant users which are upgrading  to AS 7.0 
release, and have configured "Use Logged in User's Username/Password" for Argus 
Console ' System Configuration ' Common Profile Switches ' Document Management 
for Case Attachments will switch to Common Username/Password for Documentum 
login if not already configured for E2B, Expedited and Periodic Reports.
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MedDRA and WHO Webservices: As MedDRA and WHO webservice is common for 
each enterprise, it will use only single version for encoding events and drugs. 
However, as these web services use the dictionaries configured in Argus Console ' 
System Configuration 'Common Profile Switches 'Case Form Configuration 'Auto 
Encoding, Dictionary and Central Encoding section for the respective enterprises for 
populating dictionary id and dictionary version information for the encoded items,  
configure these dictionaries as same across all enterprises.
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